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PREFACE

Thank you for purchasing JAN-7202/9202.

This equipment meets the performance standards of the IMO (International Maritime
Organization) and the IHO (International Hydro graphic Organization), and serves to improve
safety, reduce fuel combustion, concentrate voyage information as the main device of the INS
(Integrated Navigation System).

® For the best operation, read this manual thoroughly before use.

® Keep this manual in a convenient place for future reference.
Make use of this manual when experiencing operation difficulties.

® The LCD of this equipment uses thin film transistors (TFT). If some pixels on the screen
are not clear, the color is different, or the screen is brighter than usual, it is not because of
defect, instead it is because of inherent characteristic of the TFT display technology.

® The information in this manual is subject to change without notice at any time.
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® Safety Cautions @

Cautions for High Voltage

High voltages, ranging from several hundreds to tens of thousands of volts, are used in
electronic apparatus, such as radio and radar instruments. These voltages are totally harmless
in most operations. However, touching a component inside the unit is very dangerous. (Any
person other than authorized service engineers should not maintain, inspect, or adjust the unit.)
High voltages on the order of tens of thousand volts are most likely to cause instant deaths from
electrical shocks. At times, even voltages on the order of several hundred volts could lead to
electrocution. To defend against electrical shock hazards, don't put your hand into the inside of
apparatus. When you put in a hand unavoidably in case of urgent, it is strongly suggested to turn
off the power switch and allow the capacitors, etc. to discharge with a wire having its one end
positively grounded to remove residual charges. Before you put your hand into the inside of
apparatus, make sure that internal parts are no longer charged. Extra protection is ensured by
wearing dry cotton gloves at this time. Another important precaution to observe is to keep one
hand in your pocket at a time, instead of using both hands at the same time.

It is also important to select a secure footing to work on, as the secondary effects of electrical
shock hazards can be more serious. In the event of electrical shocks, disinfect the burnt site
completely and obtain medical care immediately.

Precautions for Rescue of Victim
of Electric Shock

When a victim of electric shock is found, turn off the power source and ground the circuit
immediately. If this is impossible, move the victim away from the unit as quick as possible without
touching him or her with bare hands. He or she can safely be moved if an insulating material
such as dry wood plate or cloth is used.

Breathing may stop if current flows through the respiration center of brain due to electric shock. If
the electric shock is not large, breathing can be restored by artificial respiration. A victim of
electric shock looks pale and his or her pulse may become very weak or stop, resulting in
unconsciousness and rigidity at worst. It is necessary to perform first aid immediately.




® Emergency Measures @

Method of First-Aid Treatment

Y«Precautions for First-Aid Treatments

Apply artificial respiration to the person who collapsed, minimizing moving as much as
possible avoiding risks. Once started, artificial respiration should be continued rhythmically.

(1)

)

(4)

Refrain from touching the patient carelessly as a result of the accident; the first-aider
could suffer from electrical shocks by himself or herself.

Turn off the power calmly and certainly, and move the patient apart from the cable
gently.

Call or send for a physician or ambulance immediately, or ask someone to call doctor.

Lay the patient on the back, loosening the necktie, clothes, belts and so on.

(a) Feel the patient's pulse.

(b) Check the heartbeat by bringing your ear close to the patient's heart.

(c) Check for respiration by bringing your face or the back of your hand to the patient's
face.

(d) Check the size of patient's pupils.

Opening the patient's mouth, remove artificial teeth, cigarettes, chewing gum, etc. if
any. With the patient's mouth open, stretch the tongue and insert a towel or the like into
the mouth to prevent the tongue from being withdrawn into the throat. (If the patient
clenches the teeth so tight that the mouth won't open, use a screwdriver or the like to
force the mouth open and then insert a towel or the like into the mouth.)

Wipe off the mouth to prevent foaming mucus and saliva from accumulating.




¢ Treatment to Give When the Patient Has a

Pulse Beating but Has Ceased to Breathe

* Performing mouth-to-mouth artificial respiration

(1)

Bend the patient's face backward until it is directed to look back. (A pillow may be
placed under the neck.)

Pull up the lower jaw to open up the airway. (To spread the airway)

Pinching the patient's nose, breathe deeply and blow your breath into the patient's
mouth strongly, with care to close it completely. Then, move your mouth away and
take a deep breath, and blow into his or her mouth. Repeat blowing at 10 to 15 times
a minute (always with the patient's nostrils closed).

Continue artificial respiration until natural respiration is restored.

If the patient's mouth won't open easily, insert a pipe, such as one made of rubber or
vinyl, into either nostril. Then, take a deep breath and blow into the nostril through
the pipe, with the other nostril and the mouth completely closed.

The patient may stand up abruptly upon recovering consciousness. Keep the patient
lying calmly, giving him or her coffee, tea or any other hot drink (but not alcoholic
drink) to keep him or her warm.

Mouth-to-mouth artificial respiration with the patient's head lifted

(1) Lift the back part of the patient's
head. Support the forehead with one
of your hand and the neck with the
other hand.— [1].

Many patients will have their airways
opened by lifting their head in this
way to ease mouth-to-mouth
artificial respiration.

(2) Closing the patient's mouth with your
mouth, press your cheek against the
patient's nose— [2].

Alternatively, hold the patient's nose
with your finger to prevent air leak
— [3].

$e

Blowing air into the patient's lungs.
Blow air into the patient's lungs until
chest is seen to rise. The first 10
breaths must be blown as fast as
possible.

Fig. 1 Mouth-to-mouth artificial respiration




Flow of Cardiopulmonary Resuscitation (CPR)

A person is collapsing.
- Secure the safety of the surrounding area.
- Prevent secondary disasters.

v

Listen to the appeal of the

Check for response. Responding > injured or ill person and give

- Call while tapping the shoulder.

Not responding ¢

Ask for help.
- Make an emergency call.
- Ask to bring an AED.

Open the airway.

the necessary first-aid
treatment.

Recovery position
- Lay the injured or

ill person on

- Check for breathing.

Not breathing *

Give 2 rescue breaths; omittable Note(!)

Breathing . . ]
p| his/her side and #.'

wait for the arrival
of the emergency
services.

¢ e ™~

Give CPR.
- 30 chest compressions
- Give 2 rescue breaths; omittable Note(1)

v

Arrival of an AED
- Turn on the power.

Note(") Omission of rescue breathing:

If there is a fear of infection because the
injured or ill person has an intraoral injury,
you are hesitant about giving mouth-to-mouth
resuscitation, or preparing the mouthpiece for
rescue breathing takes too long, omit rescue
breathing and proceed to the next step.

- Use the AED by following its voice prompts. N _/

Fitting of the electrode pads, etc.

l

Automatic electrocardiogram

analysis

- Do not touch the injured or ill
person.

A 4

Electric shock is not needed.

Electric shock is needed.

A 4

The AED

- Delivery of electric shock
automatically

analyzes the

When the injured or ill

<
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4

heart rhythm Y\

person has been

every 2 min.

Resume CPR from chest

compressions by following the
voice prompts of the AED.

handed over to the

——) ©MEJENCy services or

When to has started moaning or

stop CPR breathing normally, lay
him/her on his/her side
in a recovery position
and wait for the arrival
of emergency services.
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Specific Procedures for Cardiopulmonary Resuscitation (CPR)

Check the scene for safety to prevent secondary disasters

a) Do not touch the injured or ill person in panic when an accident Are you OK?

has occurred. (Doing so may cause electric shock to the
first-aiders.)

b) Do not panic and be sure to turn off the power. Then, gently move
the injured or ill person to a safe place away from the electrical

circuit.

Check for responsiveness
a) Tap the shoulder of the injured or ill and shout in the ear saying, "Are you OK?"
b) It the person opens his/her eyes or there is some response or gesture, determine it as

"responding." But, if there is no response or gesture, determine it as "not responding.”

If responding

Please call an w
a) Give first-aid treatment. ambulance.

Please bring an AED.

If not responding
a) Ask for help loudly. Ask somebody to make an emergency call
and bring an AED.
» Somebody has collapsed. Please help.
* Please call an ambulance.
* Please bring an AED.

» If there is nobody to help, call an ambulance yourself.

Open the airway

a) Touch the forehead with one hand. Lift the chin with the two fingers
of the middle finger and forefinger of the other hand and push down
on the forehead as you lift the jaw to bring the chin forward to open
the airway. If neck injury is suspected, open the airway by lifting the

lower jaw.

Check for breathing

a) After opening the airway, check quickly for breathing for no more than
10 seconds. Put your cheek down by the mouth and nose area of the
injured or ill person, look at his/her chest and abdomen, and check the following three points.
* Look to see if the chest and abdomen are rising and falling.
« Listen for breathing.

» Feel for breath against your cheek.
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b) If the injured or ill person is breathing, place him/her in the recovery

position and wait for the arrival of the emergency services.

» Position the injured or ill person on his/her side, maintain a clear

and open airway by pushing the head backward while positioning

X i . X . Roll gently in the opposite
their mouth downward. To maintain proper blood circulation, roll direction every 30 minutes.

him/her gently to position them in the recovery position in the

opposite direction every 30 minutes.

Give 2 rescue breaths (omittable)

a) If opening the airway does not cause the injured or ill person to begin

b) If there is a fear of infection because the injured or ill person has an

d) While maintaining an open airway, pinch the person's nose shut with

to breathe normally, give rescue breaths. CPR mask

intraoral injury, you are hesitant about giving mouth-to-mouth <0>’
resuscitation, or getting and preparing the mouthpiece for rescue Mouthpiece for rescue

breathing takes too long, omit rescue breathing and perform chest
compressions.

When performing rescue breathing, it is recommended to use a
mouthpiece for rescue breathing and other protective devices to

prevent infections.

your thumb and forefinger of the hand used to push down the

forehead.

e) Open your mouth widely to completely cover the mouth of the injured or ill person so that no air

will escape. Give rescue breathing twice in about 1 second and check if the chest rises.

Cardiopulmonary resuscitation (CPR) (combination of chest compressions and

rescue breaths)

a) Chest compressions

1) Position of chest compressions
» Position the heel of one hand in the center of the chest, approximately between the

nipples, and place your other hand on top of the one that is in position.
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2) Perform chest compressions

Compress
with these
parts (the

» Perform uninterrupted chest compressions of

30 at the rate of about 100 times per minute. Eeter:S of
While locking your elbows position yourself hands).

vertically above your hands.

»  With each compression, depress the chest wall to a depth of approximately 4 to 5 cm.

b) Combination of 30 chest compressions and 2 rescue breaths
30 times

1) After performing 30 chest compressions, give 2 rescue
breaths. If rescue breathing is omitted, perform only chest
compressions. 2 times

2) Continuously perform the combination of 30 chest
compressions and 2 rescue breaths without interruption.

3) If there are two or more first-aiders, alternate with each other
approximately every two minutes (five cycles of compressions

and ventilations at a ratio of 30:2) without interruption.

9. When to stop cardiopulmonary resuscitation (CPR)
a) When the injured or ill person has been handed over to the

emergency services

b) When the injured or ill person has started moaning or breathing
normally, lay him/her on his/her side in a recovery position and wait

for the arrival of emergency services.

10. Arrival and preparation of an AED
a) Place the AED at an easy-to-use position. If
there are multiple first-aiders, continue CPR
until the AED becomes ready.

b) Turn on the power to the AED unit. @

Depending on the model of the AED, you VLI @ (18 [FEET

may have to push the power on button, or the AED automatically turns on when you open the
cover.

c) Follow the voice prompts of the AED.

11. Attach the electrode pads to the injured or ill person's bare chest

a) Remove all clothing from the chest, abdomen, and arms.

b) Open the package of electrode pads, peel the pads off and securely /\ N 48

3
place them on the chest of the injured or ill person, with the adhesive [ ,@*‘. ‘
\' A \

f \ §
AL ‘
| 1\

side facing the chest. If the pads are not securely attached to the chest, \If Lot ‘/ \' t\
the AED may not function. Paste the pads exactly at the positions
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indicated on the pads, if the chest is wet with water, wipe dry with a dry
towel and the like, and then paste the pads. If there is a pacemaker or
implantable cardioverter defibrillator (ICD), paste the pads at least 3cm
away from them. If a medical patch or plaster is present, peel it off and

then paste the pads. If the injured or ill person's chest hair is thick,

paste the pads on the chest hair once, peel them off to remove the
chest hair, and then paste new pads.
c) Some AED models require to connect a connector by following voice prompts.
d) The electrode pads for small children should not be used for children over the age of 8 and for

adults.

12. Electrocardiogram analysis
a) The AED automatically analyzes electrocardiograms. Follow the
voice prompts of the AED and ensure that nobody is touching the

injured or ill person while you are operating the AED.

b) On some AED models, you may need to push a button to analyze

the heart rhythm.

13. Electric shock (defibrillation)
a) If the AED determines that electric shock is needed, the voice

prompt saying, "Shock is needed" is issued and charging starts

automatically.

N

S

b) When charging is completed, the voice prompt saying, "Press the
shock button" is issued and the shock button flashes.
Press the shock button.
c) The first-aider must get away from the injured or ill person, make
sure that no one is touching him/her, and then press the shock button.

d) When electric shock is delivered, the body of the injured or ill person may jerk.

14. Resume cardiopulmonary resuscitation (CPR).
Resume CPR consisting of 30 chest compressions
and 2 rescue breaths by following the voice

prompts of the AED.

15. Automatic electrocardiogram analysis
a) When 2 minutes have elapsed since you resumed cardiopulmonary resuscitation (CPR), the
AED automatically analyzes the electrocardiogram.
b) If you suspended CPR by following voice prompts and AED voice prompt informs you that
shock is needed, give electric shock again by following the voice prompts.

If AED voice prompt informs you that no shock is needed, immediately resume CPR.



16. When to stop CPR (Keep the electrode pads on.)
a) When the injured or ill person has been handed over to the emergency services
b) When the injured or ill person has started moaning or breathing normally, lay him/her on

his/her side in a recovery position and wait for the arrival of emergency services.




@® Pictorial Indication @

Meanings of Pictorial Indication

Various pictorial indications are included in this manual and
are shown on this equipment so that you can operate them
safely and correctly and prevent any danger to you and / or
to other persons and any damage to your property during
operation. Such indications and their meanings are as
follows.

Please understand them before you read this manual:

This indication is shown where incorrect equipment
operation due to negligence may cause death or serious
injuries.

This indication is shown where any person is supposed to
be in danger of being killed or seriously injured if this
indication is neglected and this equipment is not operated
correctly.

This indication is shown where any person is supposed to
be injured or any property damage is supposed to occur if
this indication is neglected and this equipment is not
operated correctly.

Examples of Pictorial Indication

The A mark represents CAUTION (including DANGER and
& WARNING).
Detailed contents of CAUTION ("Electric Shock" in the example
Electric Shock on the left) is shown in the mark.

The © mark represents prohibition.
Detailed contents of the prohibited action ("Disassembling

Prohibited" in the example on the left) is shown in the mark.

Disassembling
Prohibited

The @ mark represents instruction.
Detailed contents of the instruction ("Disconnect the power plug"

in the example on the left) is shown in the mark.

Disconnect
the power plug

Warning Label

There is a warning label on the top cover of the equipment.
Do not try to remove, break or modify the label.

Xi




@® Precautions upon Equipment Operation @

/AN DANGER

Never attempt to check or repair the inside of the equipment.

Checking or repair by an unqualified person may cause a fire or an electric
shock.

Contact our head office, or a nearby branch or local office to request
servicing.

Never remove the cover of this equipment.
Touching the high-voltage section inside will cause an electric shock.

Do not attempt to disassemble or tamper with this equipment.
Otherwise, a fire, an electric shock, or a malfunction may occur.

When conducting maintenance, make sure to turn the main power off.
Failure may result in electric shock.

e O

Turn off all the main powers before cleaning the equipment. Especially when
an UPS is used, make sure to turn it off since voltage is still outputted from
the UPS even after the indicator and the Conning display is turned off. Failure
may result in equipment failure, or death or serious injury due to electric
shock.
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AWARNING

Do not hold down the Power button of the operation unit when turning off the
power supply.

If the button is held down, the equipment may not be terminated normally,
causing a failure.

When conducting maintenance work, make sure to turn off the power so that
the power supply to the equipment is completely cut off.

Some equipment components can carry electrical current even after the
power switch is turned off, and conducting maintenance work may result in
electric shock, equipment failure, or accidents.

When cleaning the display screen, do not wipe it too strongly with a dry cloth.
Also, do not use gasoline or thinner to clean the screen. Failure will result in
damage to the screen surface.

Confirm computer virus does not exist in USB flash memory beforehand
when reading and writing of the file by using USB flash memory.
Influences other equipment when the display unit is infected with the virus,
and it may cause a breakdown.

Do not remove USB flash memory while the access lamp (in USB flash drive)
is flashing.

Data may be damaged when the USB flash memory is inserted or removed
while accessing it, and it may cause a breakdown.

Do not place a glass or cup containing water, etc., or a small metal object on
this equipment.

If water or such object gets inside, a fire, an electric shock, or a malfunction
may occur.

In case water or a metal object gets inside the equipment, turn off the power
immediately, unplug the power supply cable from an electric outlet, and
contact our head office, or a nearby branch or local office to request servicing.
Keeping the equipment in operation under such condition may cause a fire,
an electric shock or a malfunction.

In case you find smoke, unusual odor or extreme high heat coming from the
equipment, turn off the power immediately, unplug the power supply cable
from an electric outlet, and contact our head office, or a nearby branch or
local office to request servicing.

Keeping the equipment in operation under such condition may cause a fire or
an electric shock.

SO & VOOV O O

Change of the color of the Day/Night button, particularly the use of the [Night]
color, may interfere with the recognition of display information.
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ACAUTION

Make sure that two or more staff member work together when replacing the
LCD. If only one person attempts to replace the LCD, he/she may drop it and
become injured.

Any adjustments must be made by specialized service personnel.

Incorrect settings may result in unstable operation, and this may lead to
accidents or equipment failure.

Do not use or leave the equipment under direct sunlight for a long time or in
the temperatures above 55°C.
Otherwise, a fire or a malfunction may occur.

Do not block the ventilation opening of the equipment.
Otherwise, heat may accumulate inside to cause a fire or a malfunction.

Do not touch the equipment with hands or gloves wet with water.
Otherwise, an electric shock or a malfunction may occur.

* Do not place any object on the operation panel.
In particular, if a hot object is placed on the operation panel, it can cause

deformation of the surface of the operation panel.
» Do not apply any undue shock on the operation panel, trackball and dials.
Otherwise, a malfunction may result.

Make sure that the main power is turned off before inspection or replacement
of parts.
Otherwise, an electric shock, a fire, or a malfunction may occur.

@0 VL@

» If a fan alarm or CPU temperature rise alarm has occurred, immediately
turn off the power.
Keeping the equipment in operation under such condition may cause a fire
or a malfunction.
After turning off the power, contact our head office, or a nearby branch or
local office to request servicing.
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ACAUTION

Do not turn off the power during Backup/Restore.
Otherwise, a function may fail, and an accident may occur.

Do not do the backup operation of data while sailing.

The Conning Display application should be ended to begin the data backup. It
becomes impossible to observe using the Conning Display and this may lead
to accidents.

The backup power supply (DC power supply, etc.) of the equipment must be
connected when recovery of the C drive image is performed. If the power
supply stops during recovery, an equipment activation fault occurs, causing
an accident.

Do not turn off the power supply during recovery of C drive image.
Otherwise, a function fault occurs, causing an accident.

NN - MW

In the case of turning on the power under the condition of low temperature, do
pre-heat more than 30 minutes.
Otherwise, an operation failure may occur and an accident may occur.
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The Mounting Point of the Warning Label

Warning Label
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CWA-246 26inch Display Unit Mount Kit

Warning Label
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CWA-245 19inch Display Unit Mount Kit
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Warning Label

s we

NQE-3141-4A/8A Interswitch Unit
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EQUIPMENT APPEARANCE
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CWA-245 Display Unit

CWA-246 Display Unit
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NCE-5605 Trackball Operation Unit

NCE-5625 Keyboard Operation Unit (Option)

NDC-1590 Central Control Unit

NBD-913 Power Supply Unit
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NWZ-207 19inch Display

NWZ-208 26inch Display

NQE-1143 Junction box (Option)
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How to Use This Manual

Structure of this manual

This manual is structured as shown below. Read the necessary section according to the purpose.

Item Contents
Preface Describes the purposes of using this equipment.
Safety Cautions Describes the cautions for a high voltage, precautions

Emergency Measures

for rescue of victims of an electric shock, and the
method of First-Aid treatment.

Pictorial Indication
Precautions upon Equipment Operation

Describes the safety precautions and warning on this
equipment.

The Mounting Point of the Warning
Label

Describes the warning label attachment position on
this equipment.

Equipment Appearance

Describes the appearance of this equipment.

How to use this manual

This page

Section 1 Overview

Provides the overview of this equipment.

Section 2
Name and Function of Each Unit

Describes the name and function of each unit of this
equipment.

Section 3
Basic Operations

Describes the basic operations of Conning Display.

Section 4
Each Block of Conning Display

Describes how to view the blocks that are displayed
on the Conning Display screen and how to operate
the screen.

Section 5
Setting Up Screen View

Describes the detail setting of screen display.

Section 6
Setting Up Alerts

Describes the alert detail setting for avoiding dangers.

Section 7
Setting Up the Operation Mode

Describes the detail setting of the operation modes of
this equipment.

Section 8
Adjusting and Setting Up Equipment (for
Services)

Describes the adjustment and setup of this equipment
by specialized service personnel.

Section 9
Maintenance & Inspection

Describes the maintenance and inspection of this
equipment.

Section 10
Failures and After-Sale Services

Describes the failure handling measures and
after-sale services of this equipment.

Section 11
About Disposal

Describes the cautions on disposing of this
equipment.

Section 12 Describes the specifications of this equipment.
Specifications

Appendix A Contains a listing of alerts.

Alert List

Appendix B Describes the materials such as the menu list.

Menu List and Materials




Notations
Operation notations

Trackball operations on the operation panel are expressed as follows.

Operation

Notation

Click the left button.

Click
Example: Click on the object.

Double-click the left button.

Double-click
Example: Determine the drawing by double-click.

The buttons and dialog boxes on the screen are expressed as follows.

Button type

Notation

Button with button name
indicated

ACK

Example: — [ACK] (Acknowledgment) button

Button with an indication
other than the button name
such as an icon

Shown as follows.

Example: —> Day/Night button

A series menu selection operation is expressed as follows.

‘ Click on [Settings] - [General] - [Color and Brightness] on the menu.
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Section 1 Overview

AWARNING

Do not put any container with water or small metallic object on this equipment.
Water may spill or metal may enter the equipment, causing fire, electric shock or
other troubles.

Should water or metal have entered the equipment, turn off the circuit breaker and
contact our sales division, branch office, service center or representative located
nearest to you.

If you continue to use the equipment without taking required action, fire, electric
shock or other troubles may occur.

Should you find out smoke, offensive smell or extreme heat on the equipment, turn off
the switch and circuit breaker immediately. Then contact our sales division, branch
office, service center or representative located nearest to you.

If you continue to use the equipment without taking required action, fire or electric
shock may occur.

ACAUTION

Do not use or leave the equipment where there is a direct sunshine and high humidity
or the temperature exceeds 55°C.
Otherwise, fire or other troubles may occur.

Do not block the ventilation port of the equipment.
Otherwise, fire or other troubles may be caused by heat accumulation.

Do not touch the equipment when your hands or gloves are wet with fresh water or
seawater.
Otherwise, electric shock or other troubles may occur.

» Do not place any object on the operation panel.
In particular, if a hot object is placed on the operation panel, it can cause
deformation of the surface of the operation panel.

* Do not apply any undue shock on the operation panel, trackball and dials.
Otherwise, a malfunction may result.

S OO

» If a fan alarm or CPU temperature rise alarm has occurred, immediately turn off
the power.
Keeping the equipment in operation under such condition may cause a fire or a
malfunction.
After turning off the power, contact our head office, or a nearby branch or local
office to request servicing.

1-1 Section 1 Overview




1.1 Functions

Conning Display (referred to as "this equipment" henceforth), which enables quick understanding of
the condition of own ship by intensively displaying on the screen the navigation information and
progress information that are necessary for sailing and maneuvering the ship, supports the
improvement of the safe transportation and work efficiency.

This equipment has the following functions:

» Display of information including ship’s heading, speed, course, water depth, wind bearing/wind
speed, current set/current drift, propeller/engine revolution speed, rudder angle, thruster, waypoint

» Sensor information graph display and numeric value display

» Switching between H UP and N UP of wind bearing/wind speed display

+ Switching of data source

» Switching of display data unit

» Option alert management information
Warning: Warning information/history display from the connection device

» Day/Night function

» Self-diagnosis function
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1.2 Features

This equipment has the following features:

» Displays the relationships among the ship’s heading, course, wind bearing/wind speed, and current
set/current drift of own ship in large graphic presentation, enabling the grasping of the relationships
easily.

» Displays the relationships among the ship’s heading, course, set heading, and planned course in
3D view combining with the view from the bridge, enabling the grasping of the relationships easily*1

» Displays the speed in the unit of cm/s at the docking at the shore

» Displays many side thruster/azimuth thruster information items at docking at the shore

» Supports customization of display layout and label text according to the number of engines/wheels
(supported at factory delivery)

* Menu selection by icon

» Applies 19-inch or 26-inch color LCD

*1: The 3D view display may not be available depending on the Conning Display you use.
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1.3 Components

A list of components and optional accessories is shown below.

Components of the Display Unit

Name Model Q'ty Remarks
Display unit Main unit
Display (JMR-72XX/JAN-72XX) NW2zZ-207 1 Included in the main unit.
(JMR-92XX/JAN-92XX) NWzZ-208
Trackball operation unit NCE-5605 1 Included in the main unit.
Keyboard operation unit NCE-5625 1 Option
Large tray CUB-1593 1 ;Zigl-c;rl]cl)};;oéizplay unit
UPS 1
Central control unit NDC-1590 1 Included in the main unit.
Power supply unit NBD-913 1 Included in the main unit.
Junction box NQE-1143 1 Option
Serial LAN Interface circuit | CMH-2370 1 Option
Analog Option circuit CMJ-560 1 Option
Gyro Interface circuit CMJ-554 1 Option
Sensor LAN switch unit NQA-2443 1 Option
26inch cradle frame CWA-246 1 Option
19inch cradle frame CWA-245 1 Option
26inch desktop frame CWB-1595 1 Option
19inch desktop frame CWB-1594 1 Option
Operation unit desktop frame CWB-1596 1 Option
Instruction Manual (Japanese) 1
Instruction Manual (English) 1
Installation Manual (Japanese) 1 Option
Installation Manual (English) 1 Option
Canvas cover 1 Option
Hood (JMR-72XX/JAN-72XX) 1 Option
(JMR-92XX/JAN-92XX)
Accessory CD cleaner 1 Packing in 1 box

Spare parts for the main unit

Packing in 1 box

Spare parts for the junction box

Option
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Outline drawing of 26inch Display (NWZ-208)

Overview
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Outline drawing of 19inch Display (NWZ-207)
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Outline Drawing of Power Supply Unit (NBD-913)
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Outline Drawing of Keyboard Operation Unit (NCE-5625)
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Outline Drawing of 26inch Cradle Frame (CWA-246)
(with display, trackball operation unit and keyboard operation unit installed)

Overview

Section 1



EEEECEE H 0
(LY HEER) -v14:3
v-1L%
378V.1d300V LON : 40700 Y3H10
YIATS * 407900
EULERLE]

(AddnS ) 31Vd Hl¥v3

(FHH) 4 5]
(A1ddNS 3d) LNN ONIM

o

GY7Z-VMO
wu Ty
3 08 ¥ HE
3 ¢¢ ¥ HH
uru LINN
3 08 'XOUddV SSVIN
3y ¢¢  'XOMddV SSVIN
W4avGIN: B
-ViH
FNLXIL SSOT9-INIS SN - ¥0109
Y300 WV
RN ——

829

2y

H1dv3

(VN A ki )
(ZVN S17108 ONIXIF)

ONIMVYSHA INITTLNO LIX INNOW LINN AV 1dSId ®-909G0MADS
g7 0007 000Z g7 0007 0002
9% 000Z 000} g% 0002 000l
Vil 000 007 VAl 000l 007
G¢F 007 0zl G'CF 007 adl
Gl* 0zl 3 Gl* 0145 0€
|7 0€¢ 9 5 0€ 9
g0F 9 B GOF 9 e
NG YA% oL 43N0
WW% ._mumn.mrumm__m SNOISN3WIQ
F HEANg HEA - i 3NMLAO
Y -NUY LA 4
3SvE TINNVHO \
$AAVGIN:D A N
| (2) (F)-vEsrh
UNLXAL SSOIGINGS, 67N * 4000
HEVREIES
HAAvGIN: B ° ° M
V] I |
UNLX3L SSOT9INIS GZN * ¥000 | IE
300 INoYd
,,/,,
(LVHRER) 343 1
-1Ll
TBVLA3007 10N 40100 130 056
Jivd INOS ($BT) REAHE
(M3IA dOL) SNOISNIWIO ONILNNOW
18, INO44
€6 L6l | 6/ |€6 GGl ¢-9
(bVagsw ) ¥4 ~vGIN: B ~ Gel 0 | [SEL 2 o
AL-L o o O
J18Y1d300V 10N : 40000 ¥3H10 77
FANLXAL SSO19INS SN+ H0 09 = E
EL:8 N
________ N 5
— | N ° 4
—_— 5 3

Overview

Section 1

1-13

Outline Drawing of 19inch Cradle Frame (CWA-245)
(with display, trackball operation unit and keyboard operation unit installed)
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Outline Drawing of 26inch Desktop Frame (CWB-1595)
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Outline Drawing of 19inch Desktop Frame (CWB-1594)
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Outline Drawing of OPU Desktop Frame (CWB-1596)
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Outline Drawing of Large Tray (CWB-1593)



1.5 General System Diagrams

Connection examples of this equipment are shown below.

AIS__150/250V TTYCSLA-4

(IEC61162-2)

GYRO COMPASS__150/250V TTYCSLA-1

(IEC61162-2)
No.1 DGPS__150/250V TTYCSLA-1

(IEC61162-1)
SDME_—150/250V TTYCSIA-1

(IEC61162-1)
BNWAS__150/250V TTYCSI.A-1

(Dry Contact)

NWZ-208
26inch Monitor Unit
(Option)

— B €
5 8 5
] =} -
NCE-5625 NCE-5605 g 54 5
Keyboard Operation Unit Trackball Operation Unit |— < 3
(Option) h 3 3

< P4
-3 319 =&
W64:7ZCNA4187(0.40m EN 2R [N
= b 3 =g
g2 = ol

NDC-1590

Central Control Unit

. NQA-2443
Inner wiring | .
24VDC/Max0.4A Sensor LAN CAT-5 LAN Cable
(For LAN Unit) (W(');ﬁon;“
ICAT-5 LAN Cable
AIS__150/250V TTYCSLA-4
(IEC61162-2)
GYRO COMPASS__150/250V TTYCSLA-1
(IEC61162-2)
No.1 DGPS__150/250V TTYCSLA-1
(IEC61162-1)
SDME—150/250V TTYCSIA-1
(IEC61162-1) a
BNWAS__150/250V TTYCSLA-1 8 T
(Dry Contact) NQE-1143 S =)
Junction Box g <
(Option) © ©
3 3
(6 =
3N 3N
e ] ]
2| = )
SE o=
Inner wiring —H
24VDC/Max2A
(For Junction Box:SLC)
Transitional Source of _0.6/1kV DPYCYS-16 Inner wiring
Emergency Electric Power 24VDC NBD-913
24VDC/Max300W Power Supply Unit
(For System Backup)
Ship's Main 0.6/1kV DPYCY-6 Py Inner wiring
L
AC220V 1PH/Max240VA cQD-2312 AC220V 1PH
Relay
Terminal

NOTE: ELIMINATING THE INTERFERENCE ON FREQUENCIES USED FOR MARINE COMMUNICATIONS AND

NAVIGATION DUE TO OPERATION OF THE RADAR,

ALL CABLES OF THE RADAR ARE TO BE RUN AWAY FROM THE CABLES OF RADIO EQUIPMENT.
(ex. RADIOTELEPHONE, COMMUNICATIONS RECEIVER and DIRECTION FINDER. etc..)
ESPECIALLY INTER-WIRING CABLES BETWEEN SCANNER UNIT AND DISPLAY UNIT OF THE RADAR

SHOULD NOT BE RUN PARALLEL WITH THE CABLES OF RADIO EQUIPMENT.

General System Diagram of JAN-9202

Section 1 Overview

CWA-246 26inch Display Unit Mount Kit




NWz-207
19inch Monitor Unit

(Option)
= 3 3
§ 2 e
q S <
Keyb N%%_56%5 Unit NCE-5605 s < g
ey’ oar(opﬁg;a) fon &ni Trackball Operation Unit © hrd b
< < b3
<
Jz sl =I5
W64:7ZCNA4187(0.40m 8§ N = 2 N
2= =S (R
3le Sz gz
AIS__150/250V TTYCSLA-4
(IEC61162-2)
GYRO COMPASS__150/250V TTYCSLA-1
(IEC61162-2)
No.1 DGPS__150/250V TTYCSLA-1
(IEC61162-1)
SDME_—150/250V TTYCSIA-1
(IEC61162-1)
BNWAS__150/250V TTYCSLA-1
(Dry Contact)
NDC-1590
Central Control Unit
. NQA-2443
Inner wiring -
24VDC/Max0.4A M Sensor LAN CAT-5 LAN Cable
(For LAN Unit) (W(')‘;{i‘o%"'
ICAT-5 LAN Cable
AIS__150/250V TTYCSLA-4
(IEC61162-2)
GYRO COMPASS__150/250V TTYCSLA-1
(IEC61162-2)
No.1 DGPS__150/250V TTYCSLA-1
(IEC61162-1)
SDME__150/250V TTYCSLA-1
(IEC61162-1) B
BNWAS__150/250V TTYCSIA-1 8 z
(Dry Contact) NQE-1143 S =]
Junction Box S g,
(Option) © ©
< <
< <
s[6 s[G
N gy
25 4=
3l 3l2
Inner wiring —
24VDC/Max2A
(For Junction Box:SLC)
Transitional Source of 0.6/1kV DPYCYS-16 Inner wiring
Emergency Electric Power 24VDC NBD-913
24VDC/Max300W Power Supply Unit
(For System Backup)
Ship's Main 0.6/1kV DPYCY-6 Py Inner wiring
AC220V 1PH/Max240VA CcQD-2312 AC220V 1PH
Relay
Terminal
CWA-245 19inch Display Unit Mount Kit
NOTE: ELIMINATING THE INTERFERENCE ON FREQUENCIES USED FOR MARINE COMMUNICATIONS AND
NAVIGATION DUE TO OPERATION OF THE RADAR,
ALL CABLES OF THE RADAR ARE TO BE RUN AWAY FROM THE CABLES OF RADIO EQUIPMENT.
(ex. RADIOTELEPHONE, COMMUNICATIONS RECEIVER and DIRECTION FINDER. etc..)
ESPECIALLY INTER-WIRING CABLES BETWEEN SCANNER UNIT AND DISPLAY UNIT OF THE RADAR
SHOULD NOT BE RUN PARALLEL WITH THE CABLES OF RADIO EQUIPMENT.
General System Diagram of JAN-7202
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Section 2 Name and Function of
Each Unit

2.1 Name and Main Function of the
Operation Unit

211 Trackball operation unit

Mm 6 @ 6 ©

()

(10)

AWARNING

When turning off the power supply, do not press the Power button on the
operation unit for an extended period of time.

If the button is pressed for an extended period of time, the equipment may not
be terminated normally, causing a failure.

2-1 Section 2 Name and Function of Each Unit



No Name Function outline
1 Power button Use this button to turn on and off this equipment.
2 [MULTTI] dial - Turn this dial to operate the function that is assigned to the
[MULTI] dial, such as the Display Brightness function.
- If the [MULT]I] dial is held down, the Display Brightness
function is assigned to the [MULTI] dial forcibly.
3 USB terminal Connects a USB flash memory.
4 [SILENCE] key Stops the alert buzzer.
5 [ALERT ACK] key Acknowledges the alert.
6 [ZOOM IN] key Not used.
7 [ZOOM OUT] key Not used.
8 Trackball Moves the cursor on the screen. Use the trackball to specify a
position or to perform various settings.
9 Left button - Use this button to select a function or determine the operation
that is set.
- Clicking the left button once is referred to as "click" in this
manual.
- Clicking the left button twice consecutively is referred to as
"double click" in this manual.
10 Right button Not used.

Section 2 Name and Function of Each Unit
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2.1.2 Keyboard operation unit (Option)

(M ® @ E)y@d © 6 (14 (2)

(10)

J o
LES DAY
BIBY - _. HGHT .-

(15)

(13)

(11)

DISP
®) [ ? e )

(12)

L]Illlllllll@lw
S OOO0ADODOOINNNE

(16)

B ) JE ) S
(CEN 3 3(153/2 3 /0 D | VAR 5 ==

el [E00sE)

L y
No. Name Function outline
1 [EBL] dial Not used.
2 [VRM] dial Not used.
3 [RAIN] dial Not used.
4 [SEA] dial Not used.
5 [GAIN] dial Not used.
6 [TX STBY] key Not used.
7 [AZ] key Not used.
8 [HOME] key Not used.
9 [DAY NIGHT] key Switches the display color on the screen over 5 levels according to the
brightness on the bridge.
10 [DISP OFF] key Not used.
11 [P1] key Not used.
12 [MOB] (Man Over - The [Marker] dialog box (which shows monitoring information for preventing
Board) key loss of sight of the position of the person who fell overboard) appears based on
the latitude and longitude information of the own ship's position.
- Holding down this key closes the [Marker] dialog box.
13 [PANEL] key Whenever this key is pressed, the brightness of the panel on the operation unit
is switched.
14 [USER1] key - Executes the function that is assigned to the key.
- Holding down this key displays the setting dialog box for assigning a function
to the [USER1] key.
15 [USERZ2] key - Executes the function that is assigned to the key.
- Holding down this key displays the setting dialog box for assigning a function
to the [USERZ2] key.
16 Keyboard The keyboard is used for the input of numeric values and characters at operation

of this equipment.

2-3
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2.1.3 Display unit

-

[OJCJO)]

v

©O®

[Brightness Adjustment] [Power] button
buttons

[Power] button

When the Power button is pressed while the power of the display unit is turned off, the power is
turned on.

To turn off the power of the display unit, press the Power button for 5 seconds or longer.

[Brightness Adjustment] buttons

These buttons are used to adjust the brightness of the screen.
The screen increases brightness by pressing the ® button.
The screen decreases brightness by pressing the @ button.

Memo
Adjust the brightness of the screen to the extent it is not dazzling, taking into account the
brightness of the surroundings and to the brightness which you can be easily observed the

screens.

Section 2 Name and Function of Each Unit 2-4



2.2 Names and Main Functions of the
Top Screen

This section describes the names and main functions of the top screen.

2.2.1 Conning Display top screen

Any of the following screens is displayed as the top screen depending on the Conning Display you use.

Refer to “4.2 How to view each block” Refer to "2.2.2 Task Switching Button”

Refer to "2.2.5 Alert
notification area"

75 kkkk

Hos - 000.0

e MAN
61°00.010'E

Refer to "2.2.3 Right
Toolbar"

Active alert,
acknowledgement
enable alert, and task
switching button

* Refer to the Memo in
the next page.

Depth(FWD;

Trans

Refer to "2.2.4 [Menu] button"

Top screen (1) (with AMS license)

2-5 Section 2 Name and Function of Each Unit



Refer to “4.2 How to view Refer to “2.2.2 Task

each block”

Offshore

1 Ship Handling

2 Ship Handling

Ship Handling

ré Shlp Handling
i

ing

Thruster2
Thruster3
Thruster4 DP
Thrusters DP

Refer to “2.2.4 [Menu] button”

Switching Button”

Refer to “2.2.5

LMT 2016-05-18 16 Alert notification
080.0 area”
S - 31°59.9868'S Gyro : e
60°00.3579'E 10.01 Cause
Log -| Depth below
086.8 n
5.0 No.” :
GPS : - Refer to “2.2.3 Right
Toolbar”

Active alert and
Acknowledgement
Enable alert

0 Refer to the
omeg] o] L | Ssialgiiine “Memo”

' shown below.

Current

Depth below keel

Top screen (2) (with AMS license)

The top screen (1) and top screen (2) are displayed when the AMS license is available.

When there is no AMS license, the top right of the screen is as shown below.

Refer to "2.2.2 Task Switching Button"

Refer to "2.2.5 Alert notification area"

Refer to "2.2.3 Right Toolbar"

Memo

The active alert and acknowledgement enable alert are displayed when the AMS license is available.

For the details, refer to "(1) Active alert” and "(2) Acknowledgment enable alert" in "3.2.2 Conning

Display" of the "Bridge Alert Management System (BAMS) Instruction Manual".
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2211 Color-coded numeric display
The background of the value from each sensor is displayed in three colors.

Background color Status of numeric value

Normal color The numeric value is normal.

GPS 1 -~

WG@a5-84

Yellow The numeric value is displayed in yellow when it is unreliable such as when

the difference with the previous value is greater than the threshold value.

CLENERA  32°00.153'S
ISR  61°00,925'E

Orange When the numeric value is abnormal, "****" is displayed in orange.

2.21.2 Color coding of bar graphs
Bar graphs are color-coded at display as follows.

Red: Port side/backward direction

Green: Starboard side/forward direction

2.21.3 Numeric box
A numeric value is displayed in the numeric box outside of the graph as required.

Example: Arc-like bar graph (rudder angle, etc.)

Rudder

Actual (pR18.5

Memo
The graph and numeric value box are displayed separately from each other depending on the
Conning Display you use.
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2.2.2 Task Switching Button

[PRIMARY ]

RADAR ECDIS CON AMS Task switching button

To switch to a required task, click on the task switching button.
Click on the task to be executed from [RADAR]/[ECDIS]/[CON] (Conning Display) /[[AMS].

Memo
The [Primary] badge is displayed on the task that is set to the Primary function (basic task).

Example: ECDIS is the Primary function
[PRIMARY]

RADAR ECDIS CON AMS

2.2.3 Right Toolbar

The functions of the buttons of the right toolbar are as follows.

Day/Night button

The display color on the screen can be
switched to 5 levels according to the
brightness on the bridge.

For the details, refer to "3.7 Switching the
Day/Night Mode".

Display Brightness button MOB (Man Over Board) button
The brightness of the screen can be When a person falls overboard, use this
switched within the range from 0 t0100. button to mark the own ship’s position

when the button is clicked on, so as not to
lose the sight of the position.

For the details, refer to "3.8.1 Adjusting the

Brightness of the Screen and Operation

Unit". For the details, refer to "3.9 MOB (Man
Over Board)".

Message notification
button
Not used on the Conning
Display.

Panel Brightness button
Switch the brightness of the operation unit to any of the 5 levels, 0
to 4.

For the details, refer to "3.8.2 Adjusting the Brightness of the
Operation Unit".
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2.2.4 [Menu] button

When the [Menu] button on the bottom left corner of the screen is clicked on, the top menu is
displayed.
For the menu operation, refer to "3.4 Basic menu operation".

2.2.5 Alert notification area

2.2.51 Condition where there is no AMS license
When an alert occurs, the alert status, the content of the alert and the occurrence count are displayed
in the alert notification area.

List

For the details, refer to "3.6 Confirming and Acknowledging an Alert".

2.2.5.2 Condition where there is an AMS license
When an alert occurs, the alert status and the content of the alert are displayed in the alert notification

area.

speed limit Not Set

Neither alert confirmation nor approval can be performed by operating the alert notification area.
Alert confirmation and approval can be performed from the active alert display and the approval
enabled alert display.

For the details, refer to "(1) Active alert" and "(2) Acknowledgment enabled alert" of "3.2.2 Conning
Display" of the "Bridge Alert Management System (BAMS) Instruction Manual".
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Section 3 Basic Operations

3.1 Powering On and Starting

Turn on the power supply according to the following procedure.

ACAUTION

For low-temperature start-up, perform pre-heat for more than 30 minutes.

Otherwise, an operation failure may occur and an accident may occur.

1 Press the Power button on the operation unit.
The Power button is lit and the start-up screen is displayed.

Memo
When power is applied with all the power supplies to the display unit shut off, the display
unit starts automatically even when the Power button is not pressed.

After the start-up screen is displayed, the task menu is displayed after a brief interval.
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3.2 Starting Each Mode

When this equipment starts up, a task menu is displayed on the screen.

On the Task menu, you can select and start the desired mode from the operation modes available for
this equipment.

:-Tasi: i';'lenu

Route Planming Mavigation Data Alert
Foute Monitoring Monitoring Management
{ECDIS) (Canning Display) {AMS)

Collision Avoidance
(RADAR)

2w

Chart Data
Playback
s s Maintenance Backup/Restore

Password

R R R R

Task Menu Display Example

When the button of the mode to be executed is clicked on, the screen of the mode is displayed.

Note
When this equipment is started for the first time, if no operation is performed within 10 seconds
after the task menu is displayed, the mode screen that has been set up at the time of shipment will
appear.

3.2.1 Starting Conning Display

To display the top screen of Conning Display, click on the [Navigation Data Monitoring (Conning
Display)] button in the task menu.
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3.3 Basic Operations when using a
Trackball

A trackball in the trackball operation unit is mainly used for the operations of this equipment.
This section describes the basic operations performed using the trackball.

3.3.1 Trackball functions

) @D |y

Trackball

Left button Right button

Trackball:
Use the trackball to move the cursor on the screen. Use the trackball for specifying a position, and
setting a button and a dialog box.

Left button:

Use the left button to determine the position, and determine the button and dialog box settings.

In this manual, "click" refers to the clicking of the left button once and "double-click" refers to the
clicking of the left button twice consecutively.

Right button:
Do not use the right button while operating Conning Display.

3.3.2 Basic trackball operations

Move the cursor that is displayed on the screen by the trackball and perform various operations using
the left mouse button.

3.3.2.1 Cursor types

Only the "Pointer Cursor" type ( K ) is available.
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3.3.3 Basic click operations

When the cursor is set to a button and the button is clicked on, the function of the selected button is
executed.

*  When a function On/Off button is clicked on, the setting is switched to On/Off each time.

+  When a function selection button is clicked on, the function selection menu is displayed.
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3.4 Basic Menu Operations

Various functions can be executed or set from the menu that is displayed by clicking on the [Menul]

button.
This section describes the basic menu operations.

3.4.1 Opening the menu

1 Click on the [Menu] button at the bottom left corner of the screen.

[Menu] button

The top menu is displayed.

Page switching button

2 Click on one of the buttons that are displayed on the menu.
A dialog box for executing or setting the applicable function appears.

L

Color and Brightness

Color and Brightness Day/Night EV| ~ | Def.

Sounds Display Coler | Brightness

Key Assignment Dialog[T |Dark |

Character | [l White =

Display Example
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3 A submenuis displayed depending on the function. In this case, display a dialog box
of the function by clicking on the button on the submenu.
Example: Maintenance

Top menu

Maintenance submenu

Menu > | Maintenance > 1/1

<& Date/Time/Time : : : : : e Sensor Selection/
o o a o
- N Zone v System Information | X Operating Time N Status

B D oEanens XX SoftwareUpdate > DVD Drive Cleaning

Page switching button

Memo
When the submenu screen extends over two pages, similar to the menu screen, it is possible to
switch between the pages using the page switching buttons.
It is not possible to use the page change buttons in Conning Display.

3.4.2 Menu list

The menus that are displayed vary according to the task that is currently being executed.

Menu Related section
View Section 5 Setting Up Screen View
Alert Section 6 Setting Up Alerts
Settings Section 7 Setting Up the Operation Mode
Maintenance 9.1 Maintenance Functions Executed from Menu
Help 3.13 Help
Code Input 3.14 Password Input
Service Section 8 Adjusting and Setting Up Equipment (for Services)

3.4.3 Closing the menu

Click on the [X] button on the menu (submenu).
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3.5 Basic Dialog Box Operations

When a dialog box is opened, the dialog box is in the factory setting state or state at termination of the
previous operation.

3.5.1 Changing dialog box settings

This section describes how to change the settings by using some dialogs as the examples.

View-Options »
Unit

> [Depth (Included Depth in Chart)]
list

Select [m], [ft], or [fm] from the list.
(Perform the same operation for the
lists from [Ship Speed].)

Unit
Current Speed

Nind S Y=Ta
Depth Graph Wind Speed

Rudder Graph Propeller Revolution

Propeller Pitch Angle

Gyro/Rudder Graph

Thruster Revolution
Thruster Pitch Angle
Air TEMP °C~
Water TEMP °C~
Air Pressure hPa -

XTD/XTL for TCS Info NM -

Engine Graph
Wind Graph
Sea TEMP
ROT

Wind Direction(True) 16points -

[View-Options] dialog

L3

Key Assignment

Multi Dial

vIPanel Brightness [Panel Brightness] check box
Set the function to ON or OFF by
selecting or clearing the [Panel
Brightness] check box.

[Multi Dial] tab of the [Key Assignment] dialog
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[Ship’s Name] box
Enter a ship’s name (characters)

Installation
System Ship's

Cat i
o . Settings
Configuration Parameters =

Ship General Ship General

Ship's Name
Length 100.80 m [Length] box
Beam 150 m Enter the ship’s length (numeric).
Height from keel to MAX point 30.0 m (Perform the same operation for the

e [Beam] and subsequent boxes.)
MAX Course Change 150.0 °

MAX Speed Limit 30.0 kn

MIN Speed Limit kn
MAX ROT 0 °/min
MIN ROT 000. °/min

MIN Turn Radius ) NM

[Ship’s Parameters] dialog

3.5.2 Closing the dialog

Close the dialog by clicking on the [X] button of the dialog.

View-Options » [x] button
Unit
S-JOY
(Included Depth in C ) L
Unit Ship Speed kn
Current Speed kn
ln\{l nd S C o
Depth Graph Wind Speed kn

Rudder Graph Propeller Revolution rpm

AR R Propeller Pitch Angle

Thruster Revolution rpm
Thruster Pitch Angle %
Air TEMP °C

Water TEMP °C

Engine Graph

Wind Graph
Sea TEMP
ROT

Air Pressure
XTD/XTL for TCS Info

Wind Direction(True) 716points -
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3.5.3 Title Bar

The name (title) of the dialog box is displayed on the title bar of the dialog box.

Title of the dialog box

View-Options " X
Unit
S-Joy
(Included Depth i L

Unit M

Current Speed kn -

Depth Graph Wind Speed kn ~

Rudder Graph Propeller Revolution rpm -

Gyro/Rudder Graph Propeller Pitch Angle

. - Thruster Revolution
Engine Graph
Thruster Pitch Angle
Air TEMP
Water TEMP
Air Pressure hPa ~
XTD/XTL for TCS Info NM ~

Wind Direction(True) 16points ~

Wind Graph
Sea TEMP
ROT

The dialog can be moved by dragging the title bar.
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3.6 Confirming and Acknowledging an
Alert

Memo
This section explains the display and operation at the occurrence of an alert when there is no AMS
license.

When an alert is generated, a buzzer sound is emitted and an alert balloon is displayed in the alert
notification area.

@ eed limit Not Se
List

179 [ TAK B

Safety contour monitoring st... ~ Disclosure button

Example of Balloon Alert

X|

To acknowledge the alert detailed information, click on the Disclosure button.

For the details of the subsequent operations, refer to "3.6.2 Confirming alert contents".

The general procedure for handling an alert is shown below.

[ Alert generation ]

A 4

Stop the buzzer
"3.6.1 Stopping a buzzer"

\ 4

Check the alert contents
"3.6.2 Confirming alert contents"

A 4

Acknowledge the alert
"3.6.3 Acknowledging the alert"

A 4

[ Resolve the alert cause ]
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3.6.1 Stopping a buzzer

To stop a buzzer (silencing), click the silence button in the alert notification area or press the

[SILENCE] key in the trackball operation unit.

SILENCE button

Alert notification area

[SILENCE] key

N ED | e

3.6.2 Confirming alert contents

Alert status area

Alarm Caution button
button

Warning button

Display Example when an Alert is generated

Display Example when No Alert is generated

3-11
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When an alert is generated, the alert message is displayed in the "Alert status area".
The alert type and the number of alerts are displayed by the button.

Alarm Caution button
button

Warning button

» Alarm button: Displayed when an alarm is generated. The button is displayed in red. The
number of alarms is indicated on the button

« Warning button: Displayed when a warning is generated. The button is displayed in orange. The
number of warnings is indicated on the button.

» Caution button: Displayed when a caution is generated. The button is displayed in yellow. The
number of cautions is indicated on the button.

1 Click on the button.
An alert balloon is displayed.

@ eed Limit Not Se
List )
179 [ TAck ¥ %

Safety contour monitoring st... ~ Disclosure button

2 Display the alert detail dialog by clicking on the Disclosure button.
1] [2]

Status: ACTIVE-UNA

GE

(4]

dition of

rath. On
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[1] [Higher] button
When the Higher button is clicked on, details of the alerts of the higher priority than the alert currently

displayed appear.

[2] [Lower] button
When the Lower button is clicked on, details of the alerts of the lower priority than the alert currently
displayed appear.

[3] Disclosure button
When the Disclosure button is clicked on, the original alert balloon is displayed.
As a result, the operation area that was hidden can be re-acknowledged.

[4] Detail information
Cause (Cause), status (Status), date and time (Raised), details (Details) and action (Advice) to be
taken are displayed.

Memo
About Information:
Information is displayed in addition to a warning or a caution in the alert status area.
Information is used to report operation errors and so on to the users.
Unlike other alerts, no detail display is provided for Information.
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3.6.3 Acknowledging the alert

After checking the alert contents, when the [ACK] button of the alert details or [ALERT ACK] button of
the trackball operation unit is clicked on, the alert that is displayed is acknowledged.

When there are multiple alerts, perform the same operation by displaying the details dialog box of
another alert.

If all the alerts are acknowledged, the alert display dialog is closed automatically.

ACE [ACK] (acknowledgement) button

oY

8 Warnings (UMACK: 8)

e: Heading({unavailable)
5! ACTIVE-UNACKMOWLED
GE

Raised 21 May,2014 05:22:56

Details: The Heading data cannot

Advice: Check t

Memo
An alert can also be acknowledged by clicking on the [Active Alert] tab - [ACK] button of the [Alert
List] dialog box.

For the details refer to "3.6.4 Displaying alert list and alert history".
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3.6.4 Displaying alert list and alert history

An active alert and alert history can be displayed in list format by clicking on the Alert List button.
In the [Active Alert] tab, a list of the current alerts is displayed. In the [Alert History] tab, a list of past
alerts that have been resolved is displayed.

Memo
The window of the [Active Alert] tab can be switched to standard window display or extended
window display.
In this example, extended window display is used.
For the details of switching between standard window and extended window, refer to "3.6.4.1

Switching between a standard window and an extended window".

Alert list button

e
History

03 Active Alerts  (UNACK:3) EIEN raxge1n Higher ACK Lower

FaisedUIC) | Cause: SLC1-2 communication

failed(LAN1)
Raised 2014-05-23 06:07:54
TC):

Details: Communication with
SLC1-2 cannot be
performed via LAN1.

: the condition of

and LAN1.

nnot be recovered
after you check the
connection of the
equipment cable in
power -off statusand
restart, turn off the
power of the device and
contact your distributor.

IAcknowledged| -

a4

[Active Alert] Tab of the [Alert List] Dialog Box [Alert History] Tab of the [Alert List] Dialog Box

Memo
If the alert category is category A, alerts cannot be acknowledged with the [ACK] button in the

active alert list.
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[Active Alert] tab

(1] (2]

‘ [nformation Referen e

Active [ lert
Alert tistary

@3 Active Alerts UNACK:3) | DB eaceisd

‘ Status v| ai ) Cause:|SLC1-2 communication
TAcK | failed(LANT)

Raised 2014-05-23 06:07:54
UTO):
Details:| Communication with
SLC1-2 cannot be
performed via LAN1.

Advice:|Check the condition of
SLC1-2 and LANT.
If it cannot be recovered
after you check the
connection of the
equipment cable in
power-off status and
restart, turn off the
power of the device and
contact your distributor.

| Acknowledged
UTO):

Original|Warning
Priority:

(3] 4]

[1] Active alert information
The number of current alerts is displayed.

Number of unacknowledged alerts

Number of alerts

[2] Active page information
Up to 20 alert information items can be displayed in one page. Use this function to switch pages when
the number of alert information items exceeds 20, requiring multiple pages.

Move to the Move to the last page
first page
Move to the previous page Move to the next page
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[3] Active alert list

» The alerts that are being generated are displayed. When any of the alerts is clicked on, the alert can

be set to a selected state.

* The details of the selected alert are displayed in "[4] Active alert details".
* When a new alert is generated during the screen display, the alert is added at the top of the list.
» By clicking on any of the items in the title line, active alerts can be sorted based on the item.

- aus RaisedUTC})

1 comm

SLC1-2 compmin

SLCT-2 communication

Depth(unavail

Memo
The [ACK] button is not displayed for the [Caution] alert since acknowledgement is not required.
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[4] Details of active alert
Details of the alert that is currently selected are displayed.

Lower

munication

Detai

Alert Detailed information
Cause Displays the cause of the alert.
Raised Displays the alert generation time.
Details Displays the details of the cause of the alert.
Advice Displays advice on the alert (action to be taken by the user).

Acknowledged Displays the time when the alert was acknowledged.

Category Displays the alert category.

Priority Displays the current alert priority (identification of Alarm/Warning/Caution).

Original Priority | Displays the priority (identification of Alarm/Warning/Caution) at the generation of
the alert.

[Higher] button
When this button is clicked on, the details of the alert of the higher priority than the alert that is currently
displayed appear.

[Lower] button
When this button is clicked on, the details of the alert of the lower priority than the alert that is currently
displayed appear.

[ACK] button
When this button is clicked on, the alert that is currently selected is acknowledged.
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[Alert History] tab
Alerts that have been generated in the past are displayed.

[nformation Reference

Active Alert
Alert History

Cause Raised(UTC) i C) Rectified(UTC)

2014-04-18 2014-04-18

Caution

Warning t plausible) 2014-04-130

2014-04-13 @5:
2014-04-13 05:
4-04-13
4-04-13 04:57 2 04-13 05:
2014-04-13 04:56: 2014-04-13 B5:
ng(unavail ) 2014-84-13 84:55:14 -
h(unavailable) 2014-04-13 04:55:04
inavailable)
Inavai

eed(unavailable)

» Up to 20 alerts are displayed per page.

+  When a newly acknowledged alert is generated during the screen display, the acknowledged alert is
added to the top of the list.

» By clicking on any of the items in the title line, active alerts can be sorted based on the item.
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3.6.4.1 Switching between a standard window and an extended
window

The window of the [Active Alert] tab can be switched to a standard window or an extended window.
To switch to an extended window, click on the list extension button.
To switch to a standard window, click on the list standard button.

List standard button

Information Reference

Active Alert
Alert History

List extension button

[Example of Extended window]

‘ [nformation Reference

Active Alert
Alert History

03 Active Alerts (UnAck:3) DR Pxcein (HIEY i ACK Lower

Status Cause Raised UTC) Cause:|SLC1-2 communication

SLC1-1 communication failed(LANT) | 2014-85-22 21:07:54 ol
0 ‘ ACK |SLC1 2 communication failed(LANT) 2014-05-77 71:07:54 et B o S to

Details: Communication with
SLC1-2 cannot be
performed via LAN1.

t|Check the condition of
SLCT-2 and LANT.
[f it cannot be recovered
after you check the
connection of the
equipment cable in
power-off statusand
restart, turn off the
power of the device and
contact your distributor.

Acknowledged
uTc):

Category:

Original
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[Example of standard window]

A list screen and a detail screen are available for the standard window.
To switch to the detail screen: Click on the [Detail] button.

To switch to the list screen: Click on the [List]

Information Reference

Active Alert v

@3 Alerts _ __ Page
4 1 o
(UNACK: 3) 11

Status - Cause [

0 | ACK |SLC1 -1 communication faile...‘

Cause: |(SLCT-1

communication

failed(LAN1) Scroll bar
Raised 2014-05-23
(UTC):|06:07:54

0 ACK |SLC1-2 communication faile...

Depth(unavailable)

Details:|Communication with
SLC1-1 cannot be
performed via LAN1.

Advice:|Check the condition
of SLC1-1 and
LAN1T.
If it cannot be
recovered after you

i [»

Detail

Scroll bar [Detail] button [List] button

When the display contents overlap the top, bottom, left, or right side of the screen, a scroll bar is
displayed.
By dragging the scroll bar, the overlapped section can be displayed.

Memo
An extended window is displayed at the initial display.
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3.7 Switching the Day/Night Mode

The screen display color can be switched to any of five levels according to the brightness within the
bridge.
Use the following procedure for switching.

1 Click on the Day/Night button on the right toolbar.

Example: Day2 is set.

2 Adjust the brightness by using the ! [Light] button and the n [Dark] button.
Whenever the n [Light] button is clicked on, the brightness increases by one level from the

current level.

When the : [Dark] button is clicked on, the brightness decreases by one level from the

current level.

@:11 :Day 1
:Day 2
:Day 3
: Dusk

 Night

HEBEE
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AWARNING

Change of the color of the Day/Night button, particularly the use of the [Night]

color, may interfere with the recognition of display information.

Memo
The colors and brightness of the buttons can be changed by setting [Settings] - [General] - [Color
and Brightness] in the menu. For the details, refer to "7.2 Setting Color and Brightness".

Relationship between the day/night mode and the screen/operation unit brightness setting
value
When the day/night mode is changed, the screen/operation unit brightness is set to the following

values.
26-inch monitor 19-inch monitor

Screen Day1, Day2, Day3: 67/100 Day1, Day2, Day3: 42/100
brightness Dusk: 60/100 Dusk: 20/100

Night: 11/100 Night: 4/100
Operation unit | Day1: Level4
brightness Day2: Level3

Day3: Level2

Dusk, Night: Level1
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3.8 Adjusting the Brightness of the
Screen and Operation Unit

3.8.1 Adjusting the Brightness of the Screen

The screen brightness can be adjusted within the range from 0 to 100.

1 Click on the [Display Brightness] button on the right toolbar.

2 Adjust the brightness by using the n [Light] button and n [Dark] button.
Whenever the [Light] button/ [Dark] button is clicked on, the brightness changes by one level.
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3.8.2 Adjusting the Brightness of the Operation Unit

The brightness of the operation section can be adjusted in 5 levels (0 to 4).

1 Click on the [Panel Brightness] (Brightness of the operation unit) on the Right Tool

Bar.

The following operation unit brightness buttons are displayed.

2 Adjust the brightness by using the u [Light] button and n [Dark] button.
Whenever the [Light] button/[Dark] button is clicked on, the brightness changes by one level.
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3.8.3 [Display Brightness] dialog box

When [MULT]I] dial is operated while [Display Brightness] is selected as the function that is assigned to
the [MULTI] dial, the [Display Brightness] dialog is displayed.

-O- Display Brightness

-

100

Advanced

It is possible to adjust the brightness of the display section by rotating the [MULT]I] dial.

In order to set an offset value so that when set to the same value as the screen brightness of other

equipment, the light emitted becomes the same as in other equipment, click the [Advanced] button and

adjust the offset using the _ buttons displayed for setting the "Offset".

Display Brightness

Advanced

Offset
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3.9 MOB (Man Over Board)

When a person falls overboard, this monitoring function prevents loss of sight of the position of the
person overboard.
The MOB use procedure is as follows.

1 Click on the MOB button on the right toolbar.

The [Marker] dialog box appears.
See below for how to reference the [Marker] dialog box.
Mar ker

1 Position 32°19.517'S
61°12.417'E

[2] Bearing 225.2 ®
(3] Range 0.543 NM [4]
(3] TTG Oh&1mB5s

[6] Time Bh&1mbds

[1] [Position]
Displays the coordinates of the MOB.

[2] [Bearing]
Displays the bearing from own ship to the MOB position. The value changes as the ship moves.

[3] [Range]
Displays the range from the own ship to the MOB marker.

[4] NM/Km/sm switching button
Whenever this button is clicked on, the unit of [Range] is switched to NM, km or sm.

Memo
NM denotes nautical mile, sm denotes statute mile, and km denotes kilometer.

[51[TTG]
Displays the time to reach the MOB marker from the ship speed.

[6] [Time]
Displays the time elapsed after clicking on the [MOB] button.
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To exit from MOB

1 Click the [X] button in the [Marker] dialog box.

Marker

Position 32°19.517'S
61°12.417'E

A confirmation dialog box appears.

2 Click on the [OK] button.
The [Marker] dialog is closed.
The MOB marker is cleared.

System

Exit from MOB 7

oK Cancel

Memo
When the equipment has the ECDIS license, the MOB marker that indicates the MOB
position is displayed on the chart of the ECDIS screen, enabling confirmation of the

position relationship between own ship and the MOB position while the ship is moving.

Section 3 Basic Operations 3-28



3.10 [MULTI] Dial

3.10.1 Functions of [MULTI] dial

By turning the [MULTI] dial, the functions that are assigned to the [MULTI] dial can be operated.
Assignment to the [MULTI] dial can be changed.

3.10.2 Functions assigned to [MULTI] dial

3.10.2.1 Displaying a screen for setting the function that is
assigned

By pressing the [MULTI] dial, the setting screen for the function that is currently assigned can be

displayed.

Assigned function name

3.10.2.2 Changing the function that is assigned
1 Press the [MULTI] dial.

2 Select a function to be assigned by turning the [MULT]I] dial.

The table below lists the functions that can be assigned.

Function name Function outline
Display Brightness Adjustment of brightness of the display panel
Panel Brightness Adjustment of brightness of the operation panel

3 Press the [MULTI] dial.
The selected function is set to the assigned function.
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3.11 Basic Operations of the Software
Keyboard

Use a software keyboard for inputting numeric values and characters in various setting operations.
This section describes the basic operations of a software keyboard.

3.11.1 Starting a software keyboard

When the mouse button is clicked on a numeric input text box on such as a dialog box, a numeric input
software keyboard is displayed.
When the mouse button is clicked on a character input text box, a character input full keyboard is

displayed.

4

MAX: 126.0m
MIN:1.0m

Enter

The mouse cursor moves to the
inside of the software keyboard.

MAX: 20 characters - DEL

abc 4 6 9 o CLR €&

MIN ROT 000.1 ABC q r i Cancel

MIN Turn R:

1"#
Enter
Align
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3.11.2 Name and function of each section of the
keyboard

Numeric value input software keyboard

(3] (3]

(1]

(2]

MAX:7.613NM
MIN: -7.613NM [ — 4

(6]

(7]
(8]

9]

Sowtware full keyboard for character input

* The description of the functions common to those of a numeric value input software keyboard is omitted.
(18]

MAY: 2@ characters > DEL
[1 3] ah . - 7 ’ = o 4 CLR ﬂ
[14] 3C C ; ' ] Cancel

[15] 1"

Enter

[16] Align

[17]
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[1] Input value display section
Displays the value that is input/edited through the software keyboard.

[2] Spin button

* When the right spin button is clicked on, the minimum unit value that can be set is added to the
value that is displayed. When the left spin button is clicked on, the minimum unit value that can be
set is subtracted from the value that is displayed.

©199.0

0200.0

Example of addition

*  When the mouse button is held down on the right spin button, the value is added consecutively.
When the mouse button is held down on the left spin button, the value is subtracted consecutively.

*  When the value set by the right spin button operation exceeds the maximum value, the minimum
value is set subsequently. When the value set by the left spin button operation becomes lower than
the minimum value, the maximum value is set subsequently.

[3] Numeric value slider
When the value adjustment button on the value slider is clicked on, the input value increases or
decreases.

[4] Operation guide display button
Displays an operation guide.

000000000

‘ [MULTI DIAL]
cw :Addition
- |[CCW :Subtraction
DOWN >

[SLIDER]
Cancel |Valueisinputted by cursor
movement.
Move onto a slider and click a
Enter maouse cursor.

To close the operation guide, click on the operation guide display button again or click on a location
other than the operation guide.

[5] [CLR] key
Clears the input value that is currently selected.
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[6] Back Space key
Clears the input value on the left-side of the cursor position.

[7] [Cancel] key
Cancels the input operation and closes the software keyboard.

[8] Option key
Displays the following keys according to the type of the software keyboard.
» Signed keyboard: + key and - key

[9] [Enter] key
Determines the input operation.

[10] Input range display section [format display section)
Displays the values and character types that can be input.

[11] Numeric keys
Use the keys for input of numeric values.

[12] Arrow keys
When there are multiple input parts, the active part can be moved to the left/right by clicking on the

arrow key.

Example:

When the [left arrow key) is clicked on, the input section moves to "0100".

When the [right arrow key) is clicked on, the input section moves to "0".

0100.8

[13] Lowercase character switching key
Changes the character input key mode to the lowercase character mode.

[14] Uppercase character switching key
Changes the character input key mode to the uppercase character mode.

[15] Symbol switching key
Changes the character input key mode to the symbol mode.

[16] Key alignment switching key
Switches the character key alignment between QWERTY alignment and alphabetic alignment.
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[17] Character input key
Use this key for character input.

[18] [DEL] key
Deletes the character on the right-side of the cursor.

3.11.3 Example of numeric input

In this example, "241.5m" is input as the length of the ship.
When the numeric input software keyboard is displayed, follow the procedure provided below.

1

MAX: 1022.0m
MIN:1.0m ®

CLR €3

Cancel

Enter

1 Enter"2".

2 Enter "4" and "1".

241.0

3 Click the right arrow key and move the input field to the right side of the decimal point.

0241.6

Enter "5".

Click on the [Enter] key.
The input is fixed.

Section 3 Basic Operations 3-34



Inputting a single-digit value
Enter a value and click on another input part or move the active part by using the right arrow key.

Example:

©200.0

Enter 1.

1.0

The value that is input by clicking on another input part or
the right arrow key becomes a single-digit value and the
0001.0 value is determined. 0 is input in the blank space.

Inputting blank space in the decimal fraction section [3 digits)
After a value is input and the [Enter] key is clicked on, the input of the decimal fraction section is
determined.

Example:

Enter "5" and click on the [Enter] key.
"0" is input in the blank space next to "5" and the value is determined.
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3.11.4 Character input example

This section describes character input by using a full keyboard.

Input caret
Indicates the character input position.

\
Active mark

Indicates the character string that is being input.

Input example

1 startupafull keyboard.

When a value (character) has been input in the text box, the full character string is selected at
startup.

dddddadadddad

2 Delete the character string by clicking the Back Space key.
3 Input any character string.

4 Determine the input by clicking on the [Enter] key.
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Character modification example

1 Move the cursor to the left-end (or right-end) of the character string to be modified and

click the mouse button.

The input caret moves to the clicked position.

abcdefgh

2 Click the mouse button on the input caret position and select the character string to be
modified by dragging with the trackball.
*When the character string is selected, the input caret is cleared.

abcdefagh

3 Perform the following operation in the selected state.

[Deleting a selected section]

abcdefgh

When the Back Space key is clicked on, the
selected section is deleted.

[Replacing a selected section]

lm

abecilh

Input any character in the selected state. (In this

example, "i" is input.)

[Canceling a selected state]

7 thm, 1
a b c | dief .gh ”

Under a selected state, click on another section inside of the active mark
to cancel the selection. The input caret moves to the clicked position.

4 After modification is determined, determine the input by clicking on the [Enter] key.
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3.12 Setting a Date and a Time (Calendar
Operation)

Set a date and a time on the calendar input screen.
Use the following calendar for Conning Display.

MAY  » « 2012 »
MON TUE WED THU FRI SAT

ST IS BT (RO

7 8 10 11 12

14 15 16 17 18 19
0 21 22 23 24 25 26

0 31

Calendar picker

3.12.1 Details and usage of a calendar picker

3.12.1.1 Details of a calendar

[2] « 2013

2
SUW MOW  TUE WED THU  FRI 54T

1T 2 3 4 5 6 7/

(1]

18 11 12 13 14
17 18 19 20 21|

15 26 27 28

Selected date

[1]1 Year selection spin button

Selects a year to be displayed in the date selection box.

*  When the right spin button is clicked on, the year is changed in the ascending order.
» When the left spin button is clicked on, the year is changed in the descending order.

[2] Month selection spin button

Selects a month to be displayed in the date selection box.

* When the right spin button is clicked on, the month is changed in the ascending order.
*  When the left spin button is clicked on, the month is changed in the descending order.
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[3] Day selection box
Selects a day.

3.12.1.2 How to use a calendar

1 Clickon D (calendar button) next to the date setting box.

A calendar is displayed.

Setup of UPS

Setup Date (UTC) 2014-04-08 08:25

Time
<« 2014

TED THU R SET
N I 1o
9 10 11 12
16 17 18 19
23 24 25 26

30

2 Seta year and a month by using the year selection spin button and the month

selection spin button respectively.

3 Click on the day to be set from the day selection box.
* In the case of a calendar picker only, the day is set at this stage and the calendar picker is

closed.

4 setatime by clicking on the time spin button of the time picker.

Click on the [OK] button.
The setting is completed and the calendar is closed.
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3.13 Help

Help information on the operation of this equipment can be displayed.

Memo

The Preface, Section 1 and Appendix A are not displayed in the Help.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Help] button on the menu.
The [Help] dialog box appears.

21 [5] [6] [8]

(1] f

[3] Contents Search

Section 2 Name and Funct}* Section 2 Name and

ction 3 Common Basic (
Section 4 Range and Bear Function of
Section 5 B Operatior
Section 6 Target Tracking

Section 7 True and False | EaCh Unlt

Section 8 Functions of th

[7]

Section 9 Route Planning e —
) Section 10 Route Monito | | 2.1 Name and Main Function

ction 11 Monitoring a | of the Operation Unit
Section 12 Automatic Sai
Section 13 Operatinga Cl| | 2.1.1  Trackball operation unit

Section 14 Creating a Use

Section 15 Loghook

Section 16 Setting Up Sci
Section 17 Setting Up Al
Section 18 Setting Up th
Section 19 Adjusting and |-

[1] Backward button

The display of the content display pane goes backwards by one.

[2] Forward button

The display of the content display pane goes forwards by one.
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[3] [Contents] tab
Displays the contents. The contents are displayed in the content pane.

For the procedure, refer to "Searching the required information from the contents".

[4] Content pane
The contents are displayed in tree format. When an item is clicked on, the related

contents are displayed in the content display pane.

[5] Home button

Displays the home screen of the [Help] dialog box.

[6] [Search] tab
Searches the character string in Help.

For the procedure, refer to "Searching terminologies".

[7] Content display pane

Displays the contents of the item that was clicked on.

[8] [*] button.
Closes the [Help] dialog box.

Searching the required information from the contents

1

Click on the [Contents] tab.
The contents are displayed on the contents pane.

Click on the item containing the required information.
The contents of the item that was clicked on are displayed on the contents display pane.

Help
<EHh

Contents Search 7.31 Sea clutter
Section 2 Name and Funct *
Section 3 Commaon B
Section 4 Range and Bear
Section 5 Basic Operatior
Section 6 Target Tracking
Section 7 True and False |

7.1 Radar Wave with th
7.2 Intensity Reflectec

7.3.3 Coping with se
v 7.4 False Echoes
v 7.5 Display of AIS-SAR
Section & Functions of tF
Section 9 Route Planning
Section 10 Route Maonito

Section 11 Monitoring a | ~
»
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Searching terminologies

1 Click on the [Search] tab.
A search character input box is displayed.

2 Entera required terminology and click on the [Search] button.

Search is performed within Help. When the applicable terminology is hit, the item containing the
terminology is displayed on the contents pane.

3 Click on the item containing the required information.
The contents of the item that is clicked on are displayed on the contents display pane.
Help

- B

Contents Search Sea clutter
radar

Search
6.7.2 Alarm for new targ... |~
7.1 Radar Wave with the ...
L2 Intensity Reflected f...
7.3.1 Sea clutter o . relation between the ¢
7.3.2 Rain and snow clut... ing t ated by wind and the radar’
7.3.3 Coping with sea clu...
7.3 Sea Clutter and Rain...
7.4.1
7

Shadow

4.
4.2 Side lobe effect

7.4.3 False echo by secon...
7.4.4 False echo by multi...
7.4.5 Second time echoes

7.4.6 Radar interference
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3.14 Password Input

Equipment settings are protected by a password. To open the dialog box of the protected setting
function, the password input is necessary.
Use the following procedure to enter a password.

1 Click on the [Menu] button at the bottom left corner of the screen.

[Menu] button
The menu is displayed.

2 Click on the [Code Input] button on the Menu.

The password input dialog box appears.

3 Enter"o" (zero) and click on the [Enter] key.

*ok ok ok ok ok ok ok ok ok

3 clR €4

Cancel

4 Click on the [Menu] button at the bottom left corner of the screen again.
The [Service] button is displayed in the menu.
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5 Click on the [Service] button.

Menu >

iﬁi@?é,@‘?m

L Alert Settimgs Mainte rane Help

Check that service-related menus are displayed in the sub-menu.
Menu >  Service >

pv | B Installation &1 Maintenance

Subsequently, service-related menus can be set.
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3.15 Managing Files with File Manager

The file manager function enables the copying of route files and user map from the hard disk of this

equipment to external storage media such as DVD or from external storage media to the hard disk of

this equipment.

3.15.1 Displaying the [File Manager] dialog box

1 Click on the [Menu] on the left toolbar.

The menu is displayed.

2 Click on the [Tools] - [File Manager] button on the menu.

The [File Manager] dialog box appears.

File Manager

File Management File Load/Save

File Type Route File

Drive & Local Disk

Name

New Route.rtm
New Routel.rtm
New Route2.rtm

New Route3.rtm

3-45

Drive

& Local Disk

Name

New Route.rtm
New Routel.rtm
New Route2.rtm

New Route3.rtm
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3.15.2 File management

The "File Management" tab enables file management.

File management copies files between SSD of this equipment and external storage media and deletes
files.

This section describes file management by using the example copying a file in the file list of the drive
that is specified in the [Drive] list on the left hand side of the dialog box to the drive that is specified in

the [Drive] list on the right hand side.

1 Click on the [File Management] tab.

File Manager

File Management File Load/Save

File Type Route File
Drive &lLocal Disk Drive &Local Disk

Name Name
New Route.rtm New Route.rtm

New Routel.rtm New Routel.rtm

New Route2.rtm New Route2.rtm

New Route3.rtm [ — New Route3.rtm

2 Select the drive that contains the file to be copied from the [Drive] combo box.
Files in the drive are displayed in the list.

File Manager
File Management File Load/Save
File Type Route File
Drive & Local Disk Drive & Local Disk

Name Name
New Route.rtm New Route.rtm
New Routel.rtm New Routel.rtm

New Route2.rtm New Route2.rtm

New Route3.rtm e — New Route3.rtm

[Drive] combo box
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The following file types can be displayed by the file manager.

No. File type File extension Contents

Route File rtm Route

Screen Shot (AUTO) | png Automatically generated screen shot
3 Screen Shot (User) png Manually generated screen shot

Select the files to be copied by checking them.

File Manager

File Management File Load/Save

File Type Route File

Drive &local Disk

Name
v/ New Route.rtm
v/ New Routel.rtm
New Route2.rtm

New Route3.rtm

Delete
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Drive &local Disk

Name

New Route.rtm
New Routel.rtm
New Route2.rtm

New Route3.rtm

Section 3 Basic Operations




4 select a drive of the storage destination from the [Drive] combo box and select a copy

location from the folder tree that is displayed.

File Manager

File Management File Load/Save

File Type Route File

Drive &local Disk

Name
v/ New Route.rtm
v/ New Routel.rtm
New Route2.rtm Copy>>

New Route3.rtm

5 Click on the [Copy>>] (copy to the right) button.

The files are copied.

File Manager

File Management File Load/Save

File Type Route File
Drive &local Disk

Name
New Route.rtm
New Routel.rtm

New Route2.rtm

New Route3.rtm

[Drive] combo box

Drive &UFD 2.0 Silicon-Power4G (F: ~

- m UFD 2.0 Silic Name

> m Q1
m 02
m 03

Drive &UFD 2.0 Silicon-Power4G (F: ~

- m UFD 2.0 Silic Name

> m 01 New Route.rtm
m 02

m 03

New Routel.rtm

When the drive of the copy source and the drive of the copy destination are reversed, click on

the [<<Copy] (copy to the left) in Step 5.

Deleting a file

1 Click on the [Delete] button.
A deletion confirmation dialog is displayed.

2 To delete the file, click on the [OK] button.
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3.16 Returning to a Task Menu by Ending
the Operation

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

[Menu] button

2 Click on the [Code Input] button on the menu.

Menu -
an@E A & '
B

View Settings Mainterane

The password input dialog box appears.

3  Enter 9999 and click on the [Enter] key.

Returns to the task menu.

Chart

Maintenance
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3.17 Terminating this Equipment

AWARNING

Do not hold down the Power button of the operation unit when turning off the
power supply. If the button is held down, the equipment may not be terminated

normally, causing a failure.

1 Pressthe power supply button on the operation unit.
The power is turned off and the light of power supply button goes off.
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Section 4 Each Block of Conning
Display

This chapter describes the screen configuration of Conning Display and the screen details.

Conning Display

This equipment displays information from various equipment units and sensors that are installed
on-board in the most suitable forms.

This supports a quick understanding of the condition of own ship, thereby enabling safe sailing and

navigation.

4.1 Display mode

One of the following two top screens is displayed depending on the Conning Display you use.
Display mode switching tab

- MRS
51°00.812"'E

sl 000.0
o 0.8

Top screen (1)
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-r1 Ship Handling
ip Handling
ip Handling

Ship Handling
Ship Handling

LMT 2016-05-18 16:46:
POSN(Main 080.0
GPS - 31°59.9868'S Gyro
60°00.3579'E 10.@kn
Log

086.8

2.@kn
GPS

EOLED :

A Bow Thruste...

a3 Bow Thruste,.,

‘- H Bow .
3

20000 (15087 “"C L NUp HUp

Wind - True

Mo, & Total !
200 6950 Thru .ee Current

Thruster5 [BP knowledyg Depth below keel

Top screen (2)

On top screen (1), the mode can be switched to any of the three modes of Navigation mode, Docking
mode, and Custom mode by using the display mode switching tabs (refer to “4.1.1 Switching to the
Navigation mode/Docking mode/Custom mode”).

On top screen (2), the mode is fixed to Offshore mode. Unlike top screen (1), a green color that
indicates the starboard/forward direction and a red color that indicates the port/backward direction are
not used.

The following information is displayed in each display mode.

Display mode Information that is displayed
Navigation mode Information on the status of the ship that is navigating
Docking mode Information on the status of the ship that is docking
Custom mode Information that is arbitrarily selected to be displayed on the Custom screen
Offshore mode Information required for offshore working ships

4.1.1 Switching to the Navigation mode/Docking
mode/Custom mode

By using any of the display mode switching tabs at the top left side of the top screen, switching to any
of the three display modes is enabled.
The selected mode is highlighted.

Navigation | Docking Custom
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When the display mode is switched, the contents that are displayed in the area on the left side of the
screen change.
Examples of screens for each mode are shown below.

Navigation | Docking | Custom Navigation | Docking | Custom

No.1 Thruster

Source GPS 1~

Engine- (£ i | Engine-

1000.0 1000.0+

Actual<p Q10 Actual<{p Q10

Navigation mode Docking mode

Navigation | Docking | Custom
Weather IE__El
24.5
15.4
1024
57.5

Custom mode
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4.2 How to view each block

This section describes the information that is indicated in each block displayed on the Conning Display

screen. The information is described on a per-block basis.

All the blocks that can be displayed by Conning Display are summarized in “4.2.1 Block list”.

Search the block whose meaning of the displayed information you want to know from the list and refer

to the corresponding description in “4.2.3 Description of each block”.

For the procedure for selecting a block to be displayed on the screen in Custom mode, refer to “4.2.2

Selecting a block to be displayed on the screen in Custom mode”.

4.2.1 Block list

Reference
Block name Example of the shape of the block ]
section
3D Navigation information and the legend of the 4.2.31
navigation
Information about azimuth thruster of CPP Azimuth THR1 4232
(controllable pitch propeller) type i T 3421(2‘
Information about side thruster of CCP (controllable 4233
pitch propeller) type
Information about propeller engine of CPP 4234
(controllable pitch propeller) type Engine
45.3 o

Propeller

= 554
Information about azimuth thruster of FPP (fixed R Azimuth THR 4.2.3.5
pitch propeller) type 541%2
Information about side thruster of FPP (fixed pitch Stern THR1 4.2.3.6
propeller) type 56
Information about propeller engine of FPP (fixed E— 4237
pitch propeller) type ™ Propeller

A b
N-UP/H-UP switching button 4.2.3.8

NUp HUp
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Reference

Block name Example of the shape of the block ]
section
Ship block 4.2.3.9
Azimuth thruster information (with status) 4.2.3.10
Engine/propeller revolution graph 4.2.3.11
Engine output information 4.2.3.12
Engine telegraph information 4.2.3.13
Engine torque information 4.2.3.14
Rate Of Turn information 4.2.3.15
Weather information Weather 4.2.3.16
Draft information 42317

4-5
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Reference

Block name Example of the shape of the block ]
section

Route information source 4.2.3.18
Route name information ; 4.2.3.19
Final waypoint information 4.2.3.20
Side thruster information (with status) 4.2.3.21
Time/position information 4.2.3.22

GPS 1 32°26.213'S

WGaS-84 61°00.000' E
Automatic sailing information 4.2.3.23
Next waypoint information 4.2.3.24
One after next waypoint information 4.2.3.25
Water temperature graph 4.2.3.26
Water depth graph 4.2.3.27
Water depth information ) 4.2.3.28

9999.9 fm

Surf

Alarm Limit

9999.9 fm g2 *
Thruster drive motor load information 4.2.3.29
Thruster operation position information 4.2.3.30

Aft Support

Aft Support
Aft Support
Ship Handling
Ship Handling
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Reference
Block name Example of the shape of the block ]

section

Thruster steering mode information 4.2.3.31
Manual
Manual
Heading information 4.2.3.32
Graphic display of ship’s heading, course over the 4.2.3.33
ground, wind bearing/wind speed, and current
information
Ship speed information 4.2.3.34
Stern PORT-STBD
0.0
Source GPS 1 -

Hull motion information 4.2.3.35
Steering position information teering POSH PORT 4.2.3.36
Ship speed through water information 4.2.3.37
Course/speed over the ground information 4.2.3.38
Rudder angle/ship’s heading graph T — 4.2.3.39
Rudder angle graph A 4.2.3.40
Rudder angle information 4.2.3.41
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Reference

Block name Example of the shape of the block ]

section

Current information Current Current 4.2.3.42
= 090.0 - L »090.0
oritt - 1.0 ) ittt 1.0

Generator information 4.2.3.44
Wind bearing graph 4.2.3.45
Wind bearing/wind speed information 4.2.3.46
Wind speed graph 4.2.3.47
Course To Steer information 4.2.3.48

4.2.2 Selecting a block to be displayed on the

screen in Custom mode

Up to any six blocks can be assigned to the screen in Custom mode.

The following blocks can be assigned to the screen in Custom mode.

Weather information

Engine telegraph information
Water depth graph

Rudder angle graph

Rudder angle/ship’s heading graph
Engine/propeller revolution graph

Water temperature graph
Wind bearing graph
Wind speed graph

Chapter 4 Conning Display

4-8




See below for the procedure for selecting a block to be displayed on the screen in Custom mode.

1 Click on the Custom tab.
The screen is switched to the Custom screen and the following six windows are displayed. n

Navigation | Docking | Custom

Weather El
24.5
15.4
1024
57.5
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2 Click on the item selection button on the window for displaying items.
Thumbnails of the items that are displayable on that window are displayed.

Navigation | Docking || Custom

Weather @

24.5

15.4

1024

57.5
ltem
selection
button

Depth

Rudder

Engine REV
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3 Click on the thumbnail for the item to be displayed.
The selected item is displayed on the selected window.

Navigation | Docking || Custom

Weather @
24.5
15.4
1024
57.5

S/B
OPERATION
W/H

Selectable items
Normally, the item that is already displayed on another window cannot be selected.

Setting the window to blank
Click on [Off] in step 3 above.
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4.2.3 Description of each block

4.2.3.1 3D Navigation information and the legend of the
navigation

Route

Course Over the Ground
(yellow)

Course To Steer (blue)

ECDIS1 =~
Own ship Legend
ltem Display contents
Own ship Indicates the position of own ship.

Displayed under H-UP (own ship is positioned at the center of the screen).

Course Over | Indicates the angle of the course over the ground.
the Ground The sensor that is selected by the "Course/speed over the ground information” of
the basic information display area is used as the source.

Route Displays the route based on the route information that is received from ECDIS.
Course to Indicates the angle of the course to steer (CTS).
Steer *The course to steer is displayed in autopilot mode. In other modes, the information

is not displayed.

4.2.3.2 Information about azimuth thruster of CPP (controllable
pitch propeller) type

Azimuth THR1 Azimuth thruster angle
. 3 4 1 2 [response value]
Azimuth thruster :

angle [order value] 25.0 Azimuth thruster pitch
angle [response value]

Azimuth THR1

Azimuth thruster pitch
angle [order value]

Azimuth thruster

Azimuth thruster angle revolution [order

[response valuel value] Azimuth thruster Azimuth thruster pitch
revolution [response angle [response value]
value]
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ltem

Display contents

Azimuth thruster angle (response | Displays the azimuth thruster angle (response value) with a meter

value)

display and a numerical display.

Azimuth thruster angle
(indication value)

Displays the azimuth thruster angle (indication value).
On the meter display, the angle is displayed as a yellow line.

Azimuth thruster pitch angle
(response value)

Displays the azimuth thruster pitch angle (response value) with a
meter display and a numerical display.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of
setting value".

Azimuth thruster pitch angle
(order value)

Displays the azimuth thruster pitch angle (order value).
On the meter display, the pitch angle is displayed as a yellow line.

Azimuth thruster revolution
(response value)

Displays the azimuth thruster revolution (response value) with a
meter display and a numerical display.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of
setting value".

Azimuth thruster revolution
(order value)

Displays the azimuth thruster revolution (order value).
On the meter display, the revolution is displayed as a yellow line.

4.2.3.3 Information about side thruster of CCP (controllable pitch
propeller) type

Mo. 1 BOW

MNo.1 BOW THRUSTER

’ 2 8 4 % Thruster pitch

angle (response
value)

Thruster pitch angle (indicated value)

Thruster pitch angle (response value)

Iltem

Display contents

Thruster pitch angle
(response value)

Displays the pitch angle (response value) of the side thruster.

On the meter display, the angle is displayed as a red (Port direction) or
green (Starboard direction) bar. The maximum value is displayed at
both ends of the meter.

In numerical display, a value with the port (red)/starboard (green) mark
is displayed.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting
value".

Thruster pitch angle
(order value)

Displays the pitch angle of side thruster (order value).
On the meter display, the angle is displayed as a yellow line.

4-13 Chapter 4 Conning Display




4234

Information about propeller engine of CPP (controllable

pitch propeller) type

Propeller pitch angle (response

Maximum value

Prop eller

55.4

Propeller pitch

Propeller pitch
angle (response

Propeller pitch

angle angle workin
(indicated dirgction ’ . value)
value) Engine

Revolution per minute
of engine (response
value)

45.3

Iltem

Display contents

Propeller pitch
angle (response
value)

Displays the propeller pitch angle (response value).

On the meter display, the angle is displayed as green (forward direction) or
red (backward direction) bar.

In numerical display, a value with propeller pitch angle operation direction is
displayed.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting value".

Propeller pitch
angle (order value)

Displays the propeller pitch angle (order value).
On the meter display, the angle is displayed as a yellow line.

Engine revolution
(response value)

Displays the engine revolution in numerical format.
The unit can be changed on the View menu.
For the details, refer to "5.1.2 Setting up the display of unit of setting value".

4.2.3.5

Information about azimuth thruster of FPP (fixed pitch

propeller) type

Azimuth THR1
|

Azimuth thruster angle
[response value]

Azimuth thruster
angle [order value]

Azimuth THR

541.2

Azimuth thruster angle
[response value]

Azimuth thruster revolution
[response value]

45
——————

Azimuth thruster revolution [order value]

Azimuth thruster
revolution
[response value]

ltem

Display contents

Azimuth thruster angle
(response value)

Displays the azimuth thruster angle (response value) with a meter display
and a numerical display.

Azimuth thruster angle
(order value)

Displays the azimuth thruster angle (order value).
On the meter display, the angle is displayed as a yellow line.

Azimuth thruster
revolution (response
value)

Displays the azimuth revolution (response value) with a meter display and a
numerical display.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting value".

Azimuth thruster
revolution (order value)

Displays the azimuth revolution (order value).
On the meter display, the speed is displayed as a yellow line.
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4.2.3.6 Information about side thruster of FPP (fixed pitch
propeller) type

Stern THS1

Revolution per

minute of thruster
Revolution per minute of thruster (response value)

(indicated value)
Revolution per minute of thruster (response value)

ltem Display contents
Thruster revolution Displays the revolution (response value) of the side thruster.
(response value) On the meter display, the speed is displayed as a red (Port direction) or

green (Starboard direction) bar. The maximum value is displayed at both
ends of the meter.

In numerical display, a value with the port (red)/starboard (green) mark is
displayed.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting value".
Thruster revolution Displays the revolution of the side thruster (order value).

(order value). On the meter display, the speed is displayed as a yellow line.

4.2.3.7 Information about propeller engine of FPP (fixed pitch
propeller) type

Propeller revolution [response value]

Propeller Pro F:IE'l ler
Propeller revolution Propeller A 2 3 Propeller revolution
[order value] rotation [response value]
direction
Maximum revolution
ltem Display contents

Propeller revolution Displays the revolution (response value) of the engine/propeller.

(response value) On the meter display, the speed is displayed as a green (forward direction)
or red (backward direction) bar.

In numerical display, a value with engine/propeller operation direction is
displayed.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting value".

Propeller revolution Displays the revolution (order value) of the engine/propeller.
(order value) On the meter display, the speed is displayed as a yellow line.
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4.2.3.8 N-UP/H-UP switching buttons

NUp HUp

The N-UP/H-UP switching buttons enable switching between N-UP display and H-UP display.

The scale display in the illustration display such as course switches according to the N-UP/H-UP
display switching.

For the illustration display, refer to "4.2.3.33 Graphic display of ship’s heading, course over the
ground, wind bearing/wind speed, and current information”.

4.2.3.9 Ship block
In the Ship block, operation statues such as the rudder angle, engine/propeller, and thruster are
displayed within and surrounding the line drawing of a shape of a ship.

Ship block display examples are shown below.

Navigation i Custom

No.1 Thruster No.1 Thruster
e |, |10 I *% *

No.2 Thruster No.2 Thruster
100

Thruster 1

Thruster 2

Bow PORT-STBD

» 47

FORE-AFT

2 15

Stern PORT-STBD

» 1.3 K

Source| GPS 1~

v

Propeller-Pitch

< 30.0 %

[EgineRer |
1000.0=-

Thru

A
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4.2.3.10 Azimuth thruster information (with status)

Azimuth thruster angle (order value)

Thruster 4

<)

Azimuth thruster
angle (response
value)

Azimuth thruster
revolution (order
value)

Azimuth thruster
revolution
(response value)

Thruster 3

Azimuth thruster angle
(response value)

Azimuth thruster
revolution
(response value)

Iltem

Display contents

Azimuth thruster angle
(response value)

Displays an azimuth thruster angle (response value) in meter
display and numeric value display.

Azimuth thruster angle
(order value)

Displays an azimuth thruster angle (order value).
Displayed on the meter with a yellow line.

Azimuth thruster
revolution (response
value)

Displays an azimuth thruster revolution (response value) in meter
display and numeric value display.

The unit can be changed in the View menu.

For the details, refer to “5.1.2 Setting up the display of unit of
setting value”.

Azimuth thruster
revolution (order value)

Displays an azimuth thruster revolution (order value).
Displayed on the meter with a yellow line.

Status

Displays a status of the azimuth thruster.

Running: Running

Stop: Stopped
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4.2.3.11 Engine/propeller revolution graph

Engine REV

1@ 5

oo
]|
4

100
[RPM]

[min] PORT S5TBD—

ltem

Display contents

Engine/shaft/
propeller revolution

speed graph display

Displays the engine/propeller revolution speed graph.
The graph range can be changed on the View menu.
For the details, refer to "5.1.6 Setting an engine/propeller revolution graph ".

4.2.3.12 Engine output information

Engine output

Item

Display contents

Engine output

Displays the engine output.
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4.2.3.13 Engine telegraph information

When two engines are installed, the engine telegraph information that can be displayed on the

Custom mode screen can be set to 2. n

Telegraph(PORT)

Engine revolution speed

Telegraph position

Sub-telegraph

Operation location

ltem Display contents

Engine revolution speed | Displays the engine revolution speed.

Telegraph position Displays the telegraph position.
Sub-telegraph Displays the sub-telegraph.
Operation location Displays the engine telegraph operation location.

4.2.3.14 Engine torque information

Engine torque

Item Display contents

Engine torque Displays an engine torque.

The unit is kKNm (kilo newton meter).
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4.2.3.15 Rate

Of Turn (ROT) information

PlanROT 4> 38,2 °/min Planned ROT

ROT label ROT(Gyro)<p )20 .0) °/min ROT

ROT meter

ltem

Display contents

Rate of turn label

Displays the rate of turn sensor name.

ROT[TRI]:

Displays the rate of turn from TRI (Turn Rate Indicator).

ROT[Gyro]:

Displays the rate of turn from Gyro.

* When two Gyro units are installed, Gyro1 or Gyro2 is displayed according
to the sensor that is currently used for receiving information.

Planned rate of turn

Displays the planned rate of turn.

The value is displayed following the port/starboard mark.

* The planned rate of turn is displayed based on the route information that is
received from ECDIS. The information is not displayed if the route is not
monitored.

Rate of turn

Displays the rate of turn.
The value is displayed following the port/starboard mark.

Rate of turn meter

Displays with the red bar when the ship is turning to the port side and with
the green bar when the ship is turning to the starboard side.

(In top screen (2), a white color is used in the display instead of red and
green colors.)

Planned rate of turn is displayed with the yellow line.
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4.2.3.16 Weather information

Weather

Air temperature

Water temperature

Air pressure

Humidity

ltem

Display contents

Air temperature

Displays the air temperature.
The display unit can be changed on the View menu. For the details, refer to "5.1.2
Setting up the display of unit of setting value".

Water
temperature

Displays the water temperature.
The display unit can be changed on the View menu. For the details, refer to "5.1.2
Setting up the display of unit of setting value".

Air pressure

Displays the air pressure.
The display unit can be changed on the View menu. For the details, refer to "5.1.2
Setting up the display of unit of setting value".

Humidity

Displays the humidity.

4.2.3.17 Draft information

Forward draft

Starboard draft
Port draft

After draft

ltem

Display contents

Forward draft

Displays a forward draft.

Starboard draft

Displays a starboard draft.

Port draft

Displays a port draft.

After draft

Displays an after draft.
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4.2.3.18 Route information source

ECDIS1 ~

This combo box is displayed to display and change the sensor source for acquiring route monitoring
information.

Select a sensor source in the combo box.

When [Menu] is selected, the [Sensor Selection/Status] dialog is displayed. Any of the following sensor
sources can be selected.

Setting item Setting contents Setting value

Navigational Data | Select the source (sensor) for acquiring route ECDIS x, MFD x
monitoring information. ("x" indicates the unit
*The sources that can be selected vary number.)

according to the installation.

*When the Switch to equipment for Autosailing
check box is selected, selection is disabled.

Switch to When acquiring route monitoring information ON/OFF
equipment for from the equipment that is performing
Autosailing Auto-Sailing, enable the item (ON) by selecting

the check box.

When acquiring route monitoring information
from the source that is selected from
Navigational, disable the item (OFF) by
clearing the check box.

4.2.3.19 Route name information

Route Name

route-281481011400

The route name is displayed based on the route information that is received from ECDIS. The
information is displayed only when the route is being monitored.
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4.2.3.20 Final waypoint information

Final WPT
ETA 2

UTC/LMT switching button

ltem Display contents

ETA Displays the expected time of arrival at the final waypoint.
The time display method can be changed by using the maintenance function.
For the details, refer to "9.1.2 Setting Date/Time/Time Zone".

UTC/LMT Displays and switches UTC/LMT of ETA.
switching button
DIST Displays the distance from own ship to the final waypoint.

4.2.3.21 Side thruster information (with status)

Thruster revolution (order value)
Thruster revolution (response value)

Thruster 1

Thruster 1

Thruster
revolution
(response value)

Status Revolution direction
Item Display contents
Thruster revolution Displays a thruster revolution (response value) in meter display
(response value) and numeric value display.

The unit can be changed in the View menu.
For the details, refer to “5.1.2 Setting up the display of unit of
setting value”.

Thruster revolution (Order Displays a thruster revolution (order value).
value) Displayed on the meter with a yellow line.
Status Displays a status of the thruster.

Running: Running

Stop: Stopped
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4.2.3.22 Time and position information

UTC/LMT switching button Date Time

Positioning
sensor e
39 39
sonsc 52 26 215 S
combo box 61°00.000'E
Geodetic positioning system Latitude/longitude
ltem Display contents

Date display Displays the current date.
Time display Displays the current time (Universal Time Coordinated or local time).

UTC/LMT switching
button

When the button is clicked on, the display switches between the Universal
Time Coordinated [UTC] and local time [LMT].

Latitude Displays the latitude of own ship’s position. North latitude is indicated as N and
the South latitude is indicated as S.
Longitude Displays the longitude of own ship’s position. East longitude is indicated as E

and West longitude is indicated as W.

Positioning sensor
name combo box

Displays and changes the positioning sensor name.

The following sensor sources can be selected.

When [Menu] is selected, the [Sensor Selection/Status] dialog is displayed.
GPSx’’

For the details of the sensor source setting, refer to "9.1.5 Setting and
confirming the sensor source".

Geodetic system

Displays the geodetic system.

*1: When two or more GPS units are present, "x" indicates the unit number.
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4.2.3.23 Automatic sailing information
This section displays the status of the autopilot that is installed.

Note
Displayed when the automatic sailing option is attached.

A/P Stat Track Control KEEP AUTO

Turning mode
Control mode

Automatic sailing mode

ltem Display contents

Autopilot mode Displays the automatic sailing mode.

No display: The [Navigational Data] combo box is blank space and the Switch to
equipment for Autosailing check box in the [Sensor Selection/Status] dialog is not
checked.

Track Control: The A/P (Autopilot) steering mode is set to Track Control.

Heading Control: The A/P steering mode is set to Heading Control.

Manual: The A/P steering mode is set to Manual.

Override: Override steering (interrupt steering)

Control mode Displays the automatic sailing control mode.

No display: Automatic sailing is not set.

KEEP: During automatic sailing/course keeping state

TURN: During automatic sailing/turning (TCS category C)
Assisted Turn: During automatic sailing/turning (TCS category B)
Turn mode Displays the automatic sailing turn mode.

No display: Automatic sailing is not set.

AUTO: Automatic turn mode

Notes

When the mode is switched to Override steering on the Autopilot side in Track Control mode,

Track Control is released and the mode is set to Override Steering.

Refer to the following information for the override steering method.

- Autopilot manufactured by TOKYO KEIKI:
“4.5 Override Steering Method (Option)" of the “Autopilot Additional Instruction Manual:
TCS model Category C (TOKYO KEIKI PR-6000 and HCS-9000)"

- Autopilot manufactured by YOKOGAWA:
“4.2.3 Override steering (option)" of the “Autopilot Additional Instruction Manual Autopilot:
TCS model Category C (YOKOGAWA PT500A and PT900)"
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4.2.3.24 Next waypoint information

TTG 30:05:03

UTC/LMT switching button

kn
NM
NM STBD©.20  NM
NM
NM

ltem Display contents

No. Displays the next waypoint number.

BRG Displays the bearing up to the next waypoint.

DIST Displays the distance up to the next waypoint.

POSN Displays the latitude and longitude of To Waypoint.

Plan SPD Displays the planned ship speed.

XTD Displays the cross track distance of own ship.
Indicates the port (red)/starboard (green) with the color of the triangle mark.
The display unit can be switched by using the View menu. For the details, refer
to "5.1.2 Setting up the display of unit of setting value".

XTL PORT/STBD | XTL PORT displays the route width of the port side and XTL STBD displays
the route width of the starboard side.
The display unit can be switched in the View menu. For the details, refer to
"5.1.2 Setting up the display of unit of setting value".

Plan RAD Displays the planned turn radius.

Order RAD Displays the order turn radius.

TTG Displays the time required to arrive at the next waypoint.

ETA The date display method can be changed by using the maintenance function.
For the details, refer to "9.1.2 Setting Date/Time/Time Zone".

UTC/LMT Displays and switches UTC/LMT of ETA.

switching button
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4.2.3.25 One after next waypoint information

Next WPT

LEGDIST3.5  NM

DIST 6.5 NM
116G 65:05:48
Time to sail 34:58;
ltem Display contents
No. Displays the number of one after the next waypoint.
New CRS Displays the leg bearing of one after the next waypoint.
LEG DIST Displays the distance from the next waypoint to one after the next waypoint.
DIST Displays the distance from own ship to one after the next waypoint.
TTG Displays the time required to arrive at one after the next waypoint.
Time to sail Displays the time required from the next waypoint to one after the next
waypoint.

4.2.3.26 Water temperature graph

Sea TEMP

18 g
[min]

ltem Display contents

Water temperature graph | Displays water temperatures in graph format.

display The unit can be selected on the View menu.

For the details, refer to “5.1.2 Setting up the display of unit of
setting value”.

The range of the graph can be changed on the View menu.
For the details, refer to “5.1.8 Setting a water temperature

graph”.
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4.2.3.27 Water depth graph

60 45

[min]

Depth(Tr

Water depth graph

Water depth value

Sensor information

Water depth value reference

ltem Display contents
Water depth Displays the water depth information. Water is indicated by light blue and ocean
graph bed is indicated by brown.
Therefore, the boundary between light blue and brown indicates the water depth.
The graph range can be changed on the View menu.
For the details, refer to "5.1.3 Setting up Water Depth display”.
Water depth Displays the water depth value.
value The unit can be selected on the View menu.
For the details, refer to "5.1.3 Setting up the display of unit of setting value".
Water depth Displays the water depth value reference (Surf/Trans/Keel).
value reference
Sensor Displays the water depth sensor source.
information FWD: Depth sounder installed at the front of the ship
MID: Depth sounder installed at the center of the ship
AFT: Depth sounder installed at the rear of the ship
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4.2.3.28 Water depth information

The following items are displayed regularly as water depth information.

Sensor information

Water Depth(FWD
depth value
display 490 m

Water depth graph
Water depth Keel

value reference

Alarm Limit

Alert setting 30 m
point

ltem Display contents

Water depth value | Indicates the water depth value.

display
Water depth Indicates the water depth information. Water is indicated in blue and the sea bed
graph is indicated in brown.

Therefore, the boundary between blue and brown indicates the water depth.
The graph setting range can be changed from the View menu.

For the details, refer to "5.1.3 Setting up the Water Depth display”.

Water depth value | Displays the water depth value reference [depth measurement point].
reference The depth measurement point is one of Surf, Trans, and Keel and the water

depth value at each point is as follows.

Surf: Water depth value from the water surface

Trans: Water depth value from the transducer of the depth sounder
Keel: Water depth value from the point below the keel

Surf [water surface]

7 Trans [transducer of depth sounder]

Keel [keel]
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ltem Display contents
Sensor Displays the water depth sensor source.
information FWD: Depth sounder installed at the front of the ship

MID: Depth sounder installed at the center of the ship
AFT: Depth sounder installed at the rear of the ship

Alert setting point

The water depth value measured from the bottom of the keel is displayed.
The unit can be changed in the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting value".
*When the water depth value measured from the bottom of the keel is not

received, the [Non SYNC] badge is displayed.

Alarm Limit

Mon 5YHC

320 m

Chapter 4 Conning Display 4-30




Sentence from the water depth sounder

An alert setting point value is updated by the sentence from the water depth sounder.

A sentence is output at every 4 hours from 0 hour of UTC after the power supply of the depth sounder

is turned on.

The contents of sentences are listed below.

Field Code Data Specification
1 $ Header Fixed
2 PJRCM Sentence ID
3 SD Equipment ID
4 88 System information command
5 VXX XX Software version
6 X Image transmission
7 X Crack
8 X Interference prevention
9 X GAIN AUTO/NORMAL
10 X RANGE
11 +XX Draft adjustment value
12 X Cursor display ON/OFF
13 X Key ACK
14 X Relay contact point
15 XX Water depth alarm ON/OFF OFF=0, ON=1
16 XX.X Water depth alarm setting value | 0.0 ~99.9
17 X System alarm ON/OFF lost
18 X System alarm ON/OFF
transmission
19 X System alarm ON/OFF reception
20 X System alarm ON/OFF foam
forming
21 X System alarm ON/OFF printer
22 X Recording interval
23 *hh Check sum
24 <CR><LF> Delimiter
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4.2.3.29 Thruster drive motor load information

Drive motor load
Thruster 1 40.0 |
Thruster 2/50.0 |

Thruster 3160.0

Thruster drive motor load

Thruster 4 [70.0

Thruster 5 80.0

Item

Display contents

Thruster drive motor load

Displays a drive motor load of each thruster with a value between
0% and 100%.

4.2.3.30 Thruster operation location information

Command Position

Thruster 1T ATt Support

Thruster 2 m

Thruster 3 Aft SUppOft _. Thruster operation location
Thruster 4 Ship Handling |

Thruster 5 Ship Handling

Item

Display contents

Thruster operation
location

Displays an operation location of each thruster.

Ship Handling: After bridge (ship operation)

Aft Support: After bridge (support)

FWD Bridge: Forward bridge

When there are multiple operation locations for the same
thruster, the operation location of the highest priority is displayed.
The operation locations are shown below in the order of
descending priorities.

Ship Handling>Aft Support>FWD Bridge
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4.2.3.31 Thruster steering mode information

Steering Mode
Thruster1 DP

Thruster2 DP

Thr’u Ster'3 JS Thruster steering mode

Thruster4Manual |
Thruster5Manual

Item Display contents

Thruster steering mode Displays a steering mode of each thruster.

Backup: Backup control

DP: Dynamic positioning

DP(Locked): Dynamic positioning (locked)

JS: Joystick

JS(Locked): Joystick (locked)

AP: Autopilot

Manual: Manual

When there are multiple steering modes for the same thruster,
the steering mode of highest priority is displayed.

The steering modes are shown below in the order of descending
priorities.

Backup>DP/DP(Locked)>JS/JS(Locked)>AP>Manual
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4.2.3.32 Heading information

HDG 1 8 . . Ship’s heading

Source Gyro

Ship’s heading sensor name combo box

ltem

Display contents

Ship’s heading

Displays the ship’s heading.

The reliabilities of the values are color coded into three colors.
* Normal character color: Normal sensor value

* Yellow: Deterioration of sensor value reliability

* Orange: Abnormal sensor value

Ship’s heading
sensor name combo
box

Displays and changes the ship's heading sensor name.

The following sensor sources can be selected.

When [Menu] is selected, the [Sensor Selection/Status] dialog is displayed.
Gyro, Gyro1*'*?, Gyro2*' *?, MAG, G/C

For the details of the sensor source setting, refer to "9.1.5 Setting and
confirming the sensor source".

*1: Only for the case where two Gyro units are available.
*2: When the Gyro Compass system that is used has the automatic switching function, the sensor
source display is switched automatically according to the switching condition.
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4.2.3.33 Graphic display of ship’s heading, course over the ground,
wind bearing/wind speed, and current information

Arrow feather

Scale display

Course over

the ground Current set of tidal

stream

Ship’s heading

Scale display
Ship’s heading

Wind direction
Current set of tidal stream

Course over the ground

H-UP

ltem Display contents
Ship’s heading Displays the ship’s heading.
Scale display The scale display changes according to the switching of H-UP/N-UP.
* N-UP:
Indicates the scale of 32 points using North as the reference.
+ H-UP:
Indicates the scale of 180 degrees each towards the starboard side and

portside with reference to the bow of the ship. (In top screen (2), a white color is
used in the display instead of red and green colors.)

Course Over the | Displays the course over the ground (COG).

Ground

Arrow feather An arrow feather is displayed in the case of N-UP. The arrow tip indicates the
downwind. The number of arrow feathers indicates the Beaufort wind-force scale.

Wind direction A triangular arrow is displayed in the case of H-UP. The arrow tip indicates the
downwind. The wind speed is not displayed.

Current set of The arrowhead indicates the direction of the tide.

tidal stream
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4.2.3.34 Ship speed information

F(
'S

-AFT

10.0
0.0

Source GPS 1

kn — Speed over the ground [Bow port-starboard direction]

a4 Speed over the ground [Forward-Afterward direction]

Sl SPeEd OVer the ground [Stern port-starboard direction]

el Speed over the ground [Docking] sensor name combo box

ltem

Display contents

Speed over the
ground (Bow
port-starboard
direction)

Displays the ship speed over the ground (Bow port-starboard direction). When
the ship is moving forward in the port direction, a red arrow is displayed. When
the ship is moving forward in the starboard direction, the green triangle is
displayed. (In top screen (2), a white color is used in the display instead of red
and green colors.)

If the ship speed is 1 kn or lower, the unit changes to cm/s.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting value".

Speed over the
ground
(Forward-Afterward
direction)

Displays the speed over the ground (Forward-Afterward direction). When the
ship is moving forward, a green arrow is displayed. When the ship is moving
backward, a red arrow is displayed. (In top screen (2), a white color is used in
the display instead of red and green colors.)

If the ship speed is 1 kn or lower, the unit changes to cm/s.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting value".

Speed over the
ground (Stern
port-starboard
direction)

Displays the speed over the ground (Stern port-starboard direction). When the
ship is moving in the port direction, a red arrow is displayed. When the ship is
moving in the starboard direction, a green arrow is displayed. (In top screen
(2), a white color is used in the display instead of red and green colors.)

If the ship speed is 1 kn or lower, the unit changes to cm/s.

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of setting value".

Speed over the
ground (Docking)
sensor name
combo box

Displays and changes the speed over the ground (Docking) sensor name.
The following sensor sources can be selected.

When [Menu] is selected, the [Sensor Selection/Status] dialog is displayed.
Log”, Log1*1 2 LogZ*1 2 and GPSx°

For the details of the sensor source setting, refer to "9.1.5 Setting and
confirming the sensor source".

*1: When 1AX is installed for Log, Log cannot be selected from the sensor source.

*2: Only for the case

where two Log units are available.

*3: When two or more GPS units are present, "x" indicates the unit number.
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4.2.3.35 Hull motion information
sTD yify PORT
Heel 'ij’ 1.9 = Average roll angle

Roll{p [ 1.9 . Roll angle

EOu S S et

Trim 4 ’ 1.9 = Average pitch angle

Pitch {p 1 1.9 Pitch angle

Item Display contents

Average roll angle Displays the average roll angle (Heel) of the hull for 10 minutes.
Atriangle that indicates the tilting direction is displayed in front of
the value.

When the hull is tilted towards the port side, a left-facing triangle
is displayed and when the hull is tilted towards the starboard

side, a right-facing triangle is displayed.

Roll angle Displays the roll angle (Roll) of the hull.

Atriangle that indicates the tilting direction is displayed in front of
the value.

When the hull is tilted towards the port side, a left-facing triangle
is displayed and when the hull is tilted towards the starboard

side, a right-facing triangle is displayed.

Average pitch angle Displays the average pitch angle (Trim) of the hull for 10 minutes.
Atriangle that indicates the tilting direction is displayed in front of
the value.

When the hull is tilted towards the port side, a left-facing triangle
is displayed and when the hull is tilted towards the starboard

side, a right-facing triangle is displayed.

Pitch angle Displays the pitch angle (Pitch) of the hull.

Atriangle that indicates the tilting direction is displayed in front of
the value.

When the hull is tilted towards the port side, a left-facing triangle

is displayed and when the hull is tilted towards the starboard

side, a right-facing triangle is displayed.
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4.2.3.36 Steering position information

This function displays the steering position when override steering is set during Track Control.

Steering POSN PORT

Steering position

ltem Display contents

Steering position Displays the steering position when override steering is set
during Track Control.

Bridge: Bridge

PORT Wing: Port wing

STBD Wing: Starboard wing

Engine Room: Engine room

Engine Side: Near the engine

Wing: Wing (port or starboard is not specified)

MANO C: Specific definition of TOKYO KEIKI autopilot, steering
console

Stand: Specific definition of TOKYO KEIKI autopilot, steering
stand

The Steering Position is displayed as follows when the YDK
Steering Indicator is connected.
STAND: Steering stand

CENTER: BCC (Bridge Center Control)
PORT/W: Port wing

STBD/W: Starboard wing

S/G ROOM: Steering gear room
AFTER: AFTER console

BRIDGE: Bridge

PORT: Port

STBD: Starboard

PORT/SJ: Port S-JOY

STBD/SJ: Starboard S-JOY

Memo
The character string that has been initially set is displayed. The characters that are displayed may vary

depending on the system.
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4.2.3.37 Ship speed through water information

STW . 1 kn Speed through the water

Source LD:_Z} 1 Ship speed sensor name combo box

ltem Display contents
Speed through the Displays the speed through the water.
water The reliabilities of the values are color coded into three colors:

*Normal character color: Normal sensor value

*Yellow: Deterioration of sensor value reliability

*Orange: Abnormal sensor value

The display unit can be switched in the View menu. For the details,
refer to "5.1.2 Setting up the display of unit of setting value".

Ship speed sensor Displays/changes a ship speed sensor name.

name combo box The following sensor sources can be selected.

When [Menu] is selected, the [Sensor Selection/Status] dialog is
displayed.

Log”, Log1*1 2 LogZ*1 2

For the details of sensor source setting, refer to "9.1.5 Setting and

confirming sensor sources".

*1: When 1AXis installed for Log, Log cannot be selected from the sensor source.

*2: Only when there are two Logs

4.2.3.38 Course/speed over the ground information

COG 1 8 . ° Course Over the Ground

SOG 1 kn Speed Over the Ground
[ ]

_ = Course Over the Ground / Speed Over the Ground sensor name
Source GPS 1 combo box

Item Display contents
Course Over the Ground Indicates the course over the ground.
The reliabilities of the values are color coded into three colors:
* Normal character color: Normal sensor value
* Yellow: Deterioration of sensor value reliability
* Orange: Abnormal sensor value
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Item Display contents

Speed Over the Ground Displays the speed over the ground.
The reliabilities of the values are color coded into three colors:

* Normal character color: Normal sensor value

* Yellow: Deterioration of sensor value reliability

* Orange: Abnormal sensor value

The unit can be changed on the View menu.

For the details, refer to "5.1.2 Setting up the display of unit of
setting value".

Course Over the Displays and changes the course over the ground/ speed over the

Ground/Speed Over the ground sensor name.

Ground sensor name combo The following sensor sources can be selected.

box When [Menu] is selected, the [Sensor Selection/Status] dialog is
displayed.

Log“, Log1*1 2 Logz*1 2 and GPSx*®
For the details of the sensor source setting, refer to "9.1.5 Setting
and confirming the sensor source".

*1: When 1AXis installed for Log, Log cannot be selected from the sensor source.
*2: Only for the case where two Log units are available.
*3: When two or more GPS units are present, "x" indicates the unit number.

4.2.3.39 Rudder angle/ship’s heading graph

HDG/Rudder

HDG —

ZE0
S0k c

Erni nj

15

Rudder PORT STED—

ltem Display contents

Ship’s heading + | Displays the graph of the ship’s heading and rudder angle.
Rudder angle The graph range can be changed on the View menu.
graph display For the details, refer to "5.1.5 Setting a rudder angle/ship’s heading graph".
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4.2.3.40 Rudder angle graph

Rudder EEﬂ

[=

Erni nj

PORT STED—
ltem Display contents
Rudder angle Displays the rudder angle graph.
graph display The graph range can be changed on the View menu.
For the details, refer to "5.1.4 Setting a rudder angle graph".

4.2.3.41 Rudder angle information

Rudder Rudder angle (response value)

Rudder angle (order value)
Order {p Rudder angle (order value)

Actual } 1 8 Rudder angle (response value)

Rudder
Order
Rudder angle 4 Rudder angle
(response (order value)
value)
Rudder angle
(response
Rudder angle (order value) Rudder angle operation direction value)
ltem Display contents
Rudder angle Displays the rudder angle (response value).

(response value) | On the meter display, the rudder angle is indicated by a needle.
In numerical display, the rudder angle operation direction and the value are

displayed.
Rudder angle Displays the rudder angle (order value).
(order value) On the meter display, the angle is displayed as a yellow line.

4-41 Chapter 4 Conning Display



4.2.3.42 Current information

Current

9 Current set
]

1.0

Current speed

Current (N-UP)

Current

’ 9 . Current set

1.0

Current (H-UP)

Current speed

Iltem

Display contents

Current set

Indicates the current set.

N-UP:

Displays in 360 degrees.

H-UP:

Displays the port/starboard mark and the degree within the range from 0 to
180°.

Current speed

Displays the current speed.
The unit of current speed can be selected on the View menu. For the details,
refer to "5.1.2 Setting up the display of unit of setting value".

The meanings of the marks at H-UP are as follows.
: The downstream is on the S (starboard) side.

.: The downstream is on the P (port) side.

Memo

When the current set is 0° or 180°, no symbol is displayed.
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4.2.3.43 Generator information

Generator output

Generator

Generator output

30.0 Mw

ltem Display contents

Generator output Displays the output from the generator in meter display and numeric
value display.

“Total”, when displayed, indicates the total value of the multiple
generator outputs.

4.2.3.44 Wind bearing graph

Wind Bearing

18 8

|';|il'|:| -

[n

ltem Display contents

Wind bearing graph display | Displays a wind bearing graph.

The unit can be selected on the View menu.

For the details, refer to “5.1.2 Setting up the display of unit of
setting value”.

The range of the graph can be changed on the View menu.
For the details, refer to “5.1.7 Setting wind direction graph/wind

speed graph”.
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4.2.3.45 Wind bearing/wind speed information

Wind
BRG
SPD
BFT

1 gls

ERG ’ 9 i : Wind bearing
s, 2.6

Wind bearing

Wind speed

Beaufort wind-force scale

Wind speed

Wind bearing/wind speed-Relative (H-UP)

ltem

Display contents

Wind bearing

Indicates the wind bearing.

* N-UP:
Displays the true wind bearing in 16 bearings or 360 degrees.

* H-UP:
Displays the relative wind bearing with the port/starboard mark and the
degree within the range from 0 to 180°.

The display of bearing/degree can be selected on the View menu. For the
details, refer to "5.1.2 Setting up the display of unit of setting value".

Wind speed

Displays the wind speed.
* N-UP:
Displays the true wind speed.
» H-UP:
Displays the relative wind speed.

The unit of wind speed can be selected on the View menu. For the details,
refer to "5.1.2 Setting up the display of unit of setting value".

Beaufort wind-force
scale

Displays the Beaufort wind-force scale within the range of 13 scales for
N-UP only according to the Beaufort wind-force scale table.
For the details, refer to "Beaufort wind-force scale table".

The meanings of the marks at H-UP are as follows.

D: Indicates the windward is on S (starboard) side.

.: Indicates the windward is on P (port) side.
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Memo

No symbol is displayed with the wind bearing 0°or 180°.

Beaufort wind-force scale table

Wind- , Shape of
Equivalent . .
force Name ) Condition on the land Condition on the sea arrow
wind force *1
scale feathers
0 Calm 0to 0.2m/s |Smoke rises straight | The water surface is calm | Ng grrow
upwards. like a mirror. feathers
1 Light air 0.3 to 1.5m/s | Smoke trails to the The surface of the water
degree that indicates |ripples, such as fish
the wind direction. scales.
2 Light breeze |1.6 to 3.3m/s |Sensation of wind is | The surface of water form
felt on the face. definite ripples.
Leaves sway.
3 Gentle breeze |3.4 to 5.4m/s|Leaves and small Wave crests are broken,
branches sway. starting to create white
foam.
4 Moderate 5.5 to 7.9m/s |Wind raises cloud of |Small waves appear and
breeze dust and small rubbish |white foams increases.
and fallen leaves are
blown up in the air.
5 Fresh breeze |8.0to Shrubs with leaves Wave crests appear on the
10.7m/s start to sway. water surface.
6 Strong breeze |10.8 to Large branches of Wave crests with white
13.8m/s trees sway, making it |foams spread.
difficult for anyone to
hold umbrellas. Cables
make a sound.
7 High wind / 13.9to Whole large trees Wave crests are broken
Moderate gale [17.1m/s sway, making difficult |and white foams are blown
/ Near gale to walk against the away by the wind.
wind.
8 Gale/Fresh |17.2to Small branches are Slightly small swell. Wave
gale 20.7m/s broken, making crests are broken, sending
impossible to walk up clouds of spray and
against the wind. foams are blown away,
creating trails of lines.
9 Strong gale 20.8 to Roof tiles are blown Swell. Foams are blown
24.4mls away. The wind starts |away, drawing lines. Wave

to cause some
damage to houses.

crests collapse and start
whirling in reverse.
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Wind- ) Shape of
force Name Eguwalent Condition on the land Condition on the sea arrow
scale wind force feathers’™
10 |[Storm /Whole |24.5 to Rare in inland. Some |Swells leaning over. The
gale 28.3m/s trees started to fall water surface appears to
down from the roots. |be white by the white
The wind starts to foams, creating trails of
cause serious damage |lines and the visibility
to houses. deteriorates due to waves
collapsing violently.
11 Violent storm |28.4 to Hardly ever occurs. Mountain of swells. The
32.5m/s The wind causes a water surface is entirely
wide range of covered by white foams.
damages. Wave crests are blown
away by the wind, creating
spray and the visibility
deteriorates further.
12 Hurricane 32.6m/s or |The wind causes more | The atmosphere is filled :
more serious damage. with foam and splash and

the water surface became
entirely white. The visibility
deteriorates further.

*1: An arrow feather is displayed in the graphic display (refer to “4.2.3.33 Graphic display of ship’s

heading, course over the ground, wind bearing/wind speed, and current information”).

4.2.3.46 Wind speed graph
Wind Speed

Item

Display contents

Wind speed graph display

Displays a wind speed graph.

setting value”.

speed graph”.

The unit can be selected on the View menu.

For the details, refer to “5.1.2 Setting up the display of unit of

The range of the graph can be changed on the View menu.

For the details, refer to “5.1.7 Setting wind direction graph/wind
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4.2.3.47 Course To Steer information

Leg bearing of the route in progress

Course to steer

ltem

Display contents

Leg bearing of the
route in progress

Displays the leg bearing of the route in progress

Course to steer

Indicates the angle of CTS (Course To Steer).
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Section 5 Setting Up Screen View

Screen display detail is set in [View-Options] dialog box on the [View] menu.
The display procedure of the [View-Options] dialog box is as follows.

1 Click on the [Menu] button at the bottom left corner of the screen.

The menu is displayed.

2 Click on the [View] button on the menu.

The submenu is displayed.

3 Click on the [Options] button on the submenu.
The submenu [View-Options] dialog box is displayed.
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5.1 Setting Screen Display Options
In the [View-Options] dialog box, the screen display options can be set.

Disclosure button

View-Options L
Unit
S50

pihin )
Ship Speed

(Included

Unit
Current Speed

Depth Graph Wind Speed
Rudder Graph Propeller Revolution
Gyro/Rudder Graph Propeller Pitch Angle
Engine Graph Thruster Revolution
Wind Graph
Sea TEMP

ROT

Thruster Pitch Angle |
Air TEMP
Water TEMP
Air Pressure
XTD/XTL for TCS Info
Wind Direction(True) T16poINts =

—-v-— —v—

Classification pane Edit pane

The [View-Options] dialog box consists of the Classification pane and Edit pane.
Click on the disclosure button to hide the Classification pane.

1 Click on the screen view of which you want to set up the options in the Classification
pane.
The option setup dialog for the screen view you have selected appears in the Edit pane.

2 Set up in the Edit pane.

Screen display set in the [View-Options] dialog box
In the [View-Options] dialog box, the following screen display is set.
The following table shows the descriptions and the related sections of the classification panes that are

displayed.
Classification pane Reference section
S-JOoYy 5.1.1 Setting an S-JOY predicted position display interval
Unit 5.1.2 Setting up the display of unit of setting value
Depth Graph 5.1.3 Setting up the Water Depth display
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Classification pane Reference section
Rudder Graph 5.1.4 Setting a rudder angle graph
Gyro/Rudder Graph 5.1.5 Setting a rudder angle/ship’s heading graph
Engine Graph 5.1.6 Setting an engine/propeller revolution graph
Wind Graph 5.1.7 Setting a wind direction graph/wind speed graph
Sea TEMP 5.1.8 Setting a water temperature graph
ROT 5.1.9 Setting up the graph range of the ROT slide bar

5.1.1 Setting an S-JOY predicted position display
interval

When [S-JOY] is selected in the classification pane, the “S-JOY” dialog is displayed in the edit pane.

Note
This dialog may not be displayed depending on the equipment setting.

"

S-Jay

Predictor Interval 1Tmin -

Setting item Setting contents Setting value
Predictor Interval Select an own ship predicted position 1min, 2min, 3min,
display interval from the combo box. 5min, or 10min
Memo

A display interval can also be set from the Conning Display screen. However, S-JOY cannot be

operated from the Conning Display screen.
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5.1.2 Setting up the display of unit of setting value

Note

Some items may not be displayed depending on the installation setting.

When you select [Unit] in the Classification pane, the [Unit] dialog is displayed in the Edit pane.

.. « | View-Options
Unit

(Included Depth in Chart)
Ship Speed

Current Speed

Wind Speed |

Propeller Revolution |

Propeller Fitch Angle '

Thruster Revolution

Thruster Pitch Angle |

Air TEMP
Water TEMP
Air Pressure

ATDSXTL for TCS Info

The descriptions of settings are shown in the table below.

combo box.

Setting Item Description of Setting Setting Value

Depth (water depth) | Select a unit of water depth from the combo box. m, ft, fm

Ship Speed Select a unit of the ship speed from the combo kn, m/s, km/h
box.

Current Speed Select a unit of the current speed from the combo | kn, m/s, km/h
box.

Wind Speed Select a unit of the wind speed from the combo kn, m/s, km/h
box.

Propeller Revolution | Select a unit of the propeller's revolution per rpm, min-1
minute from the combo box.

Propeller Pitch Angle | Select a unit of the propeller's pitch angle from the | °/%
combo box.

Thruster Revolution Select the unit of thruster revolution from the rpm, min-1
combo box.

Thruster Pitch Angle | Select a unit of the thruster's pitch angle from the | °, %, NOTCH
combo box.

Air TEMP Select a unit of the air temperature from the °C, °F
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Setting Item Description of Setting Setting Value

Water TEMP Select a unit of the water temperature from the °C, °F
combo box.

Air Pressure Select a unit of the air pressure from the combo hPa, mbar
box.

XTD/XTL for TCS Select a unit of the cross track limit from the NM, m

Info combo box.

Wind Direction(True) | Select a method for displaying the wind direction 16points, Degree
(true) from the combo box.

5.1.3 Setting up the Water Depth display

When [Depth Graph] is selected on the classification pain, the [Depth Graph] dialog is shown on the
Edit pain.

Note
This dialog may not be displayed depending on the equipment setting.

"
Depth Graph
Depth Trend Graph
Depth Range(Docking)
AUTO
Depth Range(Voyage)
AUTO

Time Range 10min

Reference AUTO

The following table shows the setting details:

Setting Item Description of Setting Setting Value

Depth Range(Docking) | Select a water depth range for the docking AUTO, 10 m, 25 m, 50 m
depth graph from the combo box.

Depth Range(Voyage) | Select a water depth range for the route AUTO, 50 m, 100 m, 250 m
depth graph from the combo box.
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Setting Item Description of Setting Setting Value

Time Range Select a time range for the water depth 10 min, 15 min, 30 min,
graph from the combo box. 60 min, 12 hours

Reference Switch the reference of the water depth AUTO, Keel

(Priorities) value.

AUTO: Switch the reference of the water
depth value according to the
received value.

Keel: Set the reference of the water depth
to keel.

5.1.4 Setting a rudder angle graph

When [Rudder Graph] is selected on the classification pain, the [Rudder Graph] dialog is displayed on
the edit pain.

Note
This dialog may not be displayed depending on the equipment setting.

Rudder Graph

Rudder Tre aph
Time ge 10min

Rudde

The following table shows the setting details:

Setting Iltem Description of Setting Setting Value
Time Range Select a time range for the rudder angle graph | 5 min, 10 min, 15 min, 30 min
from the combo box.
Rudder Range | Select a rudder angle for the rudder angle 30°, 40°, 50°, 60°, 70°, 80°
graph from the combo box.
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5.1.5 Setting a rudder angle/ship’s heading graph

When [Gyro/Rudder Graph] is selected on the classification pain, the [Gyro/Rudder Graph] dialog is
displayed on the edit pain.

Note
This dialog may not be displayed depending on the equipment setting.

L2
Gyro/Rudder Graph
Gyro/Rudder Trend Graph

Time Range 10min

Rudder Range 60°

The following table shows the setting details:

Setting Item Description of Setting Setting Value
Time Range Select a time range for the rudder angle/ship’s | 5 min, 10 min, 15 min, 30 min
heading graph from the combo box.
Rudder Range | Select a rudder angle for the rudder 30°, 40°, 50°, 60°, 70°, 80°
angle/ship’s heading graph from the combo
box.
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5.1.6 Setting an engine/propeller revolution graph

When [Engine Graph] is selected on the classification pain, the [Engine Graph] dialog is displayed on

the edit pain.

Note
This dialog may not be displayed depending on the equipment setting.

The following table shows the setting details:

Setting Item Description of Setting

Setting Value

Time Range Select a time range for the engine revolution
graph form the combo box.

10 min, 15 min, 30 min,
60 min

Maximum rpm Select an engine revolution on the Ahead side
form the combo box.

AH100, AH200, AH300,
AH500, AH1000

Minimum rpm Select an engine revolution on the Astern side
form the combo box.

0, AS50, AS100
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5.1.7 Setting a wind direction graph/wind speed
graph

When [Wind Graph] is selected in the classification pane, the “Wind Graph” dialog is displayed in the
edit pane.

Note
This dialog may not be displayed depending on the equipment setting.

L3
Wind Graph

Wind Speed Trend Graph

Time Range 1@min  ~

Wind Direction Trend Graph

Time Range 10min  ~

The following table shows the setting contents.

Setting item Setting contents Setting value
Wind Speed Trend Select a time range of the wind speed graph | 10min, 15min. 30min,
Graph — Time Range from the combo box. 60min, 12hours
(Wind speed graph time
range)
Wind Direction Trend Select a time range of the wind speed graph | 10min, 15min.
Graph — Time Range from the combo box. 30min,60min,
(Wind direction graph 12hours
time range)
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5.1.8 Setting a water temperature graph

When [Sea TEMP] is selected in the classification pane, the “Sea TEMP Graph” dialog is displayed in
the edit pane.

Note
This dialog may not be displayed depending on the equipment setting.

(3

Sea TEMP Graph

Sea TEMP Trend Graph
Time Range 1@0min -~

The following table shows the setting details:

Setting item Setting contents Setting value
Time Range Select a water temperature graph time 10min, 15min, 30min,
(Time range) range from the combo box. 60min, 12hours
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5.1.9 Setting up the graph range of the ROT slide
bar

When [ROT] is selected on the classification pain, the [ROT] dialog is displayed on the edit pain.

L2

ROT

ROT
ROT Scale 90-6-90 -~

The following table shows the setting details:

Setting item Setting Setting value
ROT Scale Select a graph range for the ROT slide bar from | 30-0-30, 60-0-60,
the combo box. 90-0-90, 120-0-120,
150-0-150, 300-0-300
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Section 6 Setting Up Alerts

By setting this equipment to generate an alert when the own ship’s position or the condition meets the
specific condition, preliminary measures can be taken.

This section explains the method of setting conditions (threshold values) for generating alerts, alert
processing operations, and alert timer setting using the [Alert] menu.

6.1 Selecting Setting Items

When the [Alert] menu is opened, the [Alert] dialog box appears.
By selecting a setting item in the [Alert] dialog box, the setting dialog of the selected item can be
displayed.

6.1.1 Displaying the [Alert] dialog box

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Alert] button on the menu.
The [Alert] dialog box appears.

Disclosure button

Alert 13

Position

Depth/Safety Contour
Position monitor warning

Position Integrity ‘osition Difference Limit 9.990 NM

Radius Limit (GPS) 100 m
AMS
Radius Limit (DGPS) 100 m

Timer Time Limit

HODOP exceeded caution

Classification pane Edit pane
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The [Alert] dialog box consists of the classification pane and the edit pane.

By clicking the disclosure button ( ), you can hide the classification pane. To show the
classification pane again, click the disclosure button ( ).

6.1.2 Selecting a setting item

1 Click the item you want to set up in the Classification pane.

The setting dialog of the selected item is displayed in the Edit pane.

2 Set up in the Edit pane.

The following items can be set in the [Alert] dialog box.

Setting item

Setting contents

Depth/Safety Contour

Set a condition for generating a Depth Below
Keel alarm for avoiding grounding.

Refer to "6.2 Depth/Safety Contour Alert
Generation Conditions".

Only "Depth Below Keel
alarm" can be set.

Position Integrity
(Position sensor
integrity)

Set the conditions for generating a position monitor warning and a HDOP

limit caution.

Refer to "6.3 Position Integrity Alert Generation Conditions".

AMS (Alert
Management System)

Set the actions to be taken at the next stage for an unacknowledged alert.

Refer to "6.4 Setting Up Alert Processing".

Timer

Set a time for generating the alert.
Refer to "6.5 Setting Up the Alert Timer".
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6.2 Depth/Safety Contour Alert
Generation Conditions

When [Depth/Safety Contour] is selected in the classification pane, the [Depth/Safety Contour] dialog
is displayed in the edit pane.
In this dialog, the threshold values for generating "Depth below keel alarm" can be set up.

L1

Depth/Safety Contour

Depth Below Keel Alarm

Depth Below Keel

The threshold values can be set in a range between 0 and 200 m.
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6.3 Position Integrity Alert Generation
Conditions

When [Position Integrity] is selected in the Classification pane, the [Position] dialog is displayed in the
Edit pain.
In this dialog, the generation condition of the position monitor warning and the HDOP limit can be set
up.

A4

Position

Position monitor warning

Position Difference
Limit

Radius Limit (GPS) 20 m

NM

Radius Limit (DGPS) 10 m

Time Limit 10 sec

HDOP exceeded caution

HDOP Limit

6.3.1 Setting up the generation condition of the
position monitor warning

Enter the following threshold values for generating the position monitor warning.

Position Difference Limit:
The difference in distances when two GPS positions are compared at every second is used as a
threshold value. Specify the difference in a range between 0.010 and 9.990 NM.

Note
. Position Difference Limit takes effect when two GPSs are installed.
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Radius Limit (GPS):

The radius of a monitoring circle having the predicted position of a GPS 1 sec later at the center is
used as a threshold value. If the position actually measured is not within the time monitoring circle
specified in [Time Limit], it will be subjected to an alert. Specify the radius limit in a range between 10
and 100 m.

Radius Limit (DGPS):

The radius of a monitoring circle having the predicted position of DGPS 1 sec later at the center is used
as a threshold value. If the position actually measured is not within the time monitoring circle specified
in [Time Limit], it will be subjected to an alert. Specify the radius limit in a range between 10 and 100 m.
Time Limit:

The time during which the position actually measured by a GPS/DGPS deviates from the monitoring
circle is used as a threshold value. The time limit can be specified in a range between 1 and 29s.

6.3.2 Setting up the HDOP exceeded caution
generation condition

In the [HDOP Limit] combo box, select a threshold limit of HDOP.
Select either one of [4], [10] and [20].
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6.4 Setting Up Alert Processing

When [AMS] is selected in the Classification pane, the [AMS] dialog is displayed in the Edit pane.
In this dialog, the time to activate the action at the next stage when acknowledge is not performed for
an alert can be set up.

“
AMS

Reactivation of Silenced Alert

Time Limit 30 sec

Transfer to BNWAS

Time Limit 30 sec

Repetition of UNACK Warning

Time Limit 60 sec

Enter the wait time until an alert at the next stage is generated in [Time Limit].

Reactivation of Silenced Alert:
Set, in the range between 0 and 60s, the time required to reactivate the alert sound that was silenced

temporarily.

Transfer to BNWAS:
When a BNWAS (Bridge Navigational Watch Alarm System) is connected, specify the time to transfer
an unacknowledged alert to the BNWAS in the range between 0 and 60s.

Repetition of UNACK Warning:
Specify the time to regenerate an unacknowledged alert as an audible warning in the range between 0
and 300s. A warning will be generated repeatedly until it is acknowledged.
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6.5 Setting Up the Alert Timer

When [Timer] is selected in the Classification pane, the [Timer] dialog is displayed in the Edit pane.
In this dialog, the time to generate an alarm can be set up.

Lo

Timer

Timer

[ (LMT) BlelsE

6.5.1 Setting up the timer

To turn on the timer, select the [(LMT)] check box.
To turn off the timer, clear the [(LMT)] check box.

6.5.2 Setting up the time

When you click on the [Timer (LMT)] input box, the numeric value input keyboard appears. Specify the
time at which to generate an alarm in the range between 00:00 and 23:59.

For the use of the numeric value input keyboard, refer to "3.11.2 Name and function of each section of
the keyboard".
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Section 7 Setting Up the Operation
Mode

7.1 Basic Operation of the [Settings]
Dialog Box

You can set up the operation mode in the [Settings] dialog box.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Settings] button.
The [Settings] dialog box appears.
The [Settings] dialog box consists of the classification pane and the edit pane.
Click on the disclosure button (<<) to hide the classification pane. To show the edit pane again,
click on the disclosure button (>>).

Title bar Disclosure button [*] (Close) button

L1 x
Color and Brightness Edit pane title

Day/Night lDayl - [Def.|

Display Calar | Brightness
Key Assignment Dialog Dark

Character | ] White

Y Y
Classification pane Edit pane
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3 cClick on the item you want to set up in the classification pane.
The setup dialog of the item you selected is displayed.

4 set up in the edit pane.
Classification pane display targets

The table below provides the related sections of the classification panes and descriptions that
are displayed by Conning Display.

Classification pane Related section

Color and Brightness 7.2 Setting Color and Brightness
Sounds 7.3 Setting Sounds
Key Assignment 7.4 Setting Key Assignment
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7.2 Setting Color and Brightness

Select [Color and Brightness] in the classification pane.
Set the color and the brightness of the display contents in the setting dialog of the edit pane.

[1] (1]

A A

Color and Brightness Color and Brightness

Day/Night Day1 Day/Night Day1

Display Color | Brightness Display Color | Brightness
Dialog Dark

. White

Character Level3

Parel Level4(Light) ~

[1] [Def.] (default value) button
When this button is clicked on, all the setting items of the mode that is selected on the [Day/Night]
combo box are reset to the default values.
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Setting Item

Description of Setting

Setting Value

Day/Night

Set up the color of the dialog box itself.

Select the chart display colors from the three
types of Day1, Day3 and Night when the ARCS
is used.

Day1 [default]
Day2
Day3
Dusk
Night

[Display Color] tab

Dialog Set up the color of the dialog box. Dark [default]
Black

Character Set up the text color. White [default]
Green

[Brightness] tab

Character

Set up the text brightness.

Level1(Dark) [default of
Day 3]
Level2 [default of Day 2,
Dusk]
Level3 [default of Day 1]

Level4(Light) [default of
Night]

Panel

Set the brightness of the operation unit.

Off

Level1(Dark) [default of
Dusk / Night]

Level2 [default of Day3]
Level3 [default of Day2]

Level4(Light) [default of
Day1]

Display

Set the value that is input in the box for the
brightness of the display unit.

0to 100"

*1 The table below provides the default value of brightness.

26inch Display

19inch Display

Day1/Day2/Day3:67
Dusk:60
Night: 11

Day1/Day2/Day3:42
Dusk:20
Night:4
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7.3 Setting Sounds

Select [Sounds] in the classification pane.

Set the volumes of the operation sound and operation error sound and alarm melody in the setting
dialog of the edit pane.

When the volume or melody is changed, the selected volume or melody is played back, enabling the
user to set while listening to the sound.

«  Settings «  Settings

Sounds Sounds

Volume | Melody Volume | Melody

Level3

Sound2
Level3
Sound?2

Sound?2

Level4(Loud)
Level4({Loud)
Level4{Loud)
Level4(Loud)
Level 4{Loud)

Level4(Loud)

Setting Item Description of Setting ‘ Setting Value
[Volume] tab
Key ACK Set the volume of the sound emitted when the | Off
key is pressed. Level1(Soft)
Level2
Level3 [Default]
Level4(Loud)
Misoperation Set the volume of the operation error sound. Off
Level1(Soft)
Level2
Level3 [Default]
Level4(Loud)
Response/Notification | Set the volume of the control response sound | Off
to external equipment and control completion | | evel1(Soft)
notification sound (including the interswitch Level2
control) from external equipment. Level3 [Default]
Level4(Loud)
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Setting Item

Description of Setting

Setting Value

Message Notification

Set the volume of the message noatification
sound.

Off
Level1(Soft)
Level2

Level3 [Default]
Level4(Loud)

Alert Setting
Reminder

Set the volume of the sound notifying that the
alarm condition has not been set.

Off
Level1(Soft)
Level2

Level3 [Default]
Level4(Loud)

Navigation 1 Alarm

Navigation 2 Alarm’

Navigation 3 Alarm

Set the volume of the navigation alarm sound.

Level1(Soft)
Level2

Level3 [Default]
Level4(Loud)

CPA/TCPA Alarm

Set the volume of the CPA/TCPA alarm sound.

Level1(Soft)

Level2

Level3

Level4(Loud) [Default]

Warning

Set the volume of the system alarm sound.

Off

Level1(Soft)

Level2

Level3

Level4(Loud) [Default]

Emergency Alarm

Set the volume of the Emergency Alarm sound.

Level1(Soft)

Level2

Level3

Level4(Loud) [Default]

[Melody] tab

Navigation 1 Alarm

Set the melody of the Navigation 1 alarm.

Sound1
Sound2[Default]
Sound3
Sound4

Navigation 2 Alarm”’

Set the melody of the Navigation 2 alarm.

Sound1
Sound2[Default]
Sound3
Sound4

Navigation 3 Alarm’’

Set the melody of the Navigation 3 alarm.

Sound1
Sound2[Default]
Sound3
Sound4

CPA/TCPA Alarm

Set the melody of the CPA/TCPA alarm.

Sound1
Sound2[Default]
Sound3
Sound4

Warning

Set up the melody of Warning.

Sound1
Sound2[Default]
Sound3
Sound4

*1 Navigation 2 Alarm and Navigation 3 Alarm are not practically used.

*2 For these volumes, only Level 4 (Loud) may be able to be selected depending on the setting.
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7.4 Setting Key Assignment

Select [Key Assignment] in the classification pane.

Set the keys in the operation unit and the function assigned to the [MULT]I] dial in the setting dialog of

the edit pane.

Only the items whose funtions are available on the task screen are displayed on the screen.

A

Key Assignment
User Keys

User Key 1

Show Preset Menu

User Key 2

Show Preset Menu

Multi Dial

A
Key Assignment

User Keys | Multi Dial

¥/ Panel Brightness

The [User Keys] tab is displayed only when the optional operation unit is installed.

Setting Item

Description of Setting

Setting Value

[User Keys] tab

operation unit.

[User Key 2] is displayed only when the optional
operation unit is installed.

User Key 1 Select a function to assign to the USER1 key on the Show Preset Menu
operation unit. Capture Screen
[User Key 1] is displayed only when the optional
operation unit is installed.

User Key 2 Select a function to assign to the USER2 key on the Show Preset Menu

Capture Screen

[Multi Dial] tab

Display Brightness

When this is selected, the display brightness
adjustment function will be manipulated with the
[MULT]I] control.

It cannot be changed since power is always on.

To enable: Select.
To disable: Clear.

Panel Brightness

When this is selected, the operation unit brightness
adjustment function will be manipulated with the
[MULTI] control. This item is always displayed.

To enable: Select.
To disable: Clear.
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Section 8 Adjusting and Setting Up
Equipment (for Services)

This section describes the methods for equipment setting and maintenance that are conducted by the
service staff by using the Service menu at installation construction of this equipment.

ACAUTION

Any adjustments must be made by specialized service personnel.

Incorrect settings may result in unstable operation, and this may lead to
accidents or equipment failure.

8.1 Service Menu

The Service menu consists of two submenus of Installation and Maintenance. To display the Service
menu, a password is required.

8.1.1 To display the Service menu:

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.
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2 Click the [Code Input] button on the menu.
The password input dialog is displayed.

Enter

3 Enter 0 in Password.

Click on the [Menu] button at the bottom left corner of the screen.
You can find the [Service] button added to the menu.

5 Click the [Service] button.
The submenu is displayed.

Menu > | Service

= &1 Installation &1 Maintenance

il

6 Display a submenu dialog by clicking on one of the [Installation] and [Maintenance]
buttons.
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8.2 \Verifying Installation and Initial
Setting

Use the [Installation] dialog box to verify the installation of this equipment and perform initial setting.

8.2.1 Displaying the [Installation] dialog box

Clicking on the [Installation] in the submenu, the [Installation] dialog box appears.
The [Installation] dialog box consists of the classification pane and the edit/result pane. The
classification pane consists of two-level layers of the first classification pane and the second

classification pane.

Installation

System Ship's i . . )

Configuration = Parameters SEttings I First ClaSS|f|Cat|0n
cC ¢ " pane

R . \ Length 2115 m

S Beam 184 m
244 m

Serial Port

GPS
@ Antenna
CCRP

> Edit/Result pain

X Y
+ CCRP1 04 m 840 m
CCRP2 1.2 m 1000 m
CCRP3 0.0 m 00 m
CCRP4 00 m 0.0 m

Speed Position(from fore Draft)

Bow: 060 m
Stern: 00 m }
\ 7

Second classification pane

1 Click the item you want to set up in the classification pane.
The setup dialog of the item you selected is displayed in the edit/result pane.

2 Sset up in the edit/result pane or check the setup resulit.
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8.2.2 Verifying/Setting CCRP (Consistent Common
Reference Point)

Set a measurement reference position (CCRP) on own ship by using the [CCRP] dialog.

8.2.2.1 Displaying the [CCRP] dialog

When you select [System Configuration] in the first classification pane and [CCRP] in the second
classification pane, the [CCRP] dialog is displayed in the edit/result pane.

Installation
System Ship's

S ) Settings
Configuration =~ Parameters 9

CCRP ¢ Y Length 2115 m

Serial Port s 542 m Beam 184 m
244 m

GPS
@ Antenna
CCRP

X Y
« CCRP1 -0.4 m 840
CCRP2 1.2 m 100.0
CCRP3 60 m 0.0
CCRP4 00 m 0.0

Speed Position(from fore Draft)

Bow: 0.0 m (0,0)

Stern: 0.0 m

Note
Set up the GPS correctly. The latitude and longitude data received from the GPS is compensated
and then displayed as own ship's latitude and longitude.
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8.2.2.2

Setting CCRP

Set the following items in the [CCRP] dialog.

Setting Item

Description of Setting

Setting Value

Length (of ship)

Enter the ship's length in the box.

1.0 to 1022.0 m

Beam (ship's width)

Enter the ship's width in the box.

1.0t0 126.0 m

GPS1/2

Enter the equipment positions of GPS1 to GPS2 in

the boxes.

X: Horizontal axis position on the ship of the
applicable GPS (Center: 0)

Y: Front-back axis position on the ship of the
applicable GPS (Stern: 0)

Changes depending on the
value of [Length] and [Beam].
If Length=a and Beam=b:

X -b/2tob/2

Y 0.0Otoa

For example,

+ if Length=1.0 and Beam=1.0:

Note X 051005
+ This item may not be displayed depending on the Y 00to01.0
equipment setting. « if Length=700.0 and
* When the input range is changed by modifying Beam=70.0:
[Length] and [Beam], if a value exceeding the X -35.0to0 35.0
input range after modifying has already been Y 0.0to700.0
entered, the value will be corrected to the
maximum or minimum value.
CCRP1/2/3/4 Enter the positions of CCRP1 to CCRP4 of the
ship in the boxes.
X: Horizontal axis position of radar antennas 1 to 8
on the ship (Center: 0)
Y: Front-back axis position of radar antennas 1 to 8
on the ship (Stern: 0)
Note
When the input range is changed by modifying
[Length] and [Beam], if a value exceeding the input
range after modifying has already been entered,
the value will be corrected to the maximum or
minimum value.
CCRP Select the position to be used as the ship's CCRP | CCRP1
by clicking the button. CCRP2
CCRP3
CCRP4

Speed Position Bow

Enter the distance of the bow starboard/port speed
display point.

0.0 to Ship’s length m

Speed Position Stern

Enter the distance of the stern starboard/port
speed display point.

0.0 to Ship’s length m

Synchronizing setting
The [CCRP] dialog enables common setting items and individual setting items for RADAR, ECDIS, and

Conning (called a task station individually). Once common items are set in any of the task stations,

RADAR, ECDIS, and Conning, the settings are reflected (synchronized) in other task stations.

By setting common items in the state where all the task stations are active, the common setting items

are synchronized in all the task stations.
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8.2.3 Setting a Serial Port

Verify the setting of the serial port of this equipment and perform initial setting by using the [Serial Port]
dialog.

Synchronizing setting

The [Serial Port] dialog enables common setting items and individual setting items for RADAR, ECDIS,
and Conning (called a task station individually). Once common items are set in any of the task stations,
RADAR, ECDIS, and Conning, the settings are reflected (synchronized) in other task stations.

By setting common items in the state where all the task stations are active, the common setting items
are synchronized in all the task stations.

8.2.3.1 Displaying the [Serial Port] dialog

When you select [System Configuration] in the first classification pane and [Serial Port] in the second
classification pane, the [Serial Port] dialog is displayed in the edit/result pane.

‘ Installation
System Ship's
Configuration [SParameters

Settings

CCRP <
Terminal Board Sensor  Diagnosis

¥ Gyro [Heading Sensor(NMEA) -/ [ Detail | [ Monitor | IEC61162-2
[vilog [Log(NMEA) - [ Detail | [ Monitor | IEC61162-1
[VIGPS ez [ Detail | [ Monitor | IEC61162-1
[V AIS RIS [ Detail | [ Monitor @ IEC61162-2

Serial Port

ISW/MTR
Serial OPU

‘ Sl | siez | Tab name
Terminal Board Sensor  Diagnosis

[vICH1 Anemometer(Wind) -

VICH2 [Engine/Propeller -

[vICH3 Thruster

[vICH4 Azimuth Thruster

|vICH5 Rudder

[ Detail | [ Monitor |
| Detail | | Monitor |
[ Detail | [ Monitor |
| Detail | | Monitor |
[ Detail | [ Monitor |

Detail Monitor

IEC61162-1

[vICHB Engine Telegraph
l¥/CH7 Echo Sounder 1(Depth)
[vICH8 TRI

Detail Monitor

Detail Monitor

{_IGHS =
- e — IEC61162-2
LICH1@ = - etail / r

C OO0 CCOOOOOCO

- Gyro
[JGyro I/F L
0g

8.2.3.2 [Diagnosis] lamp light colors

The [Diagnosis] lamp indicates the diagnosis result on whether or not the sentence of the sensor
specified for each serial port has been received successfully and the status of ISW/MTR/Serial OPU.
Lit in red: Data not received.

Lit in green: Data is receiving.

Lit in orange: In diagnosis (before decision).

No color: Serial port is disabled.
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8.2.3.3

In the [Serial Port] dialog, allocate the sensors to be connected for the serial port on CCU (Central

Setting a serial port

Control Unit) and the serial port on SLC/ALC.

Setting a serial port on CCU

Set each item as follows.

"Table A: Sensors that can be selected on CCU" shows selectable sensors.

However, the sensors that actually can be selected vary depending on the equipment setting.

For the sensor communication speed, refer to "Baud rates that can be selected" (setting at factory

delivery).
Setting ltem Description of Setting Setting Value
Gyro . Select the check box and enable the serial port for the | To enable: Select.
Gyro. To disable: Clear.
. Select a sensor to be connected to the serial port for
Gyro from the [Sensor] combo box. When not
selecting a sensor, set [ - ].
LOG . Select the check box and enable the serial port for the | To enable: Select.
LOG. To disable: Clear.
. Select a sensor to be connected to the serial port for
LOG from the [Sensor] combo box. When not
selecting a sensor, set [ - 1.
GPS . Select the check box and enable the serial port for the | To enable: Select.
GPS. To disable: Clear.
. Select a sensor to be connected to the serial port for
the GPS from the [Sensor] combo box. When not
selecting a sensor, set [ - ].
AIS . Select the check box and enable the serial port for the | To enable: Select.

AlIS.

. Select a sensor to be connected to the serial port for

the AIS from the [Sensor] combo box. When not
selecting a sensor, set [ - ].

To disable: Clear.
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Table A: Sensors that can be selected on CCU

Serial port Sensor name

Gyro Heading Sensor(NMEA), Heading Sensor1(NMEA) ", Heading
Sensor2(NMEA)
Heading Sensor(Gyro I/F), Heading Sensor1(Gyro I/F)", Heading
Sensor2(Gyro I/F)

LOG Log(NMEA) , Log1(NMEA)**, Log2(NMEA)*?
Log(Gyro I/F) *3
Selector

GPS GPS 1
GPS 2%
GPS 3+
GPS 4*
Selector

AIS AIS

*1: Only when there are two Heading Sensors

*2: Only when two logs are available

*3: Only when Heading Sensor(Gyro I/F) is selected for Gyro of CCU
*4: May not be displayed depending on the number of GPS units.

Setting serial ports on SLC/ALC
Set the serial ports on SLC/ALC that is installed as follows.

Setting item Description of Setting Setting value
CH1 to CH8 1. Click on any of the tabs, SLC1(M) to SLC4(M)/SLC1(S) to | Enable: Select.
(RS-422) SLC4(S)/ALC1 to ALCA4. Disable: Clear.

2. Enable the serial port of the corresponding channel by
selecting the check box.

3. Select a sensor ' to be connected to the corresponding
channel on the [Sensor] combo box. When not selecting a

sensor, select [ -].

CH9/CH10 1. Click on any of the tabs, SLC1(M) to SLC4(M)/SLC1(S)to | Enable: Select.

(RS-422/RS485) SLC4(S)/ALC1 to ALCA4. Disable: Clear.

2. Enable the serial port of the corresponding channel by
selecting the check box.

3. Select a sensor ' to be connected to the corresponding
channel on the [Sensor] combo box. When not selecting a

sensor, select [ - ].

*1: The sensors that can be selected on SLC/ALC are indicated below.

However, the sensors that can be actually selected vary depending on the equipment setting.

Heading Sensor 1, Heading Sensor 2, Log 1, Log 2, GPS 1, GPS 2, GPS 3, GPS 4, Ship’s Clock, Echo
Sounder(Depth), Echo Sounder 2(Depth), AIS, NAVTEX, Anemometer(Wind), Water Temperature
Meter, Current Meter, Climate Meter, TRI, Autopilot, Rudder, Engine/Propeller, Engine Telegraph,
Thruster, Azimuth Thruster, Generator, Fin Stabilizer, YEOMAN Digitizer, RADAR1(TT RX),
RADAR2(TT RX), Alert(to CAM), Alert(from Subsystem), Alert(to BNWAS), IAS(MODBUS), DSC
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8.2.3.4

Changing the communication settings of the serial port

Click the [Detail] button of the enabled serial port and display the [Detail] dialog.

‘ Serial Port - Detail

Source Device SLC1

Terminal |CH1
Communication

Baud Rate
Data Length

Parity ' None

4800 -
8 - Buffer Size

Sensor Anemometer(Wind)

Stop Bits |
256

v Time Out 15 |sec

vl Checksum

Alert(from Sensor)
Sentence | - =

Serial Port - Detail

Source Device SLC1

Terminal CH8
Communication

Baud Rate

Data Length

Parity ' None

Alert(from Sensor)
Sentence | - ~

4800 ~
S~ Buffer Size

When selecting CH1 to CH7

Sensor [TRI

1.5% ~  Stop Bits -
256

~ Time Out 15 sec

When selecting CH8 to CH10

8-9

[vIChecksum
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The setting target can be checked with [Source Device] display, [Terminal] display and [Sensor]

display.

Perform the settings shown in the following table and then click on the [Set] button.

Setting Item

Description of Setting

Setting Value

Baud Rate

Select the baud rate of the corresponding serial
port from the combo box.

In the [Detail] dialog of any of CH8 to CH10, the
[Baud Rate] addition ratio combo box is
displayed on the right side of the [Baud Rate]
combo box.

Selectable baud rates vary
depending on the serial port
(Refer to "Baud rates that

can be selected".)

[Baud Rate] addition ratio
combo box

Displayed in the [Detail] dialog of CH8 to CH10.
By using this combo box, the addition ratio (%)
for adjusting the baud rate can be changed. The
baud rate for communication is determined by
adding the additional ratio to the value that is set
in the [Baud Rate] combo box.
Example) 4800 x (1 + 1.5/ 100) = 4872
Additional ratio

0.0% to 3.0% (can be set in
the unit of 0.5%)

Data Length Select the data length of the corresponding serial | 5/6/7/8
port from the combo box.
Parity Select the parity of the corresponding serial port | None/Odd/Even
from the combo box.
Stop Bits Select the stop bit length of the corresponding 1/2
serial port from the combo box.
Buffer Size Enter the buffer size of the corresponding serial 0 to 10240 bytes
port in the box.
Time Out Enter the time-out duration of the corresponding | 0 to 999s
serial port in the box.
Checksum Select the check box and enable the checksum To enable: Select.
of the sentence of the corresponding serial port. | To disable: Clear.
Subsystem Set the equipment to be connected for Alert "Alert (from Subsystem)":
Handling. Equipment that is set as
Displayed only when the sensor is "Alert (from -/installed (Task Station and
Subsystem)" or "Alert (to CAM)". sensor)
The selection is also allowed for the subsystem "Alert(to CAM)":
that has already been used in the channel of Equipment that is set as
some other serial port. -/installed (Task Station)
Primary/Secondary Select Primary or Secondary for IAS(MODBUS) | Primary: Primary system
input. Secondary: Secondary
Displayed only when the sensor is system
"IAS(MODBUS)".
Sentence Select the sentence of Alert Handling. Normal sensor such as GPS

Displayed when the sensor is other than "Alert
(BNWAS), "IAS(MODBUS)", "DSC" or
"NAV/Alert".

and Log:

-/ALR/ALF

"Alert (from Subsystem/to
CAM)":

ALR/ALF
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Baud rates that can be selected

Serial port ‘ Baud rate
Serial port on CCU
Gyro (at selection Heading Sensor(NMEA)) 4800/38400
Gyro (at selection Heading Sensor(Gyro I/F)) Fixed to 38400
Log (at selection Log(NMEA)) Fixed to 4800
Log (at selection Log(Gyro I/F)) Fixed to 38400
GPS Fixed to 4800
AIS Fixed to 38400
Serial port on SLC/ALC
CH1-8 2400/4800/9600
CH9/10 2400/4800/9600/19200/38400
Gyro I/F Fixed to 38400
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8.2.4 Setting ship's parameters

Set parameter values of own ship by using the [Ship’s Parameters] dialog.

8.2.41 Displaying the [Ship’s Parameters] dialog

When you select [Ship's Parameters] in the classification pane, the [Ship’s Parameters] dialog is
displayed in the edit/result pane.

Installation
System Ship's

Cattimm
_ . . Settings
Configuration  Parameters gs

Ship General Ship General

Ship's Name JRC-Maru
Length . m
Beam 18.4 m
Height from keel to MAX point . m
Keel-Trans 2.0 m
MAX Course Change 2
MAX Speed Limit 30.0 kn
MIN Speed Limit 5.0 kn
MAX ROT 300.0 °/min
MIN ROT © °/min
MIN Turn Radius 0.50 NM
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8.2.4.2

Setting own ship's parameters

Set the following items in the [Ship’s Parameters] dialog.

Setting Item Description of Setting Setting Value
Ship's Name Enter own ship's name in the box. Max. 20 characters
Length (of ship) Enter own ship's length in the box. 1.0t0 1022.0 m
Beam (ship's width) Enter own ship's beam in the box. 1.0t0 126.0 m
Height from keel to MAX point Enter the height of the ship from the 1.0t0 126.0 m
keel to the maximum point in the box.
Keel-Trans Enter the distance between the 0.0t020.0 m

(distance between the transducer
and the keel)

transducer of the depth sounder and
the keel. (Required when displaying the
water depth with the keel fixed)

MAX Course Change
(limit value of course change
angle)

Enter the limit value of the course
change angle of the planned route in
the box.

20.0 to 359.9°

MAX Speed Limit

Enter the ship's maximum speed in the

10.0 to 99.9 kn

box.

MIN Speed Limit Enter the ship's minimum speed in the 0.0t0 89.9 kn
box.

MAX ROT Enter the maximum rate of turn in the 30.0 to 1200.0°/min
box.

MIN ROT Enter the minimum rate of turn in the 0.0 to 570.0°/min

box.

MIN Turn Radius

Enter the minimum turn radius in the

box.

0.00 to 9.99 NM

Synchronizing setting

The [Ship’s Parameters] dialog enables common setting items and individual setting items for RADAR,

ECDIS, and Conning (called a task station individually). Once common items are set in any of the task

stations, RADAR, ECDIS, and Conning, the settings are reflected (synchronized) in other task stations.

By setting common items in the state where all the task stations are active, the common setting items

are synchronized in all the task stations.
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8.3 Maintenance

Use the [Maintenance] dialog box for maintenance operation of this equipment.

8.3.1 Displaying the [Maintenance] dialog box

Clicking the [Maintenance] button in the submenu displays the [Maintenance] dialog box.
The [Maintenance] dialog box in the submenu consists of the classification pane and the edit/result

pane. The classification pane consists of two-level layers of the first classification pane and the second
classification pane.

Maintenance

Storage Initialization I First classification pane

Manag t e
anagemen I Second classification pane

Drive Information
Drive Total: Free:
System(C:) 6.87GB 2.72GB
Data(D:) 235.49GB 180.77GB

File Information

File Usage
5-57 75.76MB
C-MAPED.3 4,968.43MB
ARCS 0.77MB > Edit/Result pane

Playback Data 2,970.76MB
Logboaok 1.96MB
Message 0.01MB

Route 1.49MB
User Map 0.06MB

Freom Tomalk ac nzmol T
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8.3.2 Managing storage

When you select [Storage] in the first classification pane and [Management] in the second
classification pane, the [Management] dialog is displayed in the edit/result pane.

Maintenance
Storage Initialization
Management

Drive Information

Drive Total: Free:
System(C:) 6.87GB 2.72GB
Data(D:) 235.49GB 180.77GB

File Information

File Usage

S-57 75.76MB
C-MAPED.3 4,968.43MB
ARCS 0.77MB

Playback Data 2,970.76MB
Loghook 1.90MB
Message 0.01MB

Route 1.49MB
User Map 0.00MB

(Frceen == A& AZKAD

The total storage capacity and free space on each of the drives (C and D) are displayed in the [Drive
Information] list. The capacity of each of the files stored on the drives is displayed in the [File
Information] list. The files managed by File Manager are applicable.
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Section 9 Maintenance & Inspection

9.1 Maintenance Functions Executed from
Menu

This section explains maintenance functions that are executed from the menu.

9.1.1 Starting maintenance functions

1 Click on the [Menu] button at the bottom left corner of the screen.

The menu is displayed.

2 Click on the [Maintenance] button on the menu.
The submenu is displayed.

3 Click on a button on the submenu.
The dialog box of the corresponding maintenance function is displayed.

9.1.2 Setting Date/Time/Time Zone

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Maintenance] - [Date/Time/Time Zone] button on the menu.
The [Date/Time/Time Zone] dialog box appears.

|Date;’Time/Time Zone 1]

Date
1 » « 12013 : [3]

[4]
[2]
13 14 15 16
27 28 29 30
Display Style YYYY-MM-DD - [5]
[v| Synchronise with Time Source(Date/Time) [6]
[l Synchronise with Time Source(Time Zone) [71
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[1] [X] button
Click on this button to close the [Date/Time/Time Zone] dialog box.

[2] [Date]

Set the year, month and day on the calendar.

For the details of how to use the calendar, refer to "3.12 Setting a Date and a Time (Calendar
Operation)".

[3] [Time(LMT)]
Enter the time in the input box. The time entered will be reflected on the clock.

[4] [Time Zone]
Enter the time zone in the time zone combo box.
A time zone can be selected between -13:30 and +13:30 from UTC.

[5] [Display Style]

From the combo box, select the style to display the date.
* YYYY-MM-DD (Japanese style)

* MMM DD,YYYY (North American style)

« DD MMM,YYYY (European style)

[6)][Synchronise with Time Source(Date/Time)](Synchronize time with GPS)
When this item is checked, the date and time are synchronized by using the time information (ZDA

sentence) from GPS and so on.

[7] [Synchronise with Time Source(Time Zone)](Synchronize the time difference with GPS)
When this item is checked, the time difference is synchronized by using the time information (ZDA

sentence) from GPS and so on.

Note
When [Synchronize with Time Source(Date/Time)] is not checked, the time is reset to the initial

value at the start of power supply. Therefore, set a correct time manually.
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9.1.3 Confirming System Information

System information can be confirmed.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Maintenance] - [System Information] button on the menu.
The [System Information] dialog box appears.

The contents of the dialog will be switched by clicking on the selection tabs provided in the
dialog box.

Software Functionality Selection
TR tab
JMR-9230-S

Application 01

Maintenance No. 01
TXRX| 00

TCS 01.00
Presentation Library 3.4

BAMS 01.00

Save to USB Device

9.1.3.1 Confirming Software Information

AWARNING

When you want to use a USB flash memory to read or write a file, make sure in

advance that the USB flash memory is not affected by a computer virus. If the
display unit is infected with a virus, other equipment may also be infected, with the
result that a trouble may occur.

Before removing the USB flash memory, check for the access lamp of the USB flash
memory and make sure that it is not being accessed.

If you remove or insert the USB flash memory when it is accessed, data may be
destroyed and a trouble may occur.

Software information can be confirmed.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.
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2 Click on the [Maintenance] - [System Information] button on the menu.

The [System Information] dialog box appears.

3 Click on the [Software] tab.
The software information is displayed.

System Information (1]

Software

JMR-9230-S

[1] [X] button

Functionality

Application 01.00

Maintenance No. @

TXRX

TCS 01.00

(2]

Presentation Library 3./

BAMS 01.00

(3]

Click on this button to close the [System Information] dialog box.

[2] Software information

Item Displayed information
JXX-XXXX Type and model name of the system
Application Version of the application software

Maintenance No.

7-digit maintenance number

TXRX

Version of the software used for the radar transmitter-receiver unit

* This information is displayed when the system is equipped with the RADAR
function.

TCS Version of the software used for TCS
* This information is displayed when the system is equipped with the TCS
function.
Presentation Edition of S52 Presentation Library
Library Displayed in case of ECDIS or RADAR (with ENC chart display licence)
BAMS Software version of the BAM system

Displayed when the AMS license is available.

[3] [Save to USB Device] (Saving to USB flash memory) button
Click on this button to save the displayed information in a USB flash memory in the text format.
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9.1.3.2 Checking the enable/disable statuses of the functions that
have been installed

AWARNING

When you want to use a USB flash memory to read or write a file, make sure in

advance that the USB flash memory is not affected by a computer virus. If the
display unit is infected with a virus, other equipment may also be infected, with the
result that a trouble may occur.

Before removing the USB flash memory, check for the access lamp of the USB flash
memory and make sure that it is not being accessed.

If you remove or insert the USB flash memory when it is accessed, data may be
destroyed and a trouble may occur.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Maintenance] - [System Information] button on the menu.
The [System Information] dialog box appears.

3 cClick on the [Functionality] tab.
The functionality information is displayed.
The display contents vary depending on the number of operation modes and whether the
modes include the primary task (shown by the name of this equipment).
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[The system has multiple operation modes and RADAR is the primary task]

System Information [1]
Software Functionality H/W Key Specification
primary| JMR-9230-S CHART RADAR
ECDIS
- (2]
_onning Display
Multi Capability System
Device Licence Status
ECDIS Enable
RADAR Enable (3]
Connina Disnlav/Fnable
Save to USB Device [4]

[The system has multiple operation modes and RADAR is not the primary task]

System Information )

Software Functionality H/W Key Specification

JMR-9200 Series RADAR

Primary | JMR-O DIS
JAN-92 _onning Display 2)
Multi Capability System

Device Licence

ECDIS Enable
RADAR Enable (3)

Connina Disnlav/Fnable

Save to USB Device 4)
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[Section that is displayed when the above screen is scrolled down (example)]
System Information
ware Functionality fication
Option Licence

Band Combining Disahle
MAX TT Mumber

MAKX ALS Number 1200

(3]

Chart ENIC M AP Erable
» Enable

Save tol

fication

|.J:-'1il"||;_'_] VHF Disable

RADAR Overlay Enable
- (3]
[nmarsat Blocking Area Disable

nable
Owerlay Weather

Save to USE Device

em Information

tware Functi Lity f cation

Wave Analy
nchronization 5 3]
erlay Weather [

urrent Dis

Overlay Wave Height/ D
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[1] [X] button
Click on this button to close the [System Information] dialog box.

[2] Format

The system format and model name of this equipment are displayed (Example: JMR-xxxx-x CHART
RADAR (for Chart RADAR).

The [Primary] badge is displayed in front of the format for the primary task.

[3] Functionality
The functions that are installed are displayed in [Device Licence] and [Option Licence].
One of the following is displayed in [Status].

[Status] Meaning
Enable Indicates that the function can be used.
Disable Indicates that the function cannot be used.
Value (such as 500) Indicates the setting value of the option licence of the function.
Stand-alone Indicates that the function can be used independently and cannot be
used as the synchronization function with other devices.

[4] [Save to USB Device] (Saving to USB flash memory) button
Click on this button to save the displayed information in a USB flash memory in the text format.
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9.1.4 Confirming operating time

Confirm the operating time of this system.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Maintenance] - [Operating Time] button on the menu.
The [Operating Time] dialog box appears.

Operating Time b4 [1]
imated time to replace)

Operating Time of . Station

Total @ Hours

LCD
LCD FAN
CCU FAN
P5U FAN
UPS

(2]

Operating Time of S
Total
Transmit
Motor
FAN

[11 [X] button
Click on this button to close the [Operating Time] dialog box.

[2] [Operating Time Of Work Station]

The operating time of this equipment is displayed.

[Total]: Total operating time of this equipment

[SSD1]: Total operating time of SSD1. The estimated replacement time is indicated in ().
[SSD2]: Total operating time of SSD2. The estimated replacement time is indicated in ().
[LCD]: Total operating time of LCD. The estimated replacement time is indicated in ().
[LCD FAN]: Total operating time of LCD FAN. The estimated replacement time is indicated in ().
[CCU FAN]: Total operating time of CCU FAN. The estimated replacement time is indicated in ().
[PSU FAN]: Total operating time of PSU FAN. The estimated replacement time is indicated in ().
[UPS]: Total operating time of UPS. The estimated replacement time is indicated in ().

Memo
[UPS] is displayed only when UPS is installed as an option.
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9.1.5 Setting and confirming the sensor source

9.1.5.1 Set and confirm the sensor source

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Maintenance] - [Sensor Selection/Status] button on the menu.
The [Sensor Selection/Status] dialog box appears.

(3] (2] (1]

Sensor Selection/Status b

Sensor Selection Sensor Selection
MDcit i Crat o Sensor Source

Position Status
Position 'GPS 1

Heading Gyro 1
sTwlog1 -
COG/SOG GPS 1
Time GPS -
Depth FWD

S0G(Docking) GPS 1 -
Navigational Data ECDIS 2 ~

vl Switch to equipment for Autosailing

[1] [X] button
Click on this button to close [Sensor Selection/Status] dialog box.
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[2] [Sensor Selection]

Enables selection of a sensor source.

Setting item Description of Setting Setting value
Position Select a Primary Position sensor source from the GPS x, DR
combo box. ("x" indicates the unit
number)
Heading Select a heading sensor source from the combo box. MAN, Gyro x
*The source that can be selected varies depending on | ("x" indicates the unit
the installation. number)
*When GyroSW is enabled, only Gyro and MAN can be
selected.
When the sensor source is set to [Manual], the heading
value can also be input in the input box.
Heading value input range: 0.0-359.9°
STW (Speed Select a Speed Through Water sensor source from the | MAN, Gyro X, MAG,
Through Water) combo box. G/IC
*The sources that can be selected vary according to the | ("x" indicates the unit
installation. number)
* When 1AX is installed for Log, Log cannot be selected
from the sensor source.
When the Gyro Compass system that is used has the
automatic switching function, the sensor source display
is switched automatically according to the switching
condition.
When the sensor source is set to [MAN], the ship’s
heading value can also be input in the input box.
Ship’s heading value input range: -99.9-99.9kn
COG/SOG Select Course Over the Ground/Speed Over the Log x, GPS
(Course Over the | Ground sensor source from the combo box. ("x" indicates the unit
Ground/Speed *The source that can be selected varies depending on | number)

Over the Ground)

the installation.

When GPS is selected for Position, the same GPS is
selected automatically.

Time (Time
correction)

Select a sensor source to be used for time correction of
this equipment from the combo box.

*The source that can be selected varies depending on
the installation.

GPS, Ship Clock

Depth (water Select a water depth sensor source from the combo FWD, AFT, MID,
depth) box. AUTO™

*The selectable sources vary depending on the

installation.
SOG(Docking) Select a sensor source of the Speed Over the Ground | Log x, GPS

(Docking) from the combo box.

*The source that can be selected varies depending on
the installation.

("x" indicates the unit
number)

Navigational Data

Select a source (sensor) from which route monitoring
information is acquired.

*The source that can be selected varies depending on
the installation.

* Cannot be selected when there is equipment that is
performing Auto Sailing and the "Switch to equipment
for Autosailing" check box is selected.

ECDIS x, MFD x

("x" indicates the unit
number)
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Setting item Description of Setting Setting value

Switch to When acquiring route monitoring information from the ON/OFF
equipment for equipment that is performing Auto-Sailing, enable the
Autosailing item (ON) by selecting the check box.

When acquiring route monitoring information from the
source that is selected from Navigational Data, disable
the item (OFF) by clearing the check box.

*1 In this case, one Echo Sounder is installed. When two Echo Sounders are installed, E/S1(AUTO)
and E/S2(AUTO) can be selected, not AUTO.

[3] Disclosure button
When this button is clicked on, the left pane will be hidden.

Memo
When a Log Selector is installed and the Log (speed) sensor is switched automatically, the following
popup window is displayed indicating the effect.

System X
When a switch of Log selector is manual mode,
conform the switch tc = STW source.

Moreover, conform STW source of other task
station too.

0] 4
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9.1.5.2 Displaying CCRP which is selected

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Maintenance] - [Sensor Selection/Status] button on the menu.
The [Sensor Selection/Status] dialog box appears.

3 Click on the [Position Status] in the left pain.

3] [2] (1]

Sensor Selection/Status =~ »

Position Status CCRP : CCRP1

Sensor Selection

Position Status

[1] [x] button
Click on this button to close the [Sensor Selection/Status] dialog box.

[2] [Position Status]
The selected CCRP (CCRP1 to 4) is displayed.

For the details of how to change the CCRP, refer to "8.2.2.2 Verifying/Setting CCRP".

[3] Disclosure button
Click on the disclosure button to hide the left pain.
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9.2 General Maintenance

/AN DANGER

Never attempt to check or repair the inside of the equipment.

Checking or repair by an unqualified person may cause a fire or an electric
shock.

Contact our head office, or a nearby branch or local office to request
servicing.

Never remove the cover of this equipment.
Touching the high-voltage section inside will cause an electric shock.

Do not attempt to disassemble or tamper with this equipment.
Otherwise, a fire, an electric shock, or a malfunction may occur.

When conducting maintenance, make sure to turn the main power off.
Failure may result in electric shock.

\
®
!
!

Turn off all the main powers before cleaning the equipment. Especially when
an UPS is used, make sure to turn it off since voltage is still outputted from
the UPS even after the indicator and the ECDIS are turned off. Failure may
result in equipment failure, or death or serious injury due to electric shock.

AWARNING

When conducting maintenance work, make sure to turn off the power so that
the power supply to the equipment is completely cut off.

Some equipment components can carry electrical current even after the
power switch is turned off, and conducting maintenance work may result in
electric shock, equipment failure, or accidents.

For operating this equipment in the good conditions, it is necessary to make the maintenance work as

described below. If maintenance is made properly, troubles will reduce. It is recommended to make

regular maintenance work.

The general maintenance work common among each equipment is as follows.

Clean the equipment.

Remove the dust, dirt, and sea water rest on the equipment cabinet with a piece of dry cloth.

Especially, clean the air vents with a brush for good ventilation.
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9.3 Maintenance on Unit
9.3.1 Display unit

AWARNING

When cleaning the screen, do not wipe it too strongly with a dry cloth.

Also, do not use gasoline or thinner to clean the screen. Otherwise the
screen surface may be damaged.

Dust accumulated on the screen will reduce clarity and darken the video. n
For cleaning it, wipe it with a piece of soft cloth (flannel or cotton). Do not wipe it strongly with a piece of
dry cloth nor use gasoline or thinner.
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9.4 Performance Check

Make performance check on the radar equipment regularly and if any problem is found, investigate it
immediately. Pay special attention to the high voltage sections in inspection and take full care that no
trouble is caused by any error or carelessness in measurement. Take note of the results of inspection,
which can be used effectively in the next inspection work.

Carry out performance check on the items listed in the check list below.

Equipment Item to be checked Criteria

Transmitter-receive | Synchronization LED of Receiver | The LED is lit during operation

Display unit Screen image Can be correctly controlled
Screen operation

9.4.1 Starting Diagnosis functions

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Maintenance] - [Diagnosis] button on the menu.
The [Diagnosis] dialog box appears.

Disclosure button

‘ Diagnosis

Monitor Test
Key Test AllL Red | All Green & All Blue

Sound Test
Light Test Diagnosis function

Vibration Test All White Patternd4d Pattern5

Magnetron Curr.

—— S-57
Memory Check Pattern6 Gray Scale Color
MON Check Lot

The Diagnosis functions are displayed in the left pane.
Click on the disclosure button to hide the left pain.

3 Clickona Diagnosis function to be executed.
The execution dialog of the selected diagnosis function is displayed.
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9.4.2 Confirming the screen status [Monitor Test]

Confirm the screen status.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

2 Click on the [Maintenance] - [Diagnosis] - [Monitor Test] button on the menu.
When the color or pattern of the dialog is clicked on, the color or pattern is displayed on the
screen.
Check the screen status with the display status.

Diagnosis

Monitor Test

Key Test AllRed All Green = All Blue
[Sound Test |

Light Test

'Vibration Test All White Patternd4 | Pattern5

Pattern6 Gray Scale

To reset the display, click the right mouse button on the button that was clicked.
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Pattern list

Pattern button name

Display

All Red

The entire screen is displayed in red.

All Green

The entire screen is displayed in green.
All Blue

The entire screen is displayed in blue.
All White

The entire screen is displayed in white.
Patternd

Displays the pattern for checking the communication quality for VDR.
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Pattern button name

Display

Pattern5

Displays the pattern for checking the communication quality for VDR.

Pattern6

Displays the pattern for checking the communication quality for VDR.

Gray Scale

Displays the grey scale pattern for checking the monitor brightness
adjustment.

Grey scale patterns can be identified with brightness in day/night mode. By
adjusting the monitor brightness to facilitate identification of grey scale
patterns, the optimum brightness can be set. The brightness in night mode
can also be adjusted in the same way.

Use the Day/Night button on the right Tool Bar for switching between the day
and night mode.

For the details of the Day/Night button, refer to "2.2.2 Right Toolbar".
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Pattern button name

Display

S-57 Color Pattern

NN

B 1

A color test pattern of the S-57 chart is displayed.
Cannot be selected under Conning Display.

ARCS Color Pattern

The [ARCS Color Pattern] dialog is displayed.

lor Patterr X

HE = o
EEEEEEEE

A color test pattern of the ARCS chart is displayed.
Cannot be selected under Conning Display.
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9.4.3 Confirming the operation of the operation unit

[Key Test]

Confirm the operation of the keys of the operation unit.

1

Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

Click on the [Maintenance] - [Diagnosis] - [Key Test] button on the menu.

Click on the [Key Test Start] button.

Diagnosis

Monitor Test Key Test Start

Key Test
Sound Test
Light Test
Vibration Test

Magnetron Curr.

Memory Check

MON Check

Key Test window is displayed.

| | | | MULTI

RAIN SEA GAIN

X X DAY SILENC]
Az o USER SILENCE
STBY ~ o Een e

DISP

OFF P1 MOB PANEL USER2

Key Test Stop
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Operate the keys, buttons and dials in the operation unit.
If the performance of the operation unit is normal, the colors of the keys, buttons and dials are
changed.

Click on the [Key Test Stop] button after the operation check.
Returns to the [Diagnosis] dialog box.

9.4.4 Confirming the alert sound [Sound Test]

Confirm the alert sound.

1

Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

Click on the [Maintenance] - [Diagnosis] - [Sound Test] button on the menu.

Click on the [Sound Test Start] button.
A sound test starts. All the available beep sound volumes can be tested by increasing the level
from 0.

BIETelle S

Monitor Test Sound Test Start

Key Test . i :
! Playing the following volume

Sound Test

Light Test

Vibration Test

Magnetron Curr.

Memory Check
MON Check
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9.4.5 Testing the brightness of LED [Light Test]

Test the brightness of LED.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

Click on the [Maintenance] - [Diagnosis] - [Light Test] button on the menu.

Click on the [Light Test Start] button.
A LED brightness test starts. All the available brightness levels can be tested by increasing the
level from 0.

Diagnosis

Monitor Test Light Test Start

NEAIESY Lighting the following light
Sound Test

Light Test

Vibration Test

Magnetron Curr.

Memory Check

MON Check
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9.4.6 Testing the motor [Vibration Test]

Test a motor.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

Click on the [Maintenance] - [Diagnosis] - [Vibration Test] button on the menu.

Click on the [Vibration Test] button.
The motor continuously vibrates while the button is pressed. When the button is released,
vibration stops.

Diagnosis

e R Vibration Test

Key Test
Sound Test
Light Test
Vibration Test

Magnetron Curr.

Memory Check

MON Check
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9.4.7 Checking the memory [Memory Check]

Check the memory.

1 Click on the [Menu] button at the bottom left corner of the screen.
The menu is displayed.

Click on the [Maintenance] - [Diagnosis] - [Memory Check] button on the menu.

Click on the [Memory Check Start] button.
Memory checking starts and the checking result is displayed on the [Result] list.

Diagnosis

Monitor Test Memory Check Start

Key Test
o -
Sound Test Results

Light Test -- Memory Test No.1:0K

-- Memory Test No.2:0K
-- Memory Test No.3:0K
-- Memory Test No.4:0K
-- SSD Test No.1:NG
SSD Test No.2:NG
MON Check SSD Test No.3:NG
SSD Test No.4:NG
Memory Check End

Vibration Test

Magnetron Curr.

Memory Check
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9.5 Replacement of Major Parts

The system includes parts that need periodic replacement. The parts should be replaced as scheduled.

Use of parts over their service life may cause a system failure.

ACAUTION

Turn off the main power source before inspecting and replacing parts.
Otherwise, an electric shock or trouble may be caused.

The liquid crystal monitor shall be replaced by two more persons. If only
one person does this work, he may drop the LCD, resulting in injury.

9.5.1 Parts required for periodic replacement

Here are parts required for periodic replacement.

Part type Name nzer‘r:te Interval Replacement kit type
NWz-207 19inch monitor | FAN 40,000 hours 7ZYNA4004
NWZz-208 26inch monitor | FAN 40,000 hours 7ZYNA4005
NBD-913 Power supply FAN 100,000 hours 7ZYNA4007
unit
QUINT-BAT/24DC/3.4AH | DC UPS Battery | 30,000 hours QUINT-BAT/24DC/3.4AH
NDC-1590 Central control | FAN 40,000 hours 7ZYNA4006
unit
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9.6 Software Update

This section describes software update of this equipment.

Note

When software update starts, the tasks that are active are automatically terminated. Complete the
necessary operation such as saving of settings prior to the start of update.

1 Set the CD/DVD or USB flash memory containing the update data.

2 Click on the [Menu] button at the bottom left corner of the screen.

The menu is displayed.

3 click [Maintenance] - [Software Update] on the menu.

Menu >  Maintenance >

B gs;:lTlme/Tlme X System Information X Operating Time

- > Diagnosis > SoftwareUpdate >$ DVD Drive Cleaning

The [Software Update] dialog box appears.

4 Click on the [Software Update] button.

1/1

N Sensor Selection/
™ Status
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A file selection dialog box appears.

Software Update

Select update file.
Current Version:01.00.103
Drive &UFD 2.0 Silicon-Power4G
- i UFD 2.0 Silicon-Pow Name - Modified
w MFD_MFD_01.00.[MFD_01.00.103.exe  2014-04-08 13:22
mfd_0100103_bh36... 2014-04-08 13:23

*

File Name MFD_01.00.103.exe

File Type EXE File(*.exe)
OK Cancel

From the [Drive] combo box, select the drive where the updating data is stored.

From the file list, select the file MFD_xx.xx.xxx.exe.
MFD_xx.xx.xxx.exe is displayed in [File name].

7 Click the [OK] button.
The update content confirmation dialog box appears.

Software Update

Current Version:
Update Version:

-

Do you continue?

NOTICE:

This application needs to reboot for
updating.

Back 0] 4 Cancel
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8 cConfirm the contents and click [OK].
Installation of the update is started and the following screen is displayed.

System

Installing the software..

Wait for some time until the installation is completed.

Note
During installation, this equipment may reboot by itself..

When the installation is completed, the following screen is displayed.

System

Installation succeeded.
Turn the power off and on again.

9 Turn off the power of this equipment.
10 Restart this equipment.

11 start the Conning display and then confirm that the software version number has been
updated correctly by the [Software] tab in [Maintenance] - [System Information].
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9.7 Updating Help Data

This section describes updating of help data of this product.

Note
» Help data is classified to the data for RADAR, data for ECDIS, and data for Conning Display. To

display help information on each of the RADAR screen, ECDIS screen, and Conning Display
screen, install the help data for each display.

+ When Help update starts, currently active tasks are terminated automatically. Complete the
necessary operations, such as saving the settings, before the start of update.

Set the CD/DVD or USB memory where update data is stored.

2 Click the [Menu] button on the Left Tool Bar.
A menu is displayed.

3 click [Maintenance] - [Software Update].

Menu > | Maintenance > 1/1 >4

Date/Time/Time . : : Sensor Selection/
L L L L
- N Zone 2% System Information = Operating Time e Status

- > Diagnosis > SoftwareUpdate >$ DVD Drive Cleaning

The [Software Update] dialog is displayed.
4 Click the [Help Install] button.

Software Update

Software Update

Help Install
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A file selection dialog is displayed.

[Drive] combo box

Help Install

Drive &BUFFALO RUF2-HSCTV (E:) -~

- B BUFFALO R v Name
& 140110 ||V MFD_HELP_ECD_EN_0100.cab

01 AQ
201401 M TMFD HELP_RAD_EN_0100.cab
201485

Conning
CONNIN
ENC3.1.
FM3Com
gdi@787
HW_ID_

[nstall

Folder tree File list

Select the drive containing update data from the [Drive] combo box.

Select the folder containing update data from the folder tree and check the file to be
updated from the file list.

Click the [Install] button.
Installation starts and the following screen is displayed.

Help Install

**% Installing.

Cancel

Wait until installation is completed.
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When installation is completed, the following screen is displayed.

Help Install

Install completed.

MFD_HELP_ECD_EN_0100.cab
MFD_HELP_RAD_EN_0100

8 Click the [OK] button.

Memo
» When the [Cancel] button is clicked during installation, installation of subsequent files is
cancelled after the installation of the file that is currently being installed is completed.
* When the selected update file already exists, the following screen is displayed.

Help Install
Already Installed.

MFD_HEL
MFD_HELP_RAD_EN_@1

[nstall

End the operation by clicking on the [Cancel] button.
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9.8 Data Backup/Restore

ACAUTION

Do not turn off the power supply during backup/restore.

Otherwise, a function fault occurs, leading to the possibility of an accident.

Do not back up data during sailing.
To start backup data, the Conning Display application must be terminated.
Otherwise, observation using the Conning Display is disabled, leading to the

possibility of an accident.

9.8.1 Backing up data

To maintain customer data, back up the data regularly by using the following procedure.
Connect an external medium such as USB memory for backup.

1 Press the Power supply button of the operation unit.
The power supply button is lit. Then, the task menu is displayed.

2 Click on the [Data Backup/Restore] button in the task menu.

- - | B

Route Planning Navigation Data
Route Monitoring Monitoring

(ECDIS) (Conning Display)

Collision Avoidance
(RADAR)

BELE!
Maintenance Backup/Restore

Playback

Password
EEEEKERKLR

The [Backup/Restore] dialog is displayed.
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3 cClick on the [Data Backup] tab.
Backup/Restore

Data Backup Data Restore

Main Drive D:>> E: Drive selection combo box

Data Type All [Data Type] combo box

Start

[Start] button

4 select a drive of the data backup destination from the drive selection combo box.

Select the type of the data to be backed up in the [Data Type] combo box.
All: The entire user data is backed up.
Except Charts: The user data excluding chart data is backed up.

Note
When All is selected and there are many charts, backup operation may take a long time.

6 Click on the [Start] button.
A confirmation dialog is displayed.

System

Start Backup. Are you sure?

0] 4 Cancel

7 Click on the [OK] button.
Copying of data to the backup destination that is selected in the drive selection combo box
starts.

Note
Do not perform any other operations until backup is completed. Otherwise, backup may fail.
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9.8.2 Restoring backed up data

Use the following procedure to restore backed up data into this equipment.
Connect the external medium (USB memory, etc.) in which backup data has been saved.

1 Pressthe power supply button of the operation unit.
The power supply button is lit. Then the task menu is displayed.

2 Click on the [Data Backup/Restore] button in the task menu.

oute Planning Navigation Data
Route Monitoring Monitoring
(ECDIS) (Conning Display)

Collision Avoidance
(RADAR)

Chart Data

SoEne Maintenance Backup/Restore

Password
E g e

The [Backup/Restore] dialog is displayed.
3 Click on the [Data Restore] tab.
Backup/Restore
Data Backup Data Restore

Main Drive D:<< E: Drive selection combo box

Data Type All [Data Type] combo box

Start

[Start] button

4 select the drive in which backup data has been saved from the drive selection combo
box.

5 select the type of the data to be restored in the [Data Type] combo box.
All: The entire user data is restored.
Except Charts: The user data excluding chart data is restored.
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6 Click on the [Start] button.
A confirmation dialog is displayed.

System

Start Restore. Are you sure?

OK Cancel

7 Click on the [OK] button.
Restoration of data from the drive that was selected from the drive selection combo box to the
hard disk of this equipment starts.
If data already exists in the hard disk, an overwriting confirmation dialog is displayed.
Click on the [OK] button to start the restoration.

Note

» Do not perform any operation until restoration is completed. If some operation is
performed, restoration may fail.

+ If backup is executed while enough free space is not available in the USB memory, the
"Error" message is displayed. Secure free space before executing backup. For the size
of the data to be backed up, check the "Usage" column in the "File Information"” list in
"8.3.2 Managing storage". (For instance, when the AVCS chart for the entire world is
installed, the size will be about 11GB.)

Memo
If the data to be restored is incompatible with this equipment, the following dialog is
displayed and data is not restored.

System

OK

Cancel the task by clicking on the [OK] button.
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9.9 Recovery of the Images in the C Drive

ACAUTION

The backup power supply (DC power supply, etc.) of the equipment must be

connected when recovery of the C drive image is performed. If the power supply

stops during recovery, an equipment activation fault occurs, causing an accident.

Do not turn off the power supply during recovery of the C drive image.

Otherwise, equipment malfunction occurs, possibly causing an accident.

The operating system (OS) of this equipment runs on the C drive.
The contents of the C drive including the images are stored in the D drive.
When the OS operation on the C drive becomes unstable, the images in the C drive can be written

back from the D drive.

Note
When the images in the C drive are written back, the information relating to C-MAP is cleared.
After writing back of images, re-register the database and licence of C-MAP and perform update
as required. (Required when the equipment has the ECDIS function or chart radar function
available as an option.)

The flow of writing back of images in the C drive is as follows.

Start this equipment with the OS in the D drive
"9.9.1 Starting the equipment with the OS in the D drive"

Execute the SSD recovery tool.
"9.9.2 Executing the SSD recovery tool"
Start the equipment with OS in the C drive.
"9.9.3 Starting the equipment with the OS in the C drive (Software
automatic recovery)"
Re-set C-MAP.
"9.9.4 Re-setting C-MAP"

!

Terminate recovery.
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9.9.1 Starting the equipment with the OS in the D
drive

Start this equipment with OS in the D drive by using the following procedure.

1  Turn on the power supply of this equipment while pressing the [SILENCE] key and the
[ZOOM OUT] key of the trackball operation unit simultaneously.
When the equipment starts, the following screen is displayed.

System Disk Recovery

Recovery Disk Number B

‘ Disk Recovery ‘

| Disk Backup |

| Shutdown |

| Individual operation(for Manufacture) |

The SSD recovery tool can be executed in this state.

9.9.2 Executing the SSD recovery tool

Write back the images in the C drive by executing the SSD recovery tool.

1 Click on the [Disk Recovery] button on the screen that is displayed at activation from
the D drive.

The following screen is displayed.

Disk recovery

Are you sure you want to recover the disk by this file?

CAC Drive Image\CDD-752_61.00.00000000.img

[ Change File

DK || Cancel |

2 Selectan image file to be written back to the C drive.
Normally, proceed with the next step with the image file that is currently displayed.

To specify a different image file, select a required image file from the list that is displayed by
clicking on the [Change File] button.
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Note
Since the equipment is started from the D drive, the usual C drive is displayed as the D drive
and the usual D drive is displayed as C drive. Therefore, note this point when selecting an
image file.

3 Click on the [OK] button.
Image file write-back operation starts.

Note
Do not perform any operation until write-back operation is completed. If any operation is
performed, the image write-back operation may fail.

At termination of recovery, the following screen is displayed.

[ System Disk Recovery @

I--"'_"‘--I The system restart the program as system recovery was

¥ completed. Change it to boot from the disk that has been
recovered.

OK

9.9.3 Starting the equipment with the OS in the C
drive (Software automatic recovery)

Start this equipment with the OS that is written back to the C drive.

1 Click on the [OK] button on the screen that is displayed at termination of write-back

operation.
The equipment starts from the C drive and, at the same time, the applications and various OS
settings on the C drive are recovered automatically.

When recovery starts, the following screen is displayed for several seconds.

Start the recovery of the software...
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Note
This equipment restarts during the recovery operation. Do not perform any other operations
until the recovery is completed.
Otherwise, recovery may fail, possibly causing an accident.

After completion of recovery, the following screen is displayed.

Recovery succeeded.
Turn the power off and on again.

C—MAP charts has been initialized.
Set up the setting of the C—MAP
charts.

2 Turn off the power supply of this equipment by pressing the power button of the
operation unit.

9.9.4 Re-setting C-MAP

Re-set the settings of C-MAP by restarting this equipment.
Re-register the database and the licence.
Update as required.
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Section 10 Failures and After-Sale
Services

10.1 Failure Detection

Semiconductor circuits can be considered to be almost free from defective semiconductors and/or
performance deterioration except when there are design and inspection errors, or external and human
induced causes. Generally, the causes of comparably frequent failures include line disconnection due
to humidity of the high resistor, failure of the variable resistor as well as contact failures of switches and
relays.

In addition to faulty parts, faulty adjustments (especially faulty tuning) or faulty maintenance (especially
faulty cable contact) occasionally make up causes of failures; thus, it is effective to reinspect or
readjust these items.

10.1.1 About alerts

Failures can be detected from alerts.
For details on alerts, please refer to "Appendix B, Alert List."

10.1.2 Alert description

For a description of alerts to be displayed, please refer to "Appendix B, Alert List."

10.1.3 Fuse inspection

Because there is a specific cause for any fuse meltdown, it is necessary to check the related circuits
even if there is no abnormality after changing a fuse. However, please give consideration that the fuse
meltdown characteristics vary significantly. The following table shows a list of the fuses used in this

unit.
List of Fuses Used
Fuse Name Name of Placement | Count Part Spec. Change Kit Model
Model Used Location Name
Blade fuse NBD-913 Power 2 32VDC 15Apart | 1015(5ZFCK00008)
(Auto fuse) supply unit
Blade (mini) fuse | NQE-1143 JB 1 32VDC 15A part | 1215(5ZFCK00017)
(Auto fuse)
Blade (mini) fuse 2 32VDC 3A part 1203(5ZFCK00016)
(Auto fuse)
Glass fuse 4 250V 0.5A part MF51NR 250V
0.5(5ZFGD00019)
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10.2 Countermeasures for Failures

10.2.1 Repair circuit block

Repair Circuit Block (JAN-9202)

Location Circuit Block Name Model Name Remarks
Display unit Display unit NwWZz-208
Display unit FAN kit for changing the 26inch MNU 7ZYNA4005
Trackball operation unit Trackball unit CCK-1060
Trackball operation unit Operation circuit A CCK-1050
Trackball operation unit Operation circuit SW CCK-1069
Trackball operation unit Operation circuit CN CCK-1070
Trackball operation unit Interior of the Trackball operation unit CMD-1103
Keyboard operation unit Operation circuit B CCK-1059
Keyboard operation unit Keyboard unit CCK-1061
Keyboard operation unit Interior of the Keyboard operation unit CMD-1106
Power supply unit Power supply unit NBD-913
Power supply unit FAN kit for changing the PSU TZYNA4007
Central control unit CCU repair kit NZC-1590
Central control unit FAN kit for changing the CCU 7ZYNA4006
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Repair Circuit Block (JAN-7202)

Location Circuit Block Name Model Name Remarks
Display unit Display unit NWz-207
Display unit FAN kit for changing the 26inch 7ZYNA4004
MNU
Trackball operation unit Trackball unit CCK-1060
Trackball operation unit Operation circuit A CCK-1050
Trackball operation unit Operation circuit SW CCK-1069
Trackball operation unit Operation circuit CN CCK-1070
Trackball operation unit Interior of the Trackball operation CMD-1103
unit
Keyboard operation unit Operation circuit B CCK-1059
Keyboard operation unit Keyboard unit CCK-1061
Keyboard operation unit Interior of the Keyboard operation | CMD-1106
unit
Power supply unit Power supply unit NBD-913
Power supply unit FAN kit for changing the PSU TZYNA4007
Central control unit CCU repair kit NZC-1590
Central control unit FAN kit for changing the CCU 7ZYNA4006
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10.3 Troubleshooting

When this equipment does not operate correctly, check the following points before asking for repairs.

Consult with your nearest subsidiary company, branch office, or sales office if the problem does not get

solved even after checking and correcting these points, or if there are any abnormally locations other

than the following items.

Symptom

Cause

Action

The power is not supplied.
Alternatively, the equipment
does not start even if the Power
button of the operation unit is
pressed.

The AC or DC power supply is
not connected.

Connect the AC or DC power
supply.

The breaker at the front of the
power supply unit (NBD-913) is
not set to ON.

Set the breaker to ON by
pushing up the lever of the
breaker.

The AC or DC power supply is
not input within the specified
voltage range.

Connect the AC or DC power
supply within the specified
voltage range.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The power supply unit
(NBD-913) is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

The operation unit (NCE-5605)
is faulty.

Make a request to the distributor
for repair.

The power is not supplied to the
monitor.

The display unit is not activated.

Activate the display unit.

The internal wiring is faulty.

Make a request to the distributor
for repair.

Display unit
(NWZ-208/NWZ-207) is faulty.

Make a request to the distributor
for repair.

Although the power is supplied
to the monitor, the screen is not
displayed.

The brightness of the monitor is
set to the minimum level.

Adjust the brightness of the
monitor to the appropriate level.

The internal wiring is faulty.

Make a request to the distributor
for repair.

Display unit
(NWZ-208/NWZ-207) is faulty.

Make a request to the distributor
for repair.

The brightness of the monitor
cannot be adjusted.

The display unit
(NWZ-208/NWZ-207) is faulty.

Make a request to the distributor
for repair.

The trackball or the option
keyboard cannot be operated.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The display unit
(NCE-5605/NCE5625) is faulty.

Make a request to the distributor
for repair.

The trackball does cannot be
moved smoothly.

The trackball is dirty.

Clean the trackball.
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Symptom

Cause

Action

Although the power is supplied
and the screen is displayed, the
display is frozen, disabling
processing to advance up to
display of the task menu.

The central control unit
(NDC-1590) is abnormal.

Make a request to the distributor
for repair.

Some task menus cannot be
selected.

The device license has not been
installed.

Install the license of the device
to be used.

The cursor is not displayed
correctly.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

Characters/symbols are not
displayed correctly.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

Position information (GPS) is
not displayed.

The communication is not set
correctly.

Set the communication correctly.

The power supply for the GPS
equipment is not turned on.

Turn on the power supply for the
GPS equipment.

The GPS equipment does not

Check the state of the GPS

perform positioning. equipment.
The connection with the GPS Check the connection with the
equipment is abnormal. GPS equipment.

When GPS equipment is
connected to the serial LAN
interface circuit, check if the
LED of the corresponding port is
lit at data reception.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.
(Case where the GPS
equipment is connected to the
serial-LAN interface circuit)

Turn on the power supply for the
serial-LAN interface circuit.

The serial-LAN interface circuit
(CMH-2370) is faulty.

(Case where the GPS
equipment is connected to the
serial-LAN interface circuit)

Make a request to the distributor
for repair.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

The azimuth of the Gyro
compass is not displayed.
Alternatively, the azimuth
rotation direction is not
displayed correctly.

The communication is not set
correctly.

Set the communication correctly.

The power supply for the Gyro
compass equipment is not
turned on.

Turn on the power supply for the
Gyro compass equipment.
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Symptom

Cause

Action

The azimuth of the Gyro
compass is not displayed.
Alternatively, the azimuth
rotation direction is not
displayed correctly.

The connection with the Gyro
compass equipment is
abnormal.

Check the connection with the
Gyro compass equipment.
When gyro compass equipment
is connected to the serial LAN
interface circuit or gyro interface
circuit, check if the
corresponding LED is lit at
signal reception.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.
(Case where the Gyro compass
equipment is connected to the
serial-LAN interface circuit)

Turn on the power supply for the
serial-LAN interface circuit.

The serial-LAN interface circuit
(CMH-2370) is faulty.

(Case where the Gyro compass
equipment is connected to the
serial-LAN interface circuit)

Make a request to the distributor
for repair.

The Gyro interface
circuit(CMJ-554) is not set
correctly

(Case where the Gyro compass
equipment is connected to the
Gyro interface circuit)

Set the Gyro interface circuit
correctly according to the Gyro
compass equipment.

The Gyro interface circuit
(CMJ-554) is faulty.

(Case where the Gyro compass
equipment is connected to the
Gyro interface circuit)

Make a request to the distributor
for repair.

The fuse of the Gyro interface
circuit (CMJ-554) is blown out.

Replace the fuse of the Gyro
interface circuit.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

Log is not displayed or the
values are not displayed
correctly.

The communication is not set
correctly.

Set the communication correctly.

The power supply for the log
equipment is not turned on.

Turn on the power supply for the
log equipment.

The connection with the log
equipment is abnormal.

Check the connection with the
log equipment.

When log equipment is
connected to the serial LAN
interface circuit or gyro interface
circuit, check if the
corresponding LED blinks at
signal reception.
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Symptom

Cause

Action

Log is not displayed or the
values are not displayed
correctly.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.
(Case where the log equipment
is connected to the serial-LAN
interface circuit).

Turn on the power supply for the
serial-LAN interface circuit.

The serial-LAN interface circuit
(CMH-2370) is faulty.

(Case where the log equipment
is connected to the serial-LAN
interface circuit).

Make a request to the distributor
for repair.

The Gyro interface circuit
(CMJ-554) is not set correctly.
(Case where the log equipment
is connected to the Gyro
interface circuit).

Set the Gyro interface circuit
correctly according to the log
equipment.

The Gyro interface circuit
(CMJ-554) is faulty.

(Case where the log equipment
is connected to the Gyro
interface circuit).

Make a request to the distributor
for repair.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

Rudder angles are not
displayed.

Alternatively, the values are not
displayed correctly.

The communication is not set
correctly.

Set the communication correctly.

The power supply for the rudder
angle indicator is not turned on.

Turn on the power supply for the
rudder angle indicator.

The connection with the rudder
angle indicator is abnormal.

Check the connection with the
rudder angle indicator.

When a rudder angle indicator is
connected to the serial LAN
interface circuit, check if the
LED of the corresponding port is
lit at data reception.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.
(Case where the rudder angle
indicator is connected to the
serial-LAN interface circuit or
the rudder angle indicator is
connected to the analog option
circuit)

Turn on the power supply for the
serial-LAN interface circuit.
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Symptom

Cause

Action

Rudder angles are not
displayed.

Alternatively, the values are not
displayed correctly.

The serial-LAN interface circuit
(CMH-2370) is faulty.

(Case where the rudder angle
indicator is connected to the
serial-LAN interface circuit or
the rudder angle indicator is
connected to the analog option
circuit)

Make a request to the distributor
for repair.

The analog option circuit
(CMJ-560) is not set correctly.
(Case where the rudder angle
indicator is connected to the
analog option circuit)

Set the analog option circuit
correctly according to the rudder
angle indicator.

The analog option circuit
(CMJ-560) is faulty.

(Case where the rudder angle
indicator is connected to the
analog option circuit)

Make a request to the distributor
for repair.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

Wind direction/wind speed
(anemoscope/anemometer)
data is not displayed.

The communication is not set
correctly.

Set the communication correctly.

The power supply for the
anemoscope/anemometer is not
turned on.

Turn on the power supply for the
anemoscope/anemometer.

The connection with the
anemoscope/anemometer is
abnormal.

Check the connection with the
anemoscope/anemometer.
Check if the LED of the
corresponding port of the serial
LAN interface circuit is lit at data
reception.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.

Turn on the power supply for the
serial-LAN interface circuit.

The serial-LAN interface circuit
(CMH-2370) is faulty.

Make a request to the distributor
for repair.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

Water depth values are not
displayed.

The communication is not set
correctly.

Set the communication correctly.

The power supply for the echo
sounder is not turned on.

Turn on the power supply for the
echo sounder.
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Symptom

Cause

Action

Water depth values are not
displayed.

The connection with the echo
sounder is abnormal.

Check the connection with the
echo sounder.

Check if the LED of the
corresponding port of the serial
LAN interface circuit is lit at data
reception.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.

Turn on the power supply for the
serial-LAN interface circuit.

The serial-LAN interface circuit
(CMH-2370) is faulty.

Make a request to the distributor
for repair.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

Sensor signals are not
displayed.

The communication is not set
correctly.

Set the communication correctly.

The power supply for the sensor
equipment is not turned on.

Turn on the power supply for the
sensor equipment.

The connection with the sensor
equipment is faulty.

Check the connection with the
sensor equipment.

Check if the LED of the
corresponding port of the serial
LAN interface circuit is lit at data
reception.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.

Turn on the power supply for the
serial-LAN interface circuit.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The display unit such as the
serial-LAN interface circuit
(CMH-2370), analog option
circuit (CMJ-560), and central
control unit (NDC-1590) is faulty.

Make a request to the distributor
for repair.

Contact signals are not output.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.
(Case where contact signal
output is acquired from the
serial-LAN interface circuit)

Turn on the power supply for the
serial-LAN interface circuit.

The serial-LAN interface circuit
(CMH-2370) is faulty.

(Case where contact signal
output is acquired from the
serial-LAN interface circuit)

Make a request to the distributor
for repair.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.
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Symptom

Cause

Action

Contact signals are not output.

The power supply for the
serial-LAN interface circuit
(CMH-2370) is not turned on.
(Case where contact signal
output is acquired from the
serial-LAN interface circuit)

Turn on the power supply for the
serial-LAN interface circuit.

The serial-LAN interface circuit
(CMH-2370) is faulty.

(Case where contact signal
output is acquired from the
serial-LAN interface circuit)

Make a request to the distributor
for repair.

The internal wiring is faulty.

Make a request to the distributor
for repair.

The central control unit
(NDC-1590) is faulty.

Make a request to the distributor
for repair.

UPS does not operation.

The connection with UPS is
faulty.

Check the connection with UPS.

UPS is not set correctly.

Set UPS correctly.

The UPS battery is extremely
depleted.

Replace the battery.

[Note]

At the battery replacement,
make a request for the work to
the specialized service staff.
During the replacement, turn off
the corresponding power supply
breaker in the ship. Otherwise,
an unexpected accident may
occur.

The internal wiring is faulty.

Make a request to the distributor
for repair.

UPS is faulty.

Make a request to the distributor
for repair.

The following popup window is
displayed.

System has detected an error.
Turn the power off and on again.

A communication error
occurred.

Close the popup window and
after checking that there is no
problem even if the power of this
equipment is turned off, turn off
the power and turn on again.
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10.4 After-Sale Services

10.4.1 About the retaining period of service parts

The retaining period of the performance-critical parts for servicing this product (parts required to
maintain the functionality of the product) is 10 years after the discontinuation of production.

10.4.2 When requesting a repair

If you suspect a failure, please read "10.3 Troubleshooting" thoroughly first and check the unit again.
If you still detect abnormality, stop using the product and contact your sales representative, our sales

department, nearest branch office or sales office.

* Repair during the warranty period: |If a failure occurs in the course of using the product correctly
according to the explanations and instructions in the Instruction Manual, your sales representative
or our company shall repair the product at no charge. However, repairs of failures caused by misuse,
negligence, or act of God such as natural disasters and fire shall be chargeable.

» If the warranty period has expired: If functionality can be recovered by repair, repair shall be
made by the request of the customer for a fee.

» Please provide the following information:

- Product name, model name, manufacturing date, serial number

- Description of abnormality (as detail as possible) (Please refer to the next page "Radar Failure
Checklist.")

- Business name or organization name, address, phone number

10.4.3 Recommendation of inspection and
maintenance

Although it depends on the usage state, performance may deteriorate by change in parts over time,
Separately from regular care, inspection and maintenance are recommended.

Regarding inspection and maintenance, please contact your sales representative, our sales
department, nearest branch office or sales office.

Please note that there is a charge for inspection and maintenance.

If you have questions regarding after-sale services, please inquire your sales representative,
our sales department, nearest branch office or sales office.
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Conning Display Failure Checklist

[Important] Before ordering a repair, please check and fill in the following items and then contact the
applicable repair office.
If there are unknown items, please contact the ship and fill in as accurate as possible.

Ship Name: Phone: Fax:

Integrated Radar Model Name: JMR- Serial Number:
(Please fill in all digits accurately.)

(1) Check the following items sequentially and circle either YES or NO for each item.
If none is applicable, please write down the specific reason in No. (7) Others.

No. Check Item Result
(1) | The power turns ON. (The light of the operation unit illuminates.) YES | NO
(2) | The starting screen is displayed. YES | NO
(3) | The task screen is displayed. YES | NO
(4) | The Conning Display screen is displayed. YES | NO
(3) | Operation using the trackball or keyboard is possible. YES | NO
(6) | The various sensors are displayed normally. YES | NO
(7) | Others (error messages, etc.)
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10.4.4 Extending the functions

The functions that are available for this equipment can be extended as an optional extra.
To extend a function, new license information (file) must be obtained and imported to this equipment.
For function extension, please request to our Sales Department or our branch office, sales office, or

agent near your premises.

10.4.4.1 Importing License information
Import the license information that was obtained (license file) to this equipment via the USB memory.
Connect the USB memory in which the license information is stored.

1 Press the Power button of the operation unit.
The Power button is lit. After a while, a task menu is displayed.

Task Menu

Route Planning Navigation Data
Route Manitoring Monitoring
(ECDIS) (Conning Display)

Collision Avoidance
(RADAR)

Chart
Playback .
d Maintenance

Password .
sk e e e ek Password Input

section

2 Click on the password input section.
A password input dialog is displayed.

3 Enterthe password, 9380.
The [Import License] dialog is displayed.
Import Licence X

Please select a licence file to be imported.
Browse
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4 Click on the [Browse] button.

The [System] dialog is displayed.
System X

Select drive and data path manually.

Drive &BUFFALO USB Flash ~
» m INI

W LicenseChange

v e | Aanhanls A

4

File Name  JRCMFD.lcn [File Name] combo box
oK Cancel

5 Select the name of the license file (example: JRCMFD.Icn) that is stored in the USB
flash memory from the [File Name] combo box and click on the [OK] button.
The [System] dialog is closed.

6 Click on the [Import] button.
When import is completed, a confirmation dialog is displayed.
Close the dialog by clicking on the [OK] button.

7 Close the [Import License] dialog by clicking on the [x] button and return to the task
menu.
In this case, a new license is adopted.
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Section 11 About Disposal

11.1 About Disposal of This Unit

When disposing of this equipment, follow the regulations and/or rules of the local regulatory authority

which has control over the location of disposal.

11.2 Chinese Version RoHS

FREAEWRBTENEREEE
(Names & Content of toxic and hazardous substances or elements )
JE 2044 (Type): JAN-9202, JAN-7202 Series 4 ¥ (Name): Conning Display
B EMREITR
2R (Toxic and Hazardous Substances and Elements)
(Part name) 4 S 4 A |z | ek
(Pb) (Hg) (Cd) (Cré6+) (PBB) (PBDE)
FEMAEEE (Inboard Unit)
- BoR3EHE (Display Unit)
- B4 2EE (OperationUnit) X X O X O O
- E5abHE
(Central Control Unit)
A% %% (Peripherals)
- 1%&4% (Options)
- B2k (Cables) X X @) X @) @)
- F /it (Documennts)

O: FoRiZA A TV AL I YA E R B B ITESI/T 11306-2006 ARiERLE IR B R LT .
(Indicates that this toxic, or hazardous substance contained in all of the homogeneous materials for this
part is below the requirement in SJ/T11363-2006.)

x: FORGAHRA FWIEDIEZIA RS — SO R b & B Y ST/T11363-2006 b AERLE AR 2K
(Indicates that this toxic or hazardous substance contained in at least one of the homogeneous materials
used for this part is above the limit requirement in SJ/T 11363-2006.)
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Section 12 Specifications

12.1 JAN-9202

GENERAL SPECIFICATION JAN-9202

Display 26inch Wide LCD

Operation Cursor and keys

External media General purpose USB port x 1

Ambient Condition

, -15°C to 55°C
- Operating Temperature
Ambient Condition
. - +40°C, 93%

- Relative Humidity

Ambient Condition 2 to 13.2Hz: Amplitude £1mm +10%

- Vibration 13.2 to 100Hz: Acceleration 7m/s?

Power Supply Input 100 to 115VAC, 50/60Hz 1
220 to 240VAC, 50/60Hz 1
24VDC

Power Consumption Approx. 240VA typical

(DC:72W at AC power outage)
Power Supply Voltage Fluctuation AC input £10%
DC input +30%, -10%

Central Control Unit NDC-1590
Power Supply Unit NBD-913
Trackball Operation Unit NCE-5605

Central Control Unit

Display

Display NWZ-208
optionpit .
Keyboard Operation Unit NCE-5625
Operation unit desktop frame rack CWB-1596
Large tray CwWB-1593
Junction Box NQE-1143
Sensor LAN Switch Unit NQA-2443

26inch DESKTOP FRAME RACK CWB-1595
26inch DISPLAY UNIT MOUNT KIT CWA-246

SAFE DISTANCE FOR STANDARD COMPASS

Display unit 2.4m
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12.2 JAN-7202

GENERAL SPECIFICATION JAN-7202

Display 19inch LCD

Operation Cursor and keys

External media General purpose USB port x 1

Ambient Condition

, -15°C to 55°C
- Operating Temperature
Ambient Condition
. . +40°C, 93%

- Relative Humidity

Ambient Condition 2 to 13.2Hz: Amplitude £1mm +10%

- Vibration 13.2 to 100Hz: Acceleration 7m/s”

Power Supply Input 100 to 115VAC, 50/60Hz 1
220 to 240VAC, 50/60Hz 1
24VDC

Power Consumption Approx. 200VA typical

(DC:72W at AC power outage)
Power Supply Voltage Fluctuation AC input £10%
DC input +30%, -10%

Central Control Unit

Central Control Unit NDC-1590
Power Supply Unit NBD-913
Trackball Operation Unit NCE-5605
Display NWz-207
option

Keyboard Operation Unit NCE-5625
OPERATION UNIT DESKTOP

FRAME RACK CWB-15%
Large tray CWB-1593
Junction Box NQE-1143
Sensor LAN Switch Unit NQA-2443

26inch DESKTOP FRAME RACK CWB-1594
26inch DISPLAY UNIT MOUNT KIT  CWA-245

SAFE DISTANCE FOR STANDARD COMPASS

Display unit 2.4m
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12.3 Display Unit

FUNCTIONAL SPECIFICATION

Display mode Sail mode/Docking mode/Custom mode
Wind direction and speed display
H UP/N UP
mode
Water depth/Rudder angle/Heading/Heading + Rudder
Trend graph . .
angle/Engine (propeller) revolution
Heading
Ship position
Geodetic positioning system
Time
COG/SOG
STW
ROT
Water depth
Wind direction/wind speed

Current direction and speed Calculated from own ship's COG/SOG
Engine (propeller) revolution Max. 2 units

Engine telegraph Max. 2 units

Rudder angle Max. 2 units

Side thruster Max. 5 units (Bow: 3 units, Stern: 2 units)
Azimuth thruster Max. 2 units

Route information

Autopilot information

Air temperature

Water temperature

Atmospheric pressure

Humidity
Self-diagnosis function Present
Remote maintenance function Present

Upgrading to multi-function display =~ Possible
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Ship heading

Course

Geodetic positioning system
Date information

COG/SOG

Ship speed through water
Turning speed

Water depth

Wind direction/wind speed

Engine (propeller) revolution

Engine telegraph
Rudder angle

Side thruster

Azimuth thruster

Route information

Auto pilot information
Air temperature
Water temperature
Atmospheric pressure
Humidity

Alert

THS > HDT (over 40Hz)
GGA > RMC > RMA > GNS > GLL

DTM

ZDA

RMC > RMA > VTG

VBW

ROT

DPT > DBS > DBK > DBT

MWV > MWD

Serial: RPM(Response), PRC(Order)
Analog: XDR

ETL

Serial: RSA(Response), ROR(Order)
Analog: XDR

Serial: TRD(Response), TRC(Order)
Analog: XDR

TRD(Response), TRC(Order)
ECDIS information notification (PJRC, EIFO0/PJRC,

EIS00/WPL)

ECDIS information notification (PJRC, EIF00)
MTA > MDA

MTW > MDA

MMB > MDA

MHU > MDA

ACK, ALR

Watch Timer Reset
Remote maintenance data
Alert

EVE
JRC format
ACK, ALR

Visual range

1.05m from the center of display

i. The measuring precision of the speed sensor complies with IMO Resolution MSC.96(72).
The measuring precision of the GPS sensor complies with IMO Resolution MSC.112(73).
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12.4 Central Control Unit

GENERAL SPECIFICATION

CPU
Main Memory
JRC ASIC

Dimension
Mass
FAN

Operational Temperature

Operational Humidity
Vibration

EMC

Ingress Protection Rating

DVI-D
VGA
IEC61162-450

IEC61162-1

IEC61162-2

LAN

Dry Contact Output
Normally Close
Normally Open

Operation Unit

Ext Operation Unit

USB I/F

RADAR I/F

Power

NDC-1590: Central Control Unit
Intel Core i5 2515E 2.5GHz

2GB (DDR3)

Yes

Width 400 x Depth 240 x Height 125 (mm)
5.6kg
1

-15°C to +55°C
40°C RH 93%

Sweep 2Hz to 13.2Hz at + 1mm, 13.2Hz to 100Hz at 7m/s® and
for 2h on each resonance, otherwise 2h at 30Hz in all three axes

IEC60945-Ed4.0
IP20

1

1 (Slave output as DVI-D)

3 (IEEE802.3/IEEE802.3ab Compliance
(100BASE-TX/1000BASE-T))

2 input (GPS and LOG)

2 input (AIS and THD (Transmitting Heading Devices))
3 (up to 1GBase-T)

2 (Power Fail and Watch Timer Reset )

Power Fail (32V 0.8A MAX)

Watch Timer Reset (32V 0.8A MAX)

1 (5m max)

1 (up to 30m)

3 (1 for MNU, Others are general purpose)

1 input for scanner unit, 1 output for other equipment
Connecting with NBD-913
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12.5 Power Supply Unit

Voltage 100 to 115VAC, 50/60Hz 1

220 to 240VAC, 50/60Hz 1
Voltage Range 85 to 264VAC
Overvoltage Protection 295VAC+2V
Input Current Max 6.8A(100VAC) / 3.4A(220VAC)
Over current Protection YES

Voltage 24VDC

Voltage Range 21.6 to 31.2VvDC
Overvoltage Protection 42V

Input Current Max 16A

Over current Protection YES

Output 1 12.0V+0.24V 2A
Output 2A (for CCU) 24.0V+0.48V 4A
Output 2B (for MNU) 24.0V+0.48V 6A
Output 3 (for TXRX) 48.0V+0.96V 4A
Mechanical
Dimension Width 400 x Depth 240 x Height 85 (mm)
Mass 4.2kg
FAN 2
Emvionment
Operational Temperature -15°C to +55°C
Operational Humidity 40°C RH 93%
Sweep 2Hz to 13.2Hz at + 1mm, 13.2Hz to 100Hz at 7m/s2
Vibration and for 2h on each resonance, otherwise 2h at 30Hz in all
three axes
EMC IEC60945-Ed4.0
Ingress Protection Rating IP20
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12.6 Trackball Operation Unit

Pointing Device 2inch Trackball

Click Button 2-buttons (Left and Right)

USB I/F 1

Speaker 1

Vibration 1

Keys SILENCE/ALERT ACK/ZOOM IN/ZOOM OUT

Knob Multi Function Knob

Cable Length Up to 5m (Up to 30m when the extended option is used.)
Dimension Width 130 x Depth 210 x Height 77 (mm)

Mass 1.3kg

Operational Temperature -15°C to +55°C

Operational Humidity 40°C RH 93% m

Sweep 2Hz to 13.2Hz at £ 1mm, 13.2Hz to 100Hz at 7m/s?

Vibration and for 2h on each resonance, otherwise 2h at 30Hz in all
three axes

EMC IEC60945-Ed4.0

Ingress Protection Rating Front : IP22
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12.7 19inch Display

Screen Size 19inch
Aspect Ratio 5:4
Full Resolution 1280 x 1024

1280 x 1024, 1280 x 960, 1024 x 768, 800 x 600, 640 x

Supported format
480, 720 x 400

Dot Pitch 0.294mm

Viewing Area 376.32mm x 301.06mm
Display Colors 1.677 billion colors
Contrast Ratio 2000:1

Viewing Angles (H/ V) 178°/178°

Back Light LED

Brightness 500cd/m2 Type

Horizon 30kHz to 80kHz

Digital Scanning Frequency (H/V
e g Frequency (H/V) Vertical 56Hz to 75Hz

DVI-D input 1

VGA input 1

VGA output N/A

USB I/F 1

Power 21.6 to 31.2vDC

Overvoltage Protection N/A

DC Reverse Connection Protection Self Return Type

Cables Up to 5m

Glass Bonding Standard

Mechanical

Dimension Width 429 x Depth 76 x Height 382 (mm)

Mass 6.0kg

Fan 1

Glass Tempered Glass + AR Coating

Operational Temperature -15°C to +55°C

Operational Humidity 40°C RH 93%
Sweep 2Hz to 13.2Hz at + 1mm, 13.2Hz to 100Hz at 7m/s2

Vibration and for 2h on each resonance, otherwise 2h at 30Hz in all
three axes

EMS IEC60945-Ed4.0

Ingress Protection Rating Front:IP65 Back:IP22
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12.8 26inch Display

Screen Size 26inch

Aspect Ratio 16:10

Full Resolution 1920 x 1200RB
1920 x 1200RB, 1680 x 1050, 1680 x 1050RB, 1600 x
1200,

Supported format
1600 x 1200RB, 1280 x 1024, 1024 x 768, 800 x 600, 640 x
480

Dot Pitch 0.2865mm

Viewing Area 550.08mm x 343.8mm

Display Colors 1.677 billion colors

Contrast Ratio 1500:1

Viewing Angles (H / V) 176°/176°

Back Light LED

Brightness 400cd/m? Type

Horizon 30kHz to 75kHz

Digital Scanning Frequency (H / V
: 2 . y( ) Vertical 56Hz to 75Hz

DVI-D input 1
VGA input 1
VGA output 1
USB I/F 1
Power 21.6 to 31.2VDC
85 to 265VAC 50/60Hz
Overvoltage Protection N/A
DC Reverse Connection Protection Self-Return Type
Cables Up to 5m
Glass Bonding Optional
Dimension Width 624 x Depth 85 x Height 456 (mm)
Mass 16kg
Fan 2
Glass Tempered Glass + AR Coating
Operational Temperature -15°C to +55°C
Operational Humidity 40°C RH 93%
Sweep 2Hz to 13.2Hz at + 1mm, 13.2Hz to 100Hz at 7m/s?
Vibration and for 2h on each resonance, otherwise 2h at 30Hz in all
three axes
EMC IEC60945-Ed4.0
Ingress Protection Rating Front: IP65 Back: IP22
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12.9 Keyboard OPU

GENERAL SPECIFICATION NCE-5625: Keyboard Operation Unit
Layout QWERTY

Pitch 15mm

Stroke 2mm

HOME, TX/STBY, PI, DISP OFF, AZ, PANEL, DAY/NIGHT,

Keys
MOB, USER1, USER2
Knobs EBL, VRM, SEA, RAIN, GAIN
Mechanical
Dimension Width 270 x Depth 210 x Height 30 (mm)
Mass 0.8kg
CEmvionment
Operational Temperature -15°C to +55°C
Operational Humidity 40°C RH 93%
Sweep 2Hz to 13.2Hz at + 1mm, 13.2Hz to 100Hz at 7m/s2
Vibration and for 2h on each resonance, otherwise 2h at 30Hz in all
three axes
EMC IEC60945-Ed4.0
Ingress Protection Rating Front : IP22

12.10 26inch Display Unit Mount Kit

GENERAL SPECIFICATION CWA-246: 26inch Display Unit Mount Kit

Dimension Width 680 x Depth 718 x Height 1100 (mm)

Mass APPROX. 65kg

CEmvionment

Operational Temperature -15°C to +55°C

Operational Humidity 40°C RH 93%
Sweep 2Hz to 13.2Hz at + 1mm, 13.2Hz to 100Hz at 7m/s?

Vibration and for 2h on each resonance, otherwise 2h at 30Hz in all
three axes

EMC IEC60945-Ed4.0

Ingress Protection Rating Front : IP22
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12.11 19inch DISPLAY UNIT MOUNT KIT

GENERAL SPECIFICATION CWA-245: 19inch DISPLAY UNIT MOUNT KIT
Dimension Width 580 x Depth 718 x Height 1100 (mm)
Mass Approx. 55kg
Operational Temperature -15°C to +55°C
Operational Humidity 40°C RH 93%
Vibrati Sweep 2Hz to 13.2Hz at £+ 1mm, 13.2Hz to 100Hz at 7m/s2 and
ibration
for 2h on each resonance, otherwise 2h at 30Hz in all three axes
EMC IEC60945-Ed4.0
Ingress Protection Rating Front: IP22
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12.12 Sensor LAN switch unit

GENERAL SPECIFICATION NQA-2443: Sensor LAN switch unit

Standards IEEE802.3, 802.3u, 802.3x
Store and Forward, with IEEE802.3 full duplex,
back pressure flow control

Forward and Filtering Rate 148810 pps

Processing type

Latency Less than 5us

Number of ports 16
10/100Base-T(X) auto negotiation speed, F/H duplex mode, and

RJ45 auto MDI/MDI-X connection
LED Power, Fault, Speed

Input Voltage 12 t0o 48 VDC

Input Current 0.34A max

Over Current Protection 1.6A

Reverse Polarity Protection Yes

Dimension Width 53.6 x Depth 135 x Height 105 (mm)
Mass 1.5kg
CEmvionment
Operational Temperature -15°C to +55°C
Operational Humidity 40°C RH 93%
Vibration Sweep 2Hz to 13.2Hz at £ 1mm, 13.2Hz to 100Hz at 7m/s?
and for 2h on each resonance, otherwise 2h at 30Hz in all three axes
EMC IEC60945-Ed4.0
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12.13 Junction Box

Mechanical
Dimension Width 400 x Depth 86 x Height 261.5 (mm)
Mass 3.8kg
CEmvionment
Operational Temperature -15°C to +55°C
Operational Humidity 40°C RH 93%
Sweep 2Hz to 13.2Hz at + 1mm, 13.2Hz to 100Hz at 7m/s?
Vibration and for 2h on each resonance, otherwise 2h at 30Hz in all
three axes
EMC IEC60945-Ed4.0
Ingress Protection Rating Front : IP20
Power
Power 21.6 t0 31.2 VDC
Input Voltage 48W MAX
Power Consumption 3Ax2,15Ax 1 Mini Blade Fuse
Over Current Protection Yes

FUNCTIONAL SPECIFICATION CMH-2370: Serial LAN Interface Circuit

IEC61162-1 8 input / 8 output
IEC61162-2 2 input / 2 output
IEC61162-450 1 (100Base-TX)
Dry Contact Output (N.C/N.O i

8 (32V, 0.8A sink MAX)
selectable)

Dry Contact Input 8 (5V, 50mA source MAX)
Ingress Protection Rating Front : IP20
FUNCTIONAL SPECIFICATION CMJ-554: Gyro Interface Circuit

STEP 22to 70 VDC

SYNC 24 to 115VAC, 50/60/400Hz

RATIO 36x/90x/180x/360x

OUTPUT THS (50Hz)

PULSE Dry contact: 30V(max), 50mA(max)
Voltage signal: 0-50V (threshold level is 2V)

RATIO 100/200/400/800 [P/NM]

OUTPUT VBW (1Hz), VLW (0.1Hz)

FUNCTIONAL SPECIFICATION CMJ-556: Analog Option Circuit

Isolated Input 4
Input Signal Range -10 to 10 VDC or 4 to 20 mA
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Appendix A Alert List

When an alert occurs, alert information is displayed in the alert notification area.

Alert message

Alarm button

Warning button Caution button

Alert notification area when there is no AMS license

The numbers displayed in the buttons indicate the number of such alerts that have occurred.

Memo
The alert button of a category that has not occurred will not be displayed.

Alert message

Alert notification area when there is an AMS license

The display colors of alert messages are defined as follows according to the type and seriousness of

alerts.
Alert Class Display .
Alert Type (Seriousness) Color Alert Display Status | Alert Sound
Before alarm
Alarms .
o acknowledgement:
(Ar;.alert |_|I1d|cat1t|ng a state Alarms Red Blinking Present
asking sailors to pay After alarm (repetitive)
immediate attention and take .
: ; ; acknowledgement:
immediate action.) O
Lighting
Warnings
(An alert indicating that the
state has changed, which Before alarm
although not immediately ;cl:_kr;.owledgement:
inkin
dar_lgerous, but may pecome Warnings Orange g Present
so in the near future if no After alarm (once)
action is taken. Warnings are acknowledgement:
alerts displayed for Lighting
preventing possible future
hazardous states.)
Cautions
(Although these are neither . o
alerts indicate that it is
necessary to pay more than
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normal attention to cautions,
statuses, or to the supplied
information.)

No Alarm - Green
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The list of alert messages by alert type is shown below.

Each item in the "Subject" column indicates the following.

INS: Alert relating to the INS function

RADAR/AIS: Alert relating to the RADAR/AIS function
Control unit: Alert relating to the control unit

Antenna: Alert relating to the antenna

Display unit: Alert relating to the display unit

Operation unit: Alert relating to the operation unit

Power supply: Alert relating to power supply

Maintenance: Alert relating to maintenance

Others: Other alert

A.1 Alarms

Message

Subject

Explanation

Depth below keel

INS

Alarm on the depth below the keel
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A.2 Warnings

Message Subject Explanation
AIS(Communication failed, Direct) INS AIS communication failure on the CCU
serial port
AIS(Communication failed, Main LAN) INS AIS communication failure on LAN1
(main network)
AIS(Communication failed, Sub LAN) INS AIS communication failure on LAN2 (sub
network)
AlS(invalid) INS AIS data validity error
AlS(unavailable) INS AIS data not received
ALC #n(Communication failed, Main INS ALC#n communication failure on LAN1
LAN) (Main network)
Anemometer (communication failed, INS Anemometer communication failure
Main LAN) (wind direction/wind speed) on
LAN1(Main network)
Autopilot(Communication failed, Main INS Autopilot communication failure on LAN1
LAN) (main network)
Autopilot(Communication failed, Sub INS Autopilot communication failure on LAN2
LAN) (sub line)
Blizzard#n-DSP#m (Communication Control Communication error with the DSP
error) section (Bizzard#n - DSP#m)
Blizzard#n DSP#m (Load Failed) Control The transfer of the DSP program did not
section succeed. (ASIC#n - DSP#m)
Blizzard#n High TEMP Control Blizzard#n high temperature
section
Blizzard(Process Error) Antenna Signal processing error in Blizzard
Blizzard(SYNC Signal Lost) Antenna Interrupt signal (interrupt due to absence
of external synchronous signal)
BNWAS(Communication failed, Main INS BNWAS communication failure in LAN1
LAN) (Main network)
CCU Fan Control Drop in CCU fan revolution per minute
section
CIF(Communication error) Control Communication error between the CPU
section and the Companion MPU
CMP RelaySoftware(Communication Control Communication error between the
error) section Companion MPU relay software and the
MFD
COG/SOG(invalid) INS COG/SOG data validity error
COG/SOG(not plausible) INS COG/SOG data plausibility error
COG/SOG(unavailable) INS COG/SOG data not received yet
CPU Core#n Clock down Control CPU Core#n clock down
section
CPU Corefin High TEMP Con_trol CPU Core#n temperature rise
section
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Message

Subject

Explanation

DATUM(invalid)

INS

DTM sentence validity error

DATUM(unavailable) INS DTM sentence not received yet
Depth(invalid) INS Depth data validity error
Depth(unavailable) INS Depth data not received yet
DSC(Communication failed, Main LAN) | INS DSC (Digital Selective Calling)
communication failure on LAN1 (Main
network)
DSP(Heading Data) RADAR/AIS Heading data error (heading error that is
received by companion MPU)
Echo Sounder(Communication failed, INS Echo sounder communication failure on
Main LAN) LAN1 (Main network)
Echo Sounder(Communication failed, INS Echo sounder communication failure on
Sub LAN) LANZ2 (Sub network)
e-Token(Communication error) Control Communication error between the CPU
section and e-Token
External TT#n(invalid) INS TT#n data validity error
External TT#n(unavailable) INS TT#n data not received
GIF(Communication error) Control Communication error between the
section Companion MPU and the Gyro IF (USB
connection)
GIF-RIF(Open) Control The open state was detected between
section the GIF and the RIF
GIF-SLC(Open) Control The open state was detected between
section the GIF and the SLC
GPS #n(Communication failed, Direct) INS GPS#n communication failure on serial
port of CCU
GPS #n(Communication failed, Main INS GPS#n communication failure on LAN1
LAN) (Main network)
GPS #n(Communication failed, Sub INS GPS#n communication failure on LAN2
LAN) (Sub network)
Gyro #n(Communication failed, Direct) INS Gyro communication failure on CCU
serial port
Gyro #n(Communication failed, INS Gyro IF communication failure on CCU
GIF-Direct) serial port
Gyro #n(Communication failed, INS Gyro IF communication failure on LAN1
GIF-Main LAN) (main network)
Gyro #n(Communication failed, GIF-Sub | INS Gyro IF communication failure on LAN2
LAN) (sub network)
Gyro #n(Communication failed, Main INS Gyro communication failure on LAN1
LAN) (main network)
Gyro #n(Communication failed, Sub INS Gyro communication failure on LAN2
LAN) (sub network)
HASP(Communication error) Control Communication error between the CPU
section and the HASP
Heading(invalid) INS Heading data validity error
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Message

Subject

Explanation

Heading(not plausible)

INS

Heading data plausibility error

Heading(unavailable) INS Heading data not received yet
IAS(Communication failed, Main LAN) INS IAS communication failure in LAN1 (Main
network)
LAT(Out of Bounds) ECDIS Exceeded system operation latitude
range
LCD Fan#n(LCD) Display Unit The LCD fan#n stopped
LCD High TEMP Display Unit LCD temperature rise
Log #n(Communication failed, Direct) INS Log communication failure on CCU serial
port
Log #n (Communication failed, INS Failure in log communication via Gyro IF
GIF-Direct) on CCU serial port
Log #n (Communication failed, GIF-Main | INS Failure in log communication via Gyro IF
LAN) on LAN1 (main network)
Log #n (Communication failed, GIF-Sub | INS Failure in log communication via Gyro IF
LAN) on LAN2 (sub network)
Log #n (Communication failed, Main INS Log communication failure on LAN1
LAN) (main network)
Log #n (Communication failed, Sub LAN) | INS Log communication failure on LAN2 (sub
network)
NAVTEX(Communication failed, Main INS NAVTEX communication failure on LAN1
LAN) (main network)
No.#n Conning(Communication failed, INS No.#n Conning communication failure on
Main LAN) LAN1 (main network)
No.#n ECDIS(Communication failed, INS No.#n ECDIS communication failure on
Main LAN) LAN1 (main network)
No.#n Radar(Communication failed, INS No.#n Radar communication failure on
Main LAN) LAN1 (main network)
No.#n Remote-Conning(Communication | INS No.#n Remote-Conning communication
failed, Main LAN) failure on LAN1 (main network)
No.#n RPS(Communication failed, Main | INS No.#n RPS communication failure on
LAN) LAN1 (main network)
No. #n Wing-Conning(Communication INS No.#n Wing-Conning communication
failed, Main LAN) failure on LAN1 (main network)
OPA-OPB(Communication error) Operation OPA-OPB open detection
section
OPU-Serial(Communication error) Control Communication error between the
section Companion MPU and the operation unit
(serial)
OPU-USB(Communication error) Control Communication error between the
section Companion MPU and the operation unit
(USB connection)
Position Monitor TCS Position monitor

(Displayed by TCS Ed.1/Ed.2)
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Message Subject Explanation
Position(failed) INS Integrity verification of Position data
failed
Position(GPS#n) Not Differential INS GPS#n is not DGPS

Position(Navigational Status Not Valid,
GPS#hn)

Track Control

The Navigation status flag of GPS#n is
invalid.

Position#n(NON-WGS84)

ECDIS

Geodetic positioning system error

Power(AC Low Voltage)

Power supply

AC Power supply OFF

Power(DC Low Voltage)

Power supply

DC Power supply voltage low

Power Fail Control 3.3V/2.5V/1.5V/1.2V and other receiving
section power dropped or stopped
Power(Fan) Power supply | The fan in the power supply unit is

broken

Power(TXRX, Failed)

Power supply

Antenna power supply failure operation

RIF(Communication error) Control Communication error with Companion
section MPU-RIF.
ROT(invalid) INS ROT data validity error
ROT(unavailable) INS ROT data not received yet
Rudder(Communication failed, Main INS Rudder communication failure on LAN1
LAN) (main network)
SLC1-#n(Communication failed, Main INS SLC1-#n Communication failure on
LAN) LAN1 (Main network)
SLC2-#n(Communication failed, Sub INS SLC2-#n Communication failure on
LAN) LAN2 (Sub network)
STW Speed(invalid) INS STW data validity error
STW Speed(not plausible) INS STW data plausibility error
STW Speed(unavailable) INS STW data not received yet
TEMP(invalid) INS Water temperature data validity error
TEMP(unavailable) INS Water temperature data not received yet
TXRX(Communication error) RADARJ/AIS | Communication error with Companion
MPU-Radar antenna
TXRX(DRV AC LKV) Antenna Drive unit failure (insufficient AC power
supply)
TXRX(DRV AC OVV) Antenna Drive unit failure (AC overvoltage)
TXRX(DRV COM) Antenna Drive unit failure (communication failure)
TXRX(DRV CPU1) Antenna Drive unit failure (motor driver CPU1
failure)
TXRX(DRV Hall Sensor) Antenna Drive unit failure (hall sensor failure)
TXRX(DRV High Rotate) Antenna Drive unit failure (high rotation failure)
TXRX(DRV IPM OVH) Antenna Drive unit failure (IPM overheating)
TXRX(DRV Low Rotate) Antenna Drive unit failure (low rotation failure)
TXRX(DRV MOT OVH) Antenna Drive unit failure (motor overheating)
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Message Subject Explanation

TXRX(DRV OVC) Antenna Drive unit failure (overcurrent)

TXRX(DRV Over Rotate) Antenna Drive unit failure (excessive rotation
failure)

TXRX(DRV VBUS LKV) Antenna Drive unit failure (VBUS insufficient
voltage)

TXRX(DRV VBUS OVV) Antenna Drive unit failure (VBUS overvoltage)

TXRX(Fan1) Antenna Antenna fan 1 failure
(This warning is not issued when a
solid-state antenna is connected.)

TXRX(Fan2) Antenna Antenna fan 2 failure
(This warning is not issued when a
solid-state antenna is connected.)

TXRX(Heater) Antenna Magnetron heater voltage error
(Even if this warning is issued, radar
transmission can be continued.
However, since the error damages the
equipment, it is recommended to be
used in the emergency case only.)

TXRX(High Temperature) Antenna Antenna  (temperature  abnormality
inside of the equipment)

TXRX(IF PLL) Antenna PLL lock error in IF DAC

TXRX(MHV) Antenna Modulation voltage abnormality

TXRX(Motor Current) Antenna Motor overcurrent abnormality

TXRX(Option) Antenna Antenna option module failure

TXRX(PROC) Antenna Antenna signal processing circuit failure

TXRX(PS) Antenna Antenna power supply circuit failure

TXRX(SSW Off) Antenna Safety switch OFF

VDR(Communication failed, Main LAN) | INS VDR communication failure on LAN1
(main network)

VDR(Communication failed, Sub LAN) INS VDR communication failure on LAN2
(main network)

VDR(Delivery Failed) RADAR/AIS Failures of capture image distribution for
VDR continued for one minute (that is, 4
times consecutively)

Water Thermometers (Communication INS Water TEMP communication failure on

failed, Main LAN) LAN1 (Main network)
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A.3 Cautions

Message Subject Explanation
AlS(invalid) INS AIS data validity error
AlS(unavailable) INS AlS data not received
AMS #n(Alert INS AMS#n communication failure in LAN1 (main network)
Communication failed,
Main LAN)
AMS #n(Alert INS AMS#n communication failure in LAN2 (sub network)
Communication failed,
SubLAN)
COG/SOG(invalid) INS COG/SOG data validity error
COG/SOG(unavailable) INS COG/SOG data not received yet
DATUM(invalid) INS DATUM sentence validity error
DATUM(unavailable) INS DATUM sentence not received yet
Depth(invalid) INS Water depth data validity error
Depth(unavailable) INS Water depth data not received yet
External TT#n(invalid) INS TT#n data validity error
External INS TT#n data not received
TT#n(unavailable)
HDOP exceeded(GPS#n) | INS Increase of HDOP of GPS#n (deterioration of GPS
precision)
Heading(invalid) INS Heading data validity error
Heading(unavailable) INS HDG data not received yet

Life Expectancy

Maintenance

The end of the estimated life expectancy of the CPU FAN

FAN(CCU) is approaching
Life Expectancy Maintenance | The end of the estimated life expectancy of the Power
FAN(Power) FAN is approaching

Life Expectancy LCD
Backlight

Maintenance

The end of the estimated life expectancy of the LCD
Backlight is approaching

Life Expectancy LCD
FAN#n

Maintenance

The end of the estimated life expectancy of the LCD
FAN#n is approaching

Life Expectancy SSD#n

Maintenance

The end of the estimated life expectancy of the SSD#n is
approaching

Life Expectancy UPS

Maintenance

The end of the estimated life expectancy of the UPS is
approaching

Position Shift Others At offset of own ship’s position

Position(invalid) INS Position validity error

Position(not plausible) INS Position plausibility error

Position(unavailable) INS Position not received yet

Position(Low Integrity, Track GPS#n measurement position integrity deterioration
GPS#n) Control

ROT(invalid) INS ROT data validity error

ROT(unavailable) INS ROT data not received yet

A-9 Appendix A Alert List



Message Subject Explanation
Scanner Rotating RADAR/AIS | Scanner is rotating (wave not transmitted) ICE
CLASS standby
STW Speed(invalid) INS STW data validity error
STW Speed(unavailable) INS STW data not received yet
TEMP(invalid) INS Water temperature data validity error
TEMP(unavailable) INS Water temperature data not received yet
TIME(invalid) INS Time validity error
TIME(unavailable) INS Time not received yet
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A.4 List of Alert Icons

The alert icons displayed in the alert status area are listed below.

No. Name of alert icon Functional outline Alert icon
Active —
1 ur(:al\:;nowled ed A flashing red triangle.
alarm g A symbol of loudspeaker in the middle of the triangle.

Active — silenced

A flashing red triangle.

2 alarm A symbol as in icon number 1 with a prominent diagonal A
line above it.
3 Active — A red triangle. '
acknowledged alarm An exclamation mark in the middle of the triangle.
: . A red triangle.
A - I
4 ctive - responsibility An arrow pointing towards the right in the middle of the A
transferred alarm .
triangle.
Rectified —
5 une:cllgr?owled od A flashing red triangle.
g A tick mark in the middle of the triangle. A
alarm
Active -
5 urcw:al\c/:inowled od A flashing yellowish orange circle. ‘
. g A symbol of loudspeaker in the middle of the circle.
warning
Active — silenced A flashing ye!lowlsh orange C|rcl.e. . .
7 . A symbol as in icon number 6 with a prominent diagonal \
warning . .
line above it.
Active —
8 ac(::l:r\:swled od A yellowish orange circle. '
) g An exclamation mark in the middle of the circle. =
warning
Active - responsibilit A yellowish orange circle.
9 P . Y | An arrow pointing towards the right in the middle of the 9
transferred warning ,
circle.
Rectified —
10 ur?:cllg:owled od A flashing yellowish orange circle.
_ g A tick mark in the middle of the circle. v
warning
) A yellow square.
11 | Caut
aution An exclamation mark in the middle of the square. !
. A plus sign. +
A t
@ ggregation To be presented together with icons number 1 to 11
b Acknowledge not A red triangle with a cross in the middle of triangle. ;;
allowed for alarm To be presented together with icons number 1, 2 and 5.
3 Acknowledge not g:;a;lomsh orange circle with a cross in the middle of

allowed for warning

To be presented together with icons number 6, 7 and 10.
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Appendix B Menu List and Materials

B.1 Menu List

This section shows the menus and dialog items of this equipment by target menu.

* Items that are enclosed by a frame of broken lines indicate the dialog and window names that are
displayed by selecting the relevant menu.

B.1.1 View

View-Options
L Unit
I Depth (Included depth in Chart)
Ship Speed
Current Speed
Wind Speed

Propeller Revolution
Propeller Pitch Angle
Thruster Revolution
Thruster Pitch Angle
Air TEMP

Water TEMP

Air Pressure

XTD/XTL for TCS info APP B

Wind Direction(True)

Depth Graph
* Case where the depth sensor is connected.
[E— (Depth Trend Graph)

Depth Range(Docking)
Depth Range(Voyage)
Time Range
Reference
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Rudder Graph

* Case where the gyro and rudder is connected.

[E—

(Rudder Trend Graph)

I:Time Range :|
Rudder Range

Gyro/Rudder Graph”
* Case where the depth sensor is connected.

[I—

(Gyro/Rudder Trend Graph)

|:Time Range :|
Rudder Range

Engine Graph °

* Case where the engine is connected.

[—

(Engine REV Trend Graph)
Time Range
Maximum rpm
Minimum rpm

Wind Graph*

* Case where the anemometer is connected

[—

(Wind Speed Trend Graph)

[Time Range.

(Wind Direction Trend Graph)
Time Range.

Sea TEMP Graph*
*Case where the water temperature meter is connected

[—

(Sea TEMP Trend Graph)
[Time Range]

ROT

[E—

(ROT)
[ROT Scale]
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B.1.2

Depth/Safety Contour

Alert

[E—

(Depth Below Keel Alarm)
Depth Below Keel

Position Integri

AMS

Timer

y

L

(Position monitor warning)
Position Difference Limit
Radius Limit (GPS)
Radius Limit (DGPS)
Time Limit

(HDOP exceeded caution)

[HDOP Limit]

(Reactivation of Silenced Alert)
Time Limit

(Transfer to BNWAS)

Time Limit

(Repetition of UNACK Warning)
Time Limit

(Timer)
(LMT)

B-3
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B.1.3 Settings

Color and Brightness

L IDay/Night
Def.
Display Color tab
[Character]
Brightness tab
(Character
Panel
Day1 : Level4 / Day2 : Level3 / Day3 : Level2 / Dusk,Night : Level1
Display
<26 inch> [0~100]Day1/Day2/Day3 : 67 / Dusk : 60 / Night : 11
<19 inch> Day1/Day2/Day3 : 42 / Dusk : 20 / Night : 4

-

Sounds

L Volume tab
(key ACK
Misoperation
Response/Notification
Message Notification
Alert Setting Reminder
Navigation 1 Alarm *
* For UKC alarm
Navigation 2 Alarm
Navigation 3 Alarm
CPA/TCPA Alarm
\Waming
Melody tab
_Navigation 1
Navigation 2
Navigation 3
CPA/TCPA

Key Assignment

L [Multi Dial tab

Display Brightness
Panel Brightness
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B.1.4

Date/Time/Time

Maintenance

Zone

[

(Date)
Month
Year
Day
Time(LMT)
Time Zone
Display Style
Synchronise with Time Source(Date/Time)
Synchronise with Time Source(Time Zone)

System Information

[—

Software tab

/Type

Application
Maintenance No.
TXRX

TCS

\Presentation Library
Functionality tab

("Device Licence Status

\Option Licence Status
Save to USB Device

Operating Time

L

(Operating Time of Work Station)
[Total ]
SSD1
SSD2

LCD

LCD FAN
CCU FAN
PSU FAN
LUPS J
(Operating Time of Scanner)*
* Under radar connection
—Total

Transmit

Motor
FAN

Voyage Distanci

L

e
(Current Voyage Distance)
—Ground
Water
“Clear

Sensor Selection/Status

L |

Sensor Selection
L (Sensor Selection)

Position
Heading
STW
COG/SOG
Time
Depth
SOG (Docking)
Navigational Data
Switch to equipment for Autosailing

Position Status
Position Status
CCRP

B-5
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Diagnosis

[—

Software Upda

Monitor Test
L Al Black
All Red
All Green
All Blue
All White
Pattern1
Pattern2
Pattern3
Pattern4
Pattern5
Pattern6
Color Bar
Gray Scale
S-57 Color Pattern
ARCS Color Pattern
Key Test
Key Test Start
L Key
Key Test Stop
Sound Test
Sound Test Start
Light Test
Light Test Start
Vibration Test
(B Vibration Test
Memory Check
L Memory Check Start
Results

te

L | Software Update

Help Install

DVD Drive Cleaning
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B.1.5 Help

«
N

Home
(Contents tab)
(Search tab)

keyword
Search
Results
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B.1.6 Code Input

Password
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B.1.7

Installation

Service

Installation Information (Menu for a person in charge of installation)
(B (Installation Information)

Date:

Calendar Icon

Name:

Company:

SSR Scanner type *
* Under compact solid-state radar connection

Language (English version only) (Menu for a person in charge of installation)

L Language

System Configuration

Subsystem Installation (Menu for a person in charge of installation)

(B (Own Task Station)

Task Station No.
Own Equipment No.
IP Address(Main):
IP Address(Sub):
USB OPU

| Serial OPU
(Junction Box)

[Junction Box 1

Task Station

Space A

Space B

LAOC

Junction Box 2 : Same as Junction Box 1)

Junction Box 3 : Same as Junction Box 1)

Junction Box 4 : Same as Junction Box 1)

Junction Box 5 : Same as Junction Box 1)
)

Junction Box 7 : Same as Junction Box 1)
)

(
(
(
(
(Junction Box 6 : Same as Junction Box 1
(
(
)

Junction Box 8 : Same as Junction Box 1

Device Installation)

Task Station 1
Equipment No.
Task Station 2
Equipment No. 2
Task Station 3
Equipment No. 3
Task Station 4
Equipment No. 4
Task Station 5
Equipment No. 5
Task Station 6
Equipment No. 6
Task Station 7
Equipment No. 7
Task Station 8
Equipment No. 8
RADAR 1
RADAR 2
VDR(JRC)
Printer

-

Heading Sensor 1

| Heading Sensor 1(Type) )

B-9
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rHeading Sensor 2
Heading Sensor 2(Type)
Log 1
Log 1 Interface/Type
Log 2
Log 2 Interface/Type
GPS 1
GPS 2
GPS 3
GPS 4
Ship’s Clock
Echo Sounder 1
Transducer 1
Transducer 2
Echo Sounder 2
Transducer 3
AIS
NAVTEX
Anemometer
Water TMP Meter
Current Meter
Climate Meter
Autopilot
Autopilot Type
Rudder
Rudder Number
Engine/Propeller
Engine/Propeller Number
Engine Telegraph
Engine Telegraph Number
Bow Thruster
Bow Thruster Number
Stern Thruster
Stern Thruster Number
Azimuth Thruster
Azimuth Thruster Number
Generator
Generator Number
S-JOY1
S-JOY2
S-JOY3
S-JOY4
S-JOY5
GPS Selector
Log Selector
Inmarsat-C 1
Inmarsat-C 2
BNWAS
BNWAS Type
General Equipment(Alert)

\General Equipment(Alert) Number )

Set
CCRP
| Length
Beam

GPS1 X~GPS4 X

GPS1Y~GPS4Y

RADAR Antenna1 X~RADAR Antenna8 X
RADAR Antenna1 Y~RADAR Antenna8 Y
CCRP1 X~CCRP4 X

CCRP1 Y~CCRP4Y

(Speed Position(from fore Draft))

Bow

Stern
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Serial Port
L (ccu

(GyroiLog/GPS/AIS ]
Sensor

Diagnosis

(ISW/MTR/Serial OPU |
Diagnosis

SLC1(M) tab
CH1 ~CH8
CH9 ~ CH10
Gyro I/F
Sensor
Diagnosis

(SLC2(M) ~ SLC4(M) : SAME AS SLC1(M))
(SLC2(S) ~ SLC4(S) : SAME AS SLC1(M))
(ALC1 ~ ALC4 : SAME AS SLC1(M))
Same as SLC(Main)

Contact (Menu for a person in charge of installation)

L (ccu)
WMRST
PWR FAIL
SLC1 tab
-Contact Output tab
Contact1 ~ Contact8
Test

| Task Station
Contact Input tab _
Contact1 ~ Contact4
Diagnosis
Task Station
(SLC2 : Same as SLC1)
(SLC3 : Same as SLC1)
(SLC4 : Same as SLC1)
(ALC1 : Same as SLC1)
(ALC2 : Same as SLC1)
(ALC3 : Same as SLC1)
(ALC4 : Same as SLC1)
A/D (Menu for a person in charge of installation)
(SLC1)
Connect (common)

Contents (common)
Generator Power

Value (common)

Data Unit (common)
Clear (common)

(SLC2 : Same as SLC1)
(SLC3 : Same as SLC1)
(SLC4 : Same as SLC1)
(ALC1 : Same as SLC1)
(ALC2 : Same as SLC1)
(ALC3 : Same as SLC1)
(ALC4 : Same as SLC1)
(Analog Option Circuit2)
Connect (common)
CH1~CH4

Contents (common)
Value (common)

Data Unit (common)
Clear (common)
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Data Output (Menu for person in charge of installation)
(TT)
[TT™ 7]
TLL
TTD
TLB
0OSD
RSD

(AIS)
(TT™ 7]
TLL
TTD
LTLB ]
Remote Maintenance
GPS Select

Log Select

Navigation Data Channel(1)

Network (Menu for person in charge of installation)
L IPAddress tab
(Own Task Station)

IP Address
Set

(Network List)
Delete
Add
Edit
Status tab
Redundancy (Menu for person in charge of installation)
(TCS)
|:Main:|
Sub
(AMS)
Main
ub
(LAN(VDRY))

[Sub j
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Ship’s Parameters

Settings

Ship General
(Ship General)
/Ship's Name 7
Length
Beam
Height from keel to MAX point
Keel-Trans
MAX Course Change
MAX Speed Limit
MIN Speed Limit
MAX ROT
MIN ROT
\MIN Turn Radius

Alert
L (WatchAlarm)

Reset Interval
Trackball Threshold
Sound Output Mode

AC Power Failure

L Auto Shutdown of Task Station after

LCD Control)

Power Off :|
Set display brightness
Power Off of Antenna
AIS
I Setting Password
Display Size
L Horizontal Size
Depth
I

Synchronization depth alarm limit

B-13
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Maintenance

L Storage
Management
L Drive Information
File Information

Operating Time Setup

[ (Operating Time of Work Station)
/Total b
Clear
LCD
Clear
LCD FAN
Clear
CCU FAN
Clear
PSU FAN
Clear
LUPS B
(Setup of UPS)
—Setup Date(UTC)
Calendar Icon
_Replace Time

Initialization
L Set Default (All settings except service)
Set Default (Service settings)
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B.2 Abbreviations of Geodetic Data

DTM sentence

No. Geodetic Data Pisplay to the top User-defined
screen Abbreviation No.
0 | WGS 84 WGS 84 W84 0
1 | WGS 72 WGS 74 W74 1
2 | Tokyo TOY TOY 2
3 | North American 1927(USA) NAS NAS(*2) 3
4 | North American 1927(Canada & Alaska) | NAS NAS(*2) 4
5 | European 1950 EUR EUR 5
6 | Australian Geodetic 1966 AUA AUA 6
7 | Ordnance Survey of Great Britain OGB OGB 7
8 | North American 1983 NAR NAR 8
9 | No Use Blank display - 9
10 | No Use Blank display - 10
11 | Adindan ADI ADI 11
12 | Arc 1950 ARF ARF 12
13 | Australian Geodetic 1984 AUG AUG 13
14 | Bermuda 1957 BER BER 14
15 | Bogota Observatory BOO BOO 15
16 | Campo Inchauspe CAl CAl 16
17 | Chatam Island Astro 1971 CHI CHI 17
18 | Chua Astro CHU CHU 18
19 | Corrego Alegre COA COA 19
20 | Djakarta (Batavia) BAT BAT 20
21 | European 1979 EUS EUS 21
22 | Geodetic Datum 1949 GEO GEO 22
23 | Guam 1963 GUA GUA 23
24 | Hayford 1910 024 024(*1) 24
25 | Hjorsey 1955 HJO HJO 25
26 | Indian IND IND 26
27 | Ireland 1965 IRL IRL 27
28 | Kertau 1948 KEA KEA 28
29 | L. C. 5 Astro 1961 LCF LCF 29
30 | Liberia 1964 LIB LIB 30
31 | Luzon LUz LUz 31
32 | Merchich MER MER 32
33 | Minna MIN MIN 33
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DTM sentence

No. Datum Display to the top User-defined

screen Abbreviation No.
34 | Nahrwan NAH NAH 34
35 | Naparima, BWI NAP NAP 35
36 | Old Egyptian 1907 OEG OEG 36
37 | Old Hawaiian OHA OHA 37
38 | Pico de las Nieves PLN PLN 38
39 | Provisional South American 1956 PRP PRP 39
40 | Provisional South Chilean 1963 HIT HIT 40
41 | Puerto Rico PUR PUR 41
42 | Qornoq QuO QuoO 42
43 | RT 90 043 043(*1) 43
44 | Sao Braz SAO SAO 44
45 | South American 1969 SAN SAN 45
46 | Graciosa Base SW 1948 GRA GRA 46
47 | Timbalai 1948 TIL TIL 47
48 | No Use Blank display - 48
49 | No Use Blank display - 49
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B.3 Lists of Terminologies, Units, and

Abbreviations
Abbreviation Term
A
A/D =AD Analog/ Digital
A/P = AP Auto Pilot
AC Alternating Current
ACC Actual Course Change
ACCA Actual Course Change Alarm
ACK Acknowledge
ACQ Acquire, Acquisition
ACT Activate
AFT After
AIO Admiralty Information Overlay (additional information to the navigation)
AIS Automatic Identification System
ALC Alert LAN Converter
AMP Amplifiers
AMS Alert Management System
ANT Antenna
ARCS Admiralty Raster Chart Service (A raster chart published by UKHO.)
ASCII American Standard Code for Information Interchange
ASIC Application Specific Integrated Circuit
AtoN Aids to Navigation
AUTO = auto | Automatic
Av. = AVE Average
AVCS Admiralty Vector Chart Service
AZ Acquisition Zone
AZI Azimuth Stabilisation Mode
B
BAM Bridge Alert Management
BCR Bow Crossing Range
BCT Bow Crossing Time
BFT Beaufort
BNWAS Bridge Navigational Watch Alarm System
BP Bearing Pulse
BRG Bearing
BZ Bearing Zero
Cc
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Abbreviation

Term

C upP

Course Up

CA-CFAR Cell Averaging CFAR
Cargo.Cat Cargo Category

CCRP Consistent Common Reference Point
CCRS Consistent Common Reference System
CCu Central Control Unit

CCw Counterclockwise

CFAR Constant False Alarm Rate
CH Channel

CHG Change

CID Conning Information Display
CIF Companion MPU Interface
CLR Clear

COG Course Over the Ground
COM Communication Port

CONT Contrast, Control

CONV Conventional

CORREL Correlation

CPA Closest Point of Approach
CPP Controllable Pitch Propeller
CPU Central Processing Unit
CRS Course

CTS Course to Steer

CTW Course Through the Water
Curr. Current

Ccw Clockwise

D

D/N Day/Night

DC Direct Current

Def. Definition

DGPS Differential GPS

DIFF Difference

DIR = Dir. Direction

DISP = Disp Display

DIST Distance

DR Dead Reckoning, Dead Reckoned Position
DSC Digital Selective Calling
DSP Digital Signal Processor
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Abbreviation Term
E

EBL Electronic Bearing Line

ECC Early Course Change

ECDIS Electronic Chart Display and Information System
Ed. Edition

EGC Enhanced Group Calling

ENC Electronic Navigational Chart

ENH Enhance

EOT End of Track

EP Estimated Position

EPA Electronic Plotting Aids

EPFS Electronic Position Fixing System
EQUIP Equipment

ETA Estimated Time of Arrival

F

FPGA Field Programmable Gate Array
FTC Fast Time Constant

FWD Forward

G

GC Great Circle

GIF Gyro Interface

GLONASS Global Orbiting Navigation Satellite System
GND Ground

GNSS Global Navigation Satellite System
GPS Global Positioning System

GZ Guard Zone

H

H UP Head Up

H/W = HW HardWare

HASP Hardware Against Software Piracy
HC Heading Control

HCS Heading Control System

HDG Heading

HDOP Horizontal Dilution of Precision

HL Heading Line

HO Hydrographic Organization

HSC High Speed Craft

B-19
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Abbreviation

Term

I/F =1IF Interface

1/0 Input/Output

IALA International Association of Marine Aids to Navigation and Lighthouse Authorities
IALA-A IALA - Region A

IALA-B IALA - Region B

ID Identification

IMO International Maritime Organization
IND Indication

INFO Information

INIT Initialisation

INS Integrated Navigation System
INT Interval

IP Address Internet Protocol Address

IR Interference Rejection

ISW Interswitch

J

K

L

L/L=LL Latitude/ Longitude

LAN Local Area Network

LAT Latitude

LCD Liquid Crystal Display

LMT Local Mean Time

LON Longitude

LOP Line of Position

LORAN Long Range Navigation

LP Long Pulse

M

M/E Main Engine

MAG Magnetic

MAN Manual

MAX Maximum

MBS Main Bang Suppression
MFDF Medium Frequency Direction Finding
MHV Modulator High Voltage

MIC Microphone

MID Middle

MIN Minimum
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Abbreviation

Term

MMSI

Maritime Mobile Services Identity Number

MOB Man Overboard

MON Monitor

MP Medium Pulse

MSC Maritime Safety Committee
MSG Message

N

N UP North Up

NAV = NAVI Navigation

NAVTEX Navigational Telex

NE North East

NFU Non Follow Up

NLT Not Less Than

NMEA National Marine Electronics Association
NMEA0183 NMEA 0183 standards
NMT Not More Than

No. = NUM Number

NW North West

(0]

OPE Operation

OPU Operation Unit

OSD Own Ship Data

OVRD Override

P

PI Parallel Index Line

PIN Personal Identification Number
PL Pulse Length

PORT Port/ Portside

POS = POSN | Position

PPI Plan Position Indicator
PRF Pulse Repetition Frequency
PROC Process

PS Power Supply

PWR Power

Q

R

R Relative

RADAR Radio Detecting and Ranging
RAND Random

B-21 Appendix B
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Abbreviation

Term

RCID

Raster Chart Issue Date

REF Reference

REL Relative

Rev. Revolution

RIF Radar I/F Circuit

RL Rhumb Line

RM Relative Motion

RM(R) Relative Motion. Relative Trails.
RM(T) Relative Motion. True Trails.
RMS Root Mean Square

RNC Raster Navigational Chart

RNG Range

RoRo Roll On/ Roll Off (Vessel)

ROM Read Only Memory

ROT Rate of Turn

RPS Route Planning System

RX Receiver

S

SA Scheme Administrator

SAR Search and Rescue

SART Search and Rescue Transponder
SATNAV Satellite Navigation

SBAS Satellite Based Augmentation System
SCL Serial LAN Converter

SDK Software Development Kit

SE South East

SEL Select

SENC System Electronic Navigational Chart
Seq Sequence

SFI System Function 1D

S-JOY Steering Joystick Controller
SLC Serial LAN Converter

SOG Speed Over the Ground

SP Short Pulse

SPD Speed

SprsLvl Spurious Level

SSD Solid State Drive

SSE Security Scheme Error

SSR Solid State Radar
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Abbreviation

Term

SSW

Safety Switch

STAB Stabilised, Stabilisation
STBD Starboard, Starboard Side
STC Sensitivity Time Control
STD Standard

STW Speed Through the Water
Surf Surface

SW HUB Switching Hub

SYNC Synchronisation

SYS System

T

T True

T&P Temporary and Preliminary Notice to Mariners
TCPA Time to CPA

TCS Track Control System

TD Time Difference

TEMP / Temp. | Temperature

TGT Target

™ True Motion

TNI Tune Indicator

TPL Transferred Line of Position
Trans Transducer

TRX Transceiver

TT Target Tracking

TTG Time to Go

X Transmitter

TXRX Transmitter Receiver Unit
U

U.Map User Map

UNACK Un-Acknowledge

Up.No. Update Number

USB Universal Serial Bus

UTC Coordinated Universal Time
\"

VD Video

VDIN Video In

VDR Voyage Data Recorder
Ver. Version

VHF Very High Frequency

B-23 Appendix B
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Abbreviation

Term

VOL

Volume

VRM Variable Range Marker
w

W uUpP Waypoint Up

WGS World Geodetic System
WIG Wing-in-ground effect craft
WOL Wheel Over Line

WPT Waypoint

WS Work Station

WTRST Watch Timer Reset

X

XTD Cross Track Distance
XTE Cross Track Error

XTL Cross Track Limit, Route Width
Y

z

Unit

bps bit per second

cm centimetre

dB decibel

deg degree

fm fathom

ft feet, foot

h=hr hour

hPa hecto pascal

Hz hertz

kg kilogram

km kilometre

kn = kts knot

m metre

mbar millibar

min minute

mph mile per hour

NM nautical mile

RAD radius

rom revolutions per minute
] second

sm statute mile
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B.4 List of Icons/lcon Buttons

The iconsl/icon buttons displayed in this equipment are listed below.

No. Name Functional outline Displayed image
1 | Active Indicates that the computer is e .
indicator processing by an animation. “ob 0a0 B0 %,
2 | Delete Deletes the item. m
3 | Setting mark Displayed when the operation is valid.
4 | Drive Displayed at the left of the name .
when a drive is selected.
5 | Folder Displayed at the left of the name m
when a folder is selected.
6 | Close Closes the dialog box.
7 | Date selection | Displays the calendar picker.
8 | Day/Night Displays the state of the current @
Day/Night setting by an icon. 1
9 | Screen Enables adjustment of the screen
brightness brightness.
10 | Panel Enables adjustment of the brightness
brightness of operation unit.
11 | MOB Starts the MOB (Man Over Board)
mode.
In the MOB mode, a symbol display of | [
the position of the sailor falling over &;
board and a dotted like connecting it 4
to the own ship are displayed
graphically.
12 | Menu [Menu] button with freeze indicator
function.
Displays the menu. ° ®
Indicates using animation that the K
system is operating. ®Meru@ Menu
13 | Silencing Silences the alert sound. ©
. b)
14 | Multiple knob | Displays the functions assigned to the
(small knob) multiple knob. Displayed as an icon

with the function name at left.

B-25
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No. Name Functional outline Displayed image
15 | Brightness Sets the brightness of the screen. m
16 | Page Selects the item to be displayed in the o0
selection custom tab. oo!
17 | View Opens the View related menu.
Sets the graph display.
18 | Alert Opens the alert related menu.
When clicked, the [Alert] dialog box
appears. Alert settings can be made
in the dialog box.
19 | Settings Opens the menu related to the
operation settings of the equipment.
20 | Maintenance | The maintenance related menu for
the users is displayed. £
It is possible to check the software ({\
version and to monitor the status of
the equipment.
21 | Help Opens the help screen.
22 | Code Input Input the password. 0
XX
"
23 | Service The menu related to adjustment,
servicing, and maintenance is
displayed for the servicing personnel.
24 | Back space Carries out a backspace operation. ﬂ
25 | Backward Moves back the input position.
mO\{ement of &«
the input
position
26 | Forward Moves the input position forward
mO\{ement of >
the input
position
27 | Operation Displays the operation guide when
guide clicked.
28 | Search Displayed in the search text box. m
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Software License Agreement

This Software License Agreement is made and entered between the user who purchased a product of
JMR-7200/9200 series, JAN-7201/9201 or JAN-7202/9202 and Japan Radio Co., Ltd. (hereinafter
referred to as "J RC") with regard to the license to use the software in the product series.

You have purchased a device that uses software licensed from Microsoft License in the U.S. and
Trend Micro Incorporated to JRC. The software which was developed by Microsoft and Trend Micro
and installed in the device along with the printed documentation attached to it and its online or
electronic documents (hereinafter collectively referred to as the "Software") are protected by
international laws and conventions in relation to the protection of intellectual properties.

The licensed Software has not been sold to you and all rights in and to the Software are reserved.

If you do not agree to execute this License Agreement, you will not be allowed to use the
device or copy the Software. If you do not agree to the provisions and terms hereof, you are
requested to immediately inform us of your intention to return the device before you start to
use it so that JRC can repay you the amount you have paid for it. By using the Software in
the state as installed in the device or in any other way, you agree to the provisions of this
License Agreement (or confirm your prior agreement).

Conditions of the license shall be stipulated as follows:

- The Software shall only be licensed for the use in the state as installed in the device you have
purchased.

- Indemnification: The Software itself is not free from defects. JRC has defined on its own
account how to use the Software installed in JRC’s devices. For this reason, Microsoft
and Trend Micro trust JRC to conduct sufficient tests to determine whether the
Software is suitable for such usage as a prerequisite for the use of the Software.

- The Software is provided with no warranties whatsoever: The Software is provided as is
and with all faults. You shall bear all the risks whether you can obtain satisfactory
quality, performance and accuracy and it shall be your responsibility to make efforts to
ensure those including eliminating errors. In addition, there is no warranty in the event
of prevention from using the Software or in the case of infringement of any right arising
from using the Software. Even if you can have any warranty in relation to the device or
the Software, such warranty is not the one provided by Microsoft or Trend Micro, and
therefore such warranty shall not bind either Microsoft or Trend Micro.

- Java support: The Software may include support of programs written in the Java language.
The Java technology is not free from defects and is not designed or manufactured for the
purpose of use or resell as online controlling equipment for the use in any dangerous
environment requiring preparation of safety device in case of an emergency such as in
operation of nuclear device, navigation or telecommunication system for aircrafts, air traffic
control, life support machine or weapon systems in which failure of the Java technology may
directly lead to an event which causes death or serious injury or environmental damage.

This statement of disclaimer of liability is the obligation of Microsoft under the contract
between Microsoft and Sun Microsystems.
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- Limitation of Liability: Except to the extent prohibited by law, Microsoft shall not be
liable for any indirect damages, special damages, consequential damages or incidental
damages arising from or in relation to the performance or use of the Software. This
limitation of liability shall apply even in the case any remedy for damages may not fulfill
its essential purpose. In any event, Microsoft shall not liable for any damages
exceeding the amount equal to 250 US$.

- Limitation of Liability: Trend Micro shall not be liable for any consequential damages,
incidental damages, or loss of profit arising from the use of the software activation
code or instruction manuals. In any event, Trend Micro's total liability shall be limited to
a 100% of the amount paid by you for the service rendered during three months
immediately before the damage occurred.

- Restriction of reverse engineering, decompiling and disassembling: Except in cases explicitly
permitted by applicable laws regardless of the restriction hereunder, you shall not reverse
engineer, decompile or disassemble the Software.

- Export control: You acknowledge that the country of origin of the Software is the United States
of America. You agree to comply with export control laws and regulations of the United States
of America as well as both domestic laws of the United States of America and international
laws applicable to the Software including regulations issued by the U.S. Government or other
governments in relation to end users, end use and country of destination.

For additional information on export of the Software, refer to the website:
http://www.microsoft.com/exporting/.

Font License Agreement

This product uses Migu font (http://mix-mplus-ipa.sourceforge.jp/migu/) to display characters on the
screen. Migu font data is distributed from the URL stated above. Migu font is distributed in compliance
with "IPA Font License Agreement v1.0" (http://ipafont.ipa.go.jp/ipa_font_license_v1.html). This
product loaded with the Migu font is also in compliance with "IPA Font License Agreement v1.0." You
may use this product under the agreement to the provisions of "IPA Font License Agreement v1.0." You
have the right to change the font used for the display of this product from Migu font to IPA font.
However, there is no need to change the Migu font to IPA font in the specifications of this product.
Moreover, this product is designed to provide the display which is optimized for using Migu font. Note
that using IPA font for the display may cause a problem of compatibility of font data with regard to the
form of some characters resulting in degradation of the display on the screen. If you desire to change
from Migu font to IPA font, consult with our service agent.
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IPA Font License Agreement v1.0

The Licensor provides the Licensed Program (as defined in Article 1 below) under the terms of this
license agreement ("Agreement"). Any use, reproduction or distribution of the Licensed Program, or
any exercise of rights under this Agreement by a Recipient (as defined in Article 1 below) constitutes
the Recipient's acceptance of this Agreement.

Article 1 (Definitions)
In this Agreement, the following terms set forth in each item shall be defined as therein.

1. "Digital Font Program" shall mean a computer program containing, or used to render or display
fonts.

2. ‘"Licensed Program" shall mean a Digital Font Program licensed by the Licensor under this
Agreement.

3. "Derived Program" shall mean a Digital Font Program created as a result of a modification,
addition, deletion, replacement or any other adaptation to or of a part or all of the Licensed
Program, and includes a case where a Digital Font Program newly created by retrieving font
information from a part or all of the Licensed Program or Embedded Fonts from a Digital
Document File with or without modification of the retrieved font information.

4. "Digital Content" shall mean products provided to end users in the form of digital data, including
video content, motion and/or still pictures, TV programs or other broadcasting content and
products consisting of character text, pictures, photographic images, graphic symbols and/or the
like.

5. "Digital Document File" shall mean a PDF file or other Digital Content created by various software
programs in which a part or all of the Licensed Program becomes embedded or contained in the
file for the display of the font ("Embedded Fonts"). Embedded Fonts are used only in the display
of characters in the particular Digital Document File within which they are embedded, and shall be
distinguished from those in any Digital Font Program, which may be used for display of characters
outside that particular Digital Document File.

"Computer" shall include a server in this Agreement.

7. "Reproduction and Other Exploitation" shall mean reproduction, transfer, distribution, lease, public
transmission, presentation, exhibition, adaptation and any other exploitation.

8. "Recipient" shall mean anyone who receives the Licensed Program under this Agreement,
including one that receives the Licensed Program from a Recipient.

Article 2 (Grant of License)

The Licensor grants to the Recipient a license to use the Licensed Program in any and all countries in
accordance with each of the provisions set forth in this Agreement. However, any and all rights
underlying in the Licensed Program shall be held by the Licensor. In no sense is this Agreement
intended to transfer any right relating to the Licensed Program held by the Licensor except as
specifically set forth herein or any right relating to any trademark, trade name, or service mark to the
Recipient.
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1. The Recipient may install the Licensed Program on any number of Computers and use the same
in accordance with the provisions set forth in this Agreement.

2. The Recipient may use the Licensed Program, with or without modification in printed materials or
in Digital Content as an expression of character texts or the like.

3. The Recipient may conduct Reproduction and Other Exploitation of the printed materials and
Digital Content created in accordance with the preceding Paragraph, for commercial or
non-commercial purposes and in any form of media including but not limited to broadcasting,
communication and various recording media.

4. If any Recipient extracts Embedded Fonts from a Digital Document File to create a Derived
Program, such Derived Program shall be subject to the terms of this agreement.

5. If any Recipient performs Reproduction or Other Exploitation of a Digital Document File in which
Embedded Fonts of the Licensed Program are used only for rendering the Digital Content within
such Digital Document File then such Recipient shall have no further obligations under this
Agreement in relation to such actions.

6. The Recipient may reproduce the Licensed Program as is without modification and transfer such
copies, publicly transmit or otherwise redistribute the Licensed Program to a third party for
commercial or non-commercial purposes ("Redistribute"), in accordance with the provisions set
forth in Article 3 Paragraph 2.

7. The Recipient may create, use, reproduce and/or Redistribute a Derived Program under the terms
stated above for the Licensed Program: provided, that the Recipient shall follow the provisions set
forth in Article 3 Paragraph 1 when Redistributing the Derived Program.

Article 3 (Restriction)

The license granted in the preceding Article shall be subject to the following restrictions:

1. If a Derived Program is Redistributed pursuant to Paragraph 4 and 7 of the preceding Article, the
following conditions must be met:

(1) The following must be also Redistributed together with the Derived Program, or be made
available online or by means of mailing mechanisms in exchange for a cost which does not
exceed the total costs of postage, storage medium and handling fees:

(a) a copy of the Derived Program; and

(b) any additional file created by the font developing program in the course of creating the
Derived Program that can be used for further modification of the Derived Program, if
any.

(2) It is required to also Redistribute means to enable recipients of the Derived Program to
replace the Derived Program with the Licensed Program first released under this License
(the "Original Program"). Such means may be to provide a difference file from the Original
Program, or instructions setting out a method to replace the Derived Program with the
Original Program.

(3) The Recipient must license the Derived Program under the terms and conditions of this
Agreement.

(4) No one may use or include the name of the Licensed Program as a program name, font
name or file name of the Derived Program.

(5) Any material to be made available online or by means of mailing a medium to satisfy the
requirements of this paragraph may be provided, verbatim, by any party wishing to do so.
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2. If the Recipient Redistributes the Licensed Program pursuant to Paragraph 6 of the preceding

Article, the Recipient shall meet all of the following conditions:

(1) The Recipient may not change the name of the Licensed Program.

(2) The Recipient may not alter or otherwise modify the Licensed Program.

(3) The Recipient must attach a copy of this Agreement to the Licensed Program.

3. This licensed Program is provided by the licensor "as is" and any expressed or implied warranty
as to the Licensed Program or any derived program, including, but not limited to, warranties of title,
non-infringement, merchantability, or fithess for a particular purpose, are disclaimed. In no event
shall the licensor be liable for any direct, indirect, incidental, special, extended, exemplary, or
consequential damages (including, but not limited to; procurement of substituted goods or service;
damages arising from system failure; loss or corruption of existing data or program; lost profits),
however caused and on any theory of liability, whether in contract, strict liability or tort (including
negligence or otherwise) arising in any way out of the installation, use, the reproduction or other
exploitation of the licensed Program or any derived program or the exercise of any rights granted
hereunder, even if advised of the possibility of such damages.

4. The Licensor is under no obligation to respond to any technical questions or inquiries, or provide
any other user support in connection with the installation, use or the Reproduction and Other
Exploitation of the Licensed Program or Derived Programs thereof.

Article 4 (Termination of Agreement)

1.  The term of this Agreement shall begin from the time of receipt of the Licensed Program by the APP B
Recipient and shall continue as long as the Recipient retains any such Licensed Program in any
way.
2. Notwithstanding the provision set forth in the preceding Paragraph, in the event of the breach of
any of the provisions set forth in this Agreement by the Recipient, this Agreement shall
automatically terminate without any notice. In the case of such termination, the Recipient may not
use or conduct Reproduction and Other Exploitation of the Licensed Program or a Derived
Program: provided that such termination shall not affect any rights of any other Recipient receiving
the Licensed Program or the Derived Program from such Recipient who breached this Agreement.

Article 5 (Governing Law)

1. IPA may publish revised and/or new versions of this License. In such an event, the Recipient
may select either this Agreement or any subsequent version of the Agreement in using,
conducting the Reproduction and Other Exploitation of, or Redistributing the Licensed Program or
a Derived Program. Other matters not specified above shall be subject to the Copyright Law of
Japan and other related laws and regulations of Japan.

2. This Agreement shall be construed under the laws of Japan.
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Not use the asbestos
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For further information,contact:

JRC| Japan Radio Co., Lid.

Since 1915

URL Head office : http.//www.jrc.co.jo/eng/

Marine Service Department
e-mail : msc@jrc.co.jp
One-call : +81-50-3786-9201

ISO 9001, ISO 14001 Certified
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